
Font Dialog Box
Click the Font button in a calendar-printing dialog box to open the Font dialog box.

Dialog Box Options

Font
Sets the font typeface.

Font Style
Sets the font style: regular, italic, bold, or bold italic.

Size
Sets the point size for the font.

Select Font For
In Weekly, Monthly and Yearly view, sets the fonts to use for each part of the display of the selected 
view. Click to select an item, then make all the font selections and click Apply.

Sample
Displays a sample of the selected font with the chosen attributes.

Apply button
In Weekly, Monthly and Yearly view, applies the specified font to the item selected in the Select Font 
For list. Make sure to apply the changes you make to the fonts for each item in the Select Fonts For 
list, before you select another item or click OK.    



Search Setup Dialog Box

Search Within
Sets the activities and other text fields to include in the Contact Manager search. Check Appointments,
Calls, To Do, and/or Contact Log.



To Do / Goals Dialog Box
The Calendar | To Do Items | Daily command opens the To Do dialog box, and the Calendar | Goals 
command opens the Goals dialog box. The options are the same in both dialog boxes.

Dialog Box Options

Predefined Activities
Displays a list of predefined activities you can choose from. Predefined Activities are usually 
composed of text and one or more field names, which are replaced with information from the current 
card. For example, Call {Firstname} {Lastname} at {Phone}, when filled in with the current card 
information, might read Call Michael Smith at 555-8943. If you choose an item from the Predefined 
Activities list, you can edit the text in the Text field. If no Predefined Activities are listed, click the Setup 
button to open the Personal List Setup dialog box.

Text
Sets the text (up to 500 characters) of the To Do or goal. Type text, or select an activity from the 
Predefined Activities list.

Regarding
Type a description or note about the activity. The Regarding text can be up to 2000 characters.

Priority
Sets the priority for the To Do or goal to Low, Medium, High, or Advanced. If Advanced is chosen, you 
can click the Advanced button to specify additional levels of priority. 

Advanced button specifies more detailed levels of priority than Low, Medium, or High. Advanced
priorities sort on two levels, first on A-B-C and then on 1-2-3-4-5 6. 

No Priority sets no priority for the To Do or goal.

Category
Specifies the category for the To Do or goal. In the To Do list and Goals list, you can sort To Dos and 
goals by category. Select a category from the drop-down list. To create categories, click the Setup 
button. 

Assign
Specifies the person assigned to the To Do goal (or the person who assigned it to you). Select a name 
from the Assign drop-down list. To add names to the Assign list, click the Setup button.

No Due Date
When checked, specifies no completion date for the To Do or goal.

Due Date
Sets the date by which the To Do or goal should be completed. The Due Date displays in the right-
most column of the To Do list or Goals list. You can sort items in the To Do list or Goals list by Due 
Date. Type the due date, use the spin button to select a date, or click the down arrow and select a date
from the mini calendar.

Default button
Saves the settings for the Priority, Category, Assign, and Completed as defaults settings for new To 
Dos or goals.

Setup button
Opens the Personal List Setup dialog box, where you create or modify predefined activities, 
categories, and assigns.



Recurring button
(To Do items only) Opens the Recurring To Do dialog box, where you can set the current To Do to 
recur. This option is available only for To Dos.

Completed
When checked, indicates that the To Do or goal is completed. A  appears next to completed tasks in 
the Daily View, and the description line in the list is crossed out. The activity no longer forwards to the 
next day.

Timer
When checked, turns the timer on to record the elapsed time until the To Do or goal is completed. The 
timer will run as long as Internet Sidekick is running, up to 10,000 hours.



Sort To Do Items/Goals List Dialog Box
Choosing Calendar | Sort | To Do Items opens the Sort To Do Items dialog box. Choosing Calendar | 
Sort | Goals opens the Sort Goals List dialog box. The options are the same in both dialog boxes.

Dialog Box Options

Primary Index
Sets the first attribute the To Dos or goals should be sorted on.

Secondary Index
Sets the second attribute the To Dos and goals should be sorted on.

Order
Choose options that determine the order in which items are sorted:

Ascending sorts in ascending order according to the primary and secondary indexes.
Descending sorts in descending order according to the primary and secondary indexes.
Blank Indexes First moves To Dos or goals that have blanks for the index first.
Blank Indexes Last moves To Dos or goals that have blanks for the index last.
Sort Completed Items to Bottom automatically moves completed items to bottom of list when 

you click another Calendar list.



Delete Recurring Dialog Box
Select the instances you want to delete:
· All Occurrences
· Future Occurrences
· Past Occurrences
Tip: Selecting Past Occurrences provides a good way to clean up old entries you no longer need.



Personal List Setup Dialog Box
To open this dialog box, click the Setup button in the To Do, Calls, or Goals dialog box. Or choose 
Calendar | Personal List Setup in the daily Calendar View. 

Dialog Box Options

Setup Options
Selects the kind of option you want to change. Select Predefined Activities, Call Status, Category, or 
Assign. Only options relevant to the activity in question are available. (That is, if you reached    this 
dialog box from the To Do dialog box, Call Status is not an available option.) As the different options 
are selected, the corresponding definitions for the options are displayed in the List box below. 

Field Names
Lists field names that you can add to the edit box when creating or modifying Predefined Activities. 
Double click a field name to add it at the cursor position in the Edit box. 
For example, if you have a field name called LastName, you can type "Meeting with" in the Edit box 
and then double-click LastName in the Field Names list to create the following predefined activity: 
"Meeting with {LastName}".

Edit
Type or revise information here, and add field names by double-clicking them (for Predefined 
Activities).

List
Displays the items in the list for the item selected in Setup Options. You can add, delete, or change 
items in the list.

Add button
Adds the text in the Edit box to the List box.

Change button
Replaces the text in the List box with the text in the Edit box.

Delete button
Deletes the selected item in the List box.



Define Cardfile Fields Dialog Box
Use this dialog box to define fields for a cardfile.

Dialog Box Options

Field Name
Type a new field name (up to 39 characters) or click on a field name you want to change.    Note: If the 
field is to be used for Internet scheduling, the field name must include one of the following keywords 
indicating the e-mail type: Exchange, Internet, CompuServe, AOL.

Add button
Inserts the new field name after the highlighted position in the field name list box. This button is 
dimmed if the field name already exists.

Add Before button
Inserts a field name before the highlighted position in the field name list box. This button is dimmed if 
the field name already exists.

Change button
Changes a field name. This button is dimmed if the field name already exists or a field name has not 
been selected.

Delete button
Deletes a field name from the field name list. This button is dimmed if no field name is selected. 
Warning: By deleting a field name, you delete all the information in that field in the cardfile.

Sort By button
Opens the Sort Cardfile dialog box where you can change the index line, which determines the sorting 
order of the cards in the cardfile.

OK button
Updates the active cardfile with the changes made to the field names defined. This button is dimmed if 
no changes have been made to the field names, and no changes have been made in the Sort By 
dialog box.



Ignore All Command (Shortcut Menu) 
The Ignore All command appears on the shortcut menu when you right-click a word that has been 
marked by AutoSpell as a possible misspelling. 
If you select Ignore All, the strikethrough is removed from the word at the current location, and at all 
other instances of that word in your document. 



Date Stamp Command (Shortcut Menu) 
To stamp today’s date at the insertion point in the Contact Log or current document, right-click the 
mouse in the Contact Log or document to open the Shortcut menu, and choose Date Stamp.

Shortcuts
Keyboard: Ctrl+D



Time Stamp Command (Shortcut Menu) 
To stamp the current time at the insertion point in the Contact Log or current document, right-click the 
mouse in the Contact Log or document, and choose Time Stamp from the Shortcut menu.

Shortcuts
Keyboard: Ctrl+T



Edit Command (Shortcut Menu, Calendar) 
The Edit command displays the appropriate daily entry dialog box for the selected activity: 
appointment, To Do, call, or Goal. Right-click the event and choose Edit from the Shortcut menu.



Font Command (Shortcut Menu) 
The Font command in the Shortcut menu displays the Change Display Font dialog box, where you 
choose the display font for the Cardfile.



Font Command (Shortcut Menu) 
The Font command in the Shortcut menu displays the Change Display Font dialog box, where you 
choose the display font for the Write view.



Recurring Command (Shortcut Menu) 
The Recurring command in the Shortcut menu displays the appropriate dialog box: Recurring 
Appointments, Recurring Calls, or Recurring To Do.



Send To (Shortcut Menu)
The Send To option in the shortcut menu lets you send information in a card or Write document. Right-
click in the document or card contents to use the Send to command. 
For more information, point to one of the Send To commands and press F1.



Send To | Eudora Pro or Exchange
You can send the contents of a card to someone else via e-mail, using the Send To Eudora Pro or 
Send To Exchange commands in the shortcut menu.    These commands launch your Exchange or 
Eudora Pro (32-bit) e-mail software, and insert the card fields as text in an e-mail document. 



Send To | Eudora Pro or Exchange
You can send the contents of a Write document to someone else via e-mail, using the Send To Eudora 
Pro or Send To Exchange commands in the shortcut menu.    These commands launch your Exchange 
or Eudora Pro (32-bit) e-mail software, and insert the text in an e-mail document.



Send To (Fax)
You can fax a Write document to someone using your fax modem. 
1. In Write, use the Viewport to select one or more cards of people you want to fax the document to. 

The cards must include a field that contains the word “fax” in its name, and there must be a valid fax
number in the field. 

2. Right-click in the text area of the document you want to fax, and choose Send To | Fax.



Reconcile Date Range Dialog Box

From
Enter the date from which you want to reconcile appointments.

To
Enter the date to which you want to reconcile appointments.



Add Card
Choose Cards | Add (in Cardfile View) or Edit | Add Card (in Calendar View or Write View) to open this 
dialog box.

Dialog Box Options

Card Contents
Type the data you want to add to the cardfile.

Add button
Adds the current data to the cardfile. The dialog box is emptied and remains open.

Close button
Closes the Add Card dialog box. If you have data in the dialog box, Internet Sidekick asks if you want 
to add the current data to the cardfile.



Find Condition
In the Cardfile, the Find Condition command (Edit | Find | Condition) opens the Find Condition dialog 
box.

Dialog Box Options

Condition 1 and Condition 2
Each condition consists of three parts:

Field Name:    Click the down arrow to select a field name to include in the condition. <Any Field>
has Internet Sidekick search for the text in all fields; select <Any Field> only if the selected operator is 
Equal To or Not Equal To.

Operator:    Click the down arrow to select an operator. Choose from the following operators:
Equal To
Not Equal To
Less Than
Less Than Or Equal To
Greater Than
Greater Than Or Equal To

Between (within the range). Use a comma to separate the two values.
Outside (outside of the range). Use a comma to separate the two values.

Value:    Type the text you want to search for.
If you want to add a an "OR" condition, check the box in the Condition 1 area and fill in the condition.
If you want to add an AND condition, check the box below Condition 2 and fill in the condition.



Extract Cards on Condition
Use this dialog box to specify the conditions for extracting cards.

Dialog Box Options

Condition 1 and Condition 2
Each condition consists of three parts:

Field Name:    Click the down arrow to select a field name to include in the condition. <Any Field>
has Internet Sidekick search for the text in all fields; select <Any Field> only if the selected operator is 
Equal To or Not Equal To.

Operator:    Click the down arrow to select an operator. Choose from the following operators:
Equal To
Not Equal To
Less Than
Less Than Or Equal To
Greater Than
Greater Than Or Equal To

Between (within the range). Use a comma to separate the two values.
Outside (outside of the range). Use a comma to separate the two values.

Value:    Type the text you want to search for.
If you want to add a an "OR" condition, check the box in the Condition 1 area and fill in the condition.
If you want to add an AND condition, check the box below Condition 2 and fill in the condition.



Print Labels/Address Book/Envelopes Dialog Box
Use this dialog box to select the cards and lay out the format.

Dialog Box Options

1 Select Cards to Print
Selects which cards to print to labels, address books, or envelopes:

Current prints a label, address book, or envelope using the current card of the active cardfile.

All prints print labels, address books, or envelopes using all cards in the active cardfile.

Index prints labels, address books, or envelopes from a range of cards in the active cardfile. Type
the index line information for the first and last card of the range to print in the From and To boxes.

Selected prints labels, address books, or envelopes using the selected cards in the active 
cardfile.

Marked Cards prints labels, address books, or envelopes using the marked cards in the active 
cardfile.

2 Choose Printing Style Template
Sets the size and position of labels or address book entries on a page. When printing envelopes, this 
sets the overall design of the envelopes, excluding the addressee portion. 
A list of templates is provided to get you started. However, since all printers are different, you should 
make sure the template you want to use prints correctly to your printer before printing many pages. 
You may have to adjust the margins slightly.
Click the Set Up Template button to open the Set Up Template dialog box to edit template attributes, 
including margins.
To delete a template, select it from the drop-down list and press the Delete key.

3 Choose Contents to Print
Sets the design of the label or address book entry. When printing envelopes, this sets the design of the
addressee portion of the envelope. Click the Set Up Contents button to open the Setup Contents 
dialog box to create or change a design. 
To delete a contents design, select it from the drop-down list and press the Delete key.
For detailed information on how to create the contents, see Designing Printing Label Contents.

4 Select Printing Options

Repeat Entire Set sets the number of copies of the entire label sheet, address book, or envelope
set to print.

Repeat Each Card sets the number of copies of each label, address book entry, or envelope to 
print (before printing the next one in the set). Select this option to print multiple return address labels.

More Options lets you set additional printing options, such as the starting position for labels and 
index tabs, page numbers, and a different print sort order than in the cardfile itself. See More (Printing) 
Options Dialog Box for more information. For envelope printing, see More Options (Envelopes) Dialog 
Box.



Preview button
Lets you preview the labels, address books, or envelopes before printing.



More (Printing) Options Dialog Box

Dialog Box Options

Orientation
Sets the paper orientation: portrait or landscape. 

Other Options

Skip Blank Lines skips any blank lines or empty fields from the printed labels or address book 
entries. Note that if the current label contents design contains a field name on the same line as other text, 
that other text will always print, even if the information from that field is blank.

Skip Blank Cards skips any cards with all fields in the label format empty from the printed labels 
or address book entries.

Add Page Numbers prints page numbers at the bottom of address book pages.

Index Tabs prints alphabetical index tabs at the top of each address book page.

Separate Index Tabs prints each new index tab at the top of new address book page.

Print Index Field
Sorts the printed address books or labels by the field you specify here. This is useful if you want to sort
the printed materials in a different way than they are sorted in the cardfile. For example, although your 
cardfile may be sorted alphabetically by the Company field, you might want to print labels sorted by Zip
Code.

Start Print Position
Sets the row and column position on a label sheet to begin printing. This is useful when printing to 
partially used label sheets.



Template Setup Options Dialog Box

Dialog Box Options

Reverse Side Printing Options 
When Print on Both Sides is checked in the Set Up Template dialog box, use these options for printing 
to asymmetrical pages.

Left to Right Mirror Image switches the left and right settings for label and page margins when 
printing the reverse side of address book pages.

Top to Bottom Mirror Image switches the top and bottom settings for label and page margins 
when printing the reverse side of address book pages. This makes the printout horizontally symmetrical.

Reverse Order of Pages on Reverse Side prints the reverse side of the address book pages in 
reverse order, starting with the last page of the address book. 

Binder Holes Position
Use these options when printing to paper with more than one address book page per sheet. Choose

Same Side when all binder holes on address book pages for a sheet of paper are on the same 
side.

Centered when all binder holes on address book pages are toward the center of the sheet of 
paper.

Mirrored when all binder holes on address book pages are toward the outside edges of the sheet
of paper.



Set Up Template Dialog Box
In Cardfile View in the Print Labels/Envelopes/ dialog box, click the Set Up Template button to open 
the Set Up Template dialob box, where you can set exact page margins and layout for your latels.

Dialog Box Options

Page Margins
Sets the dimensions of the sheet of paper that is being printed to. 
For address book printing, the number of "pages" to one sheet of paper can vary from one to four. 
Therefore, the Page Margins for the paper will adjust the distances from the top, bottom and sides of 
the paper to the edge of the pages, as well as the horizontal and vertical distance between the pages 
that the paper is divided into (set as horizontal and vertical page margins).

Label Margins
Sets the dimensions of the labels on the page, adjusting the distance from the top, bottom and sides of
the paper to the edge of the labels, as well as the vertical and horizontal distance between the labels. 
In address book printing, label margins adjust the distance from the top, bottom and sides of the page, 
as well as the vertical and horizontal distance between the labels on a page.

Page Layout
Sets the number of rows of labels to a page, the number of columns of labels, and the number of 
pages to a sheet of paper. The number of pages is used for address book and index card printing only.

Print on Both Sides
Used for printing address books to both sides of the paper. When this option is checked, Internet 
Sidekick prompts you to reinsert the paper after the first side of the address book pages are printed. 
Choose OK from Internet Sidekick to begin printing the second side of the address book pages. For 
more information, see the Reverse Side Printing Options in the Template Setup Options dialog box.

Opposite Corners
When one of the vertical page options is selected in Pages (2v or 3v), allows you to turn the page to 
print opposite corners. 

Save As button
Saves the changes you have made to the template (or saves as a new template), and closes the 
dialog box.

Cancel button
Cancels the changes you have made to the template, and closes the dialog box.

Options button
Sets several reverse-side printing options and specifies the position of binder holes. 

Test Print button
Prints a sample sheet of labels that indicate the exact margins of the printed output. Match this test 
print sheet to the actual sheet of labels.



Set Up Contents Dialog Box

Dialog Box Options

Save As button
Saves the changes you have made to the contents (or saves as new contents), and closes the dialog 
box.

Cancel button
Cancels the changes you have made to the contents, and closes the dialog box.

Hint button
Displays helpful hints for designing the contents. 

Click to Add

Card Fields button creates a text element that can include cardfile fields. After you click the Label
button, the Edit Label Text dialog box appears with a list of cardfile fields. Double-click a field to add it to 
the label text. 

Text button creates a text element. Opens the Edit Text dialog box. Type the text you want in the 
Text element, and click the OK button. 

Graphic button creates one of four graphic elements: Bitmap, Frame, Round Frame, or Line.

Stamp button creates a stamp element from a number of ready-made phrases. Text can be 
rotated by right-clicking.

Modify Selection button
Customizes the selected element. This command displays the shortcut menu for the selected element.
The shortcut menu lists editing options appropriate for the type of elements selected: Alignment for 
Text elements, for example, or Thickness for lines. (You can also change the contents of Card Fields 
elements or Text elements by double-clicking them.)

Zoom button
Magnifies or reduces the area shown on-screen.

Show Grid 
Shows the grid used in aligning elements. (See Snap To Grid, below.).

Snap to Grid
Causes elements to “snap” to a regular grid of points when you create or move them. This is useful for 
aligning elements.



Envelope Template Setup Dialog Box

Dialog Box Options

Save As button
Saves the changes you have made to the envelope template (or saves as a new template), and closes
the dialog box.

Cancel button
Cancels the changes you have made to the template, and closes the dialog box.

Hint button
Displays helpful hints for designing the envelope template. 

Click to Add

Card Fields button is not enabled in this dialog box, since you only need to add Card Field 
information in the addressee portion of the envelope. To do so, use the Setup Contents dialog box.

Text button creates a text element. Opens the Edit Text dialog box. Type the text you want in the 
Text element, and click the OK button. 

Graphic button creates one of four graphic elements: Bitmap, Frame, Round Frame, or Line.

Stamp button creates a stamp element from a number of ready-made phrases. Text can be 
rotated by right-clicking. 

Modify selection button
Customizes the selected element. This command displays the shortcut menu for the selected element.
The shortcut menu lists editing options appropriate for the type of elements selected: Alignment for 
Text elements, for example, or Thickness for lines. (You can also change the contents Text elements 
by double-clicking them.)

Zoom button
Magnifies or reduces the area shown on-screen.

Show Grid
Shows the grid used in aligning elements. (See Snap To Grid, below.).

Snap to Grid
Imposes a regular grid of points that elements will snap to. This is useful for aligning elements.



More Options (Envelopes) Dialog Box

Dialog Box Options

Feed and Orientation 
Sets the envelope feed direction and orientation.

Options

Skip Blank Lines skips any blank lines or empty fields from the printed labels or address book 
entries.

Skip Blank Cards skips any cards with all fields in the label format empty from the printed labels 
or address book entries.

Manual Feed lets you manually feed envelopes to the printer, rather than having printer print from
a stack.

Print Index Field
Sorts the printed address books or labels by the field you specify here. This is useful if you want to sort
the printed materials in a different way than they are sorted in the cardfile.

Margins
Sets the top and left margins of the envelope printing area.



Back Up And Restore Dialog Box
Choose the action you want: Back Up or Restore.

Dialog Box Options

Overwrite Confirmation 
Check to have Internet Sidekick notify you when you are backing up or restoring files over any existing
files with the same names.

Next >>
Click to proceed. The Back Up dialog box or Restore dialog box appears.



Back Up Dialog Box
 Related topics

Choose the drive and directory of the files you want to back up. You can copy multiple files across 
multiple disks, as long as no single file is larger than the capacity of a disk.

Dialog Box Options

Source file directory 
Click the Browse button if you need to change the directory from which files will be backed up. The 
Change Source Directory dialog box opens, and you can specify the source directory. You can back up
files from different directories by changing directories and selecting files from them.

Source files
Click each file you want to back up. Notice that all cardfiles in the directory are grouped under the 
heading [Cardfile], and all calendar files are under the [Calendar] heading, and so forth with other 
Internet Sidekick files. Other (non-Internet Sidekick) files are listed under the [Other] heading. 

Back up the following files
Displays the files you have selected to back up. 

Destination Directory 
Click the Browse button if you need to change the directory to which the files will be copied.    The 
Change Destination Directory dialog box opens, and you change the destination directory. 

>
Adds the selected files in the Source list to the Back Up list.

>>
Adds all files listed in the Source list to the Back Up list.

< 
Removes a file you select    in the Back Up list.

<<
Removes all files in the Back Up list.

Previous
Returns you to the opening Back Up And Restore dialog box.

Begin
Begins the backup process.



Restore Dialog Box
 Related topics

Dialog Box Options

Source file directory 
Click the Browse button if you need to change the directory from which files will be restored. The 
Change Source Directory dialog box opens, and you can change the source directory. 

Source files 
Click each file you want to restore and click the > button to add it to the Restore list. Notice that all 
cardfiles in the directory are grouped under the heading [Cardfile], and all calendar files are under the 
[Calendar] heading, and so forth with other Internet Sidekick files. Other files are listed under the 
[Other] heading.

Restore file names and destinations 
Displays the file names you select to restore, and the directory to which the file will be restored.

Change Destination Directory 
Highlight files from the Restore file names and destinations list, and then click the Browse button if you
need to change the directory to which the files will be restored. The Change Destination Directory 
dialog box opens, and you can change the destination directory. 

>
Adds the selected files to the Restore list.

>>
Adds all files listed in the Source Files list to the Restore list.

< 
Removes a file you select    in the Restore list.

<<
Removes all files in the Restore list.

Previous
Discards the settings you've specified and returns you to the opening Back Up And Restore dialog box.

Begin
Begins the restore process.



Fill In Information Dialog Box
This dialog box appears when your document template contains field names (in brackets, as merge 
fields) that do not exist in the cardfile you are merging with the document.

Dialog Box Options

Find
By default, this field contains the field name that does not exist in the cardfile. You can change this text
if you want to search for something else.

Replace With
In this field, type the text you want to replace the Find text with. Each time you use different Replace 
With text, it is added to the list below this field. You can click any text in the list to bring it into the 
Replace With field again. 

Replace
Replaces the selected text in the document with the text in the Replace With field, then selects the 
next occurrence of the text from the Find field. 

Replace All
Replaces all occurrences of the Find text with the Replace With text.

Ignore
Ignores the selected text in the document, and finds the next occurrence of the Find text.

Ignore All
Ignores all occurrences of the Find text.

Close
Closes the dialog box.



Change Directory Dialog Box

Dialog Box Options

Directories
Displays the directories available on the current drive. 

Drive
Displays the current drive. Click the down arrow to choose another drive. 

Network
Displays the Map Network Drive dialog box, which allows you to map drive letters to network drives.



Match Cardfile Fields Dialog Box
To open this dialog box, click OK in the Move Cards dialog box, or drag a card’s index line to another 
cardfile tab. 
Select a field from each cardfile and click the Match button.

Dialog Box Options

Source Cardfile List
Lists the fields in the source cardfile.

Destination Cardfile List
Lists the fields in the destination cardfile.

Match
Matches the selected field from each cardfile.

Remember the Matches
Saves the matches, so that these same fields will be automatically matched in the future. 

Delete Match Fields button
Displays the Delete Match Fields dialog box, where you change the list of remembered matches.    

Remove button
Removes the selected match (for this instance only, not affecting the permanent matches).



Delete Match Fields Dialog Box

Delete
Deletes the selected match from the remembered matches.



Remove Duplicate Cards Dialog Box

Dialog Box Options

Replace Cards in the Current Cardfile
Replaces the duplicate cards in the open cardfile with cards from the second cardfile. 

Retain Cards in the Current Cardfile
Retains the duplicate cards in the open cardfile and ignores the cards in the second cardfile. 

Do Not Remove Cards
Keeps all duplicate cards, including any duplicates. 



Change Display Font Dialog Box
The Change Display Font dialog box contains options for changing the fonts you see on-screen.

Dialog Box Options

Font
Sets the font typeface.

Font Style
Sets the font style (for example, regular, italic, bold, or bold italic).

Size
Sets the point size for the font.

Select Font For
Sets the fonts to use for each part of the display of the selected view. Click to select an item, then 
make all the font selections and click Apply or OK.

Sample
Displays a sample of the selected font.

Apply
Applies the specified font to the item selected in Select Font For. (If only one item is available in the 
Select Font For list, this button does not appear; click OK to apply your changes.)    



Modify Cardfile Template Dialog Box

Dialog Box Options

Field Name
Type a new field name (up to 39 characters) or select the field name you want to change. 

Add
Inserts the new field name after the highlighted position in the field name list box. This button is 
unavailable if the field name already exists.

Delete
Deletes the selected field name from the field name list. This button is unavailable if no field name is 
selected.

Up
Moves the selected field higher in the list by one slot.

Down
Moves the selected field lower in the list by one slot.



Paper Setup Dialog Box
You can edit the margins of the paper type on which you print your Internet Sidekick daily calendar. 
Click the Edit button in the Print Sidekick Format dialog box to open the Paper Setup Dialog box.

Dialog Box Options

Paper Type
Sets which paper type you modify. Type a new paper type name or select the one you want to change.

Margins
Sets the left, right, top, and bottom margins of the current paper type.

Add
Adds a new paper type, if you have typed a new name in the Paper Type field.

Delete
Deletes the currently selected paper type.

Change
Saves the changes you have made to the paper type.



Select Cardfile Template
In Cardfile View, the New Cardfile command (File | New Cardfile) opens the Select Cardfile Template 
dialog box.

Dialog Box Options

Cardfile Template
Sets the cardfile template to use as a basis for your new cardfile. Choose None to use no templates. 

Field Names
Shows the fields in the selected cardfile template.



Print Dialog Box 

Dialog Box Options

From/To
Sets the range of dates to print. The default From day is the first day shown in that glance view. The 
default To day depends on what type of format you choose to print.

Title
is where you type the title for the printed calendar.

Footer 
Is where you type a running footer for the printed calendar.

Print Selection

Today's Date prints today's date at the bottom right corner of your calendar.

Mini Calendar prints small versions of the previous month's and next month's calendars in the 
top corners of your calendar. If this option is selected, you will not be able to print graphics in the corners 
using the Graphic Selection options.

Graphic Selection
Sets a graphic to appear at the top left and/or the top right corners of the printed calendar. Choose 
which corner to set the graphic at, and choose the graphic from the Picture list. Click Apply to set that 
graphic in the selected corner. Click View to view that graphic.

Margins
Sets up the margins for the left, top, right and bottom of the printout. Type each margin number or use 
the up or down arrow buttons to increment or decrement the margins.

Fonts button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer.

Preview button
Previews the calendar before you print it.



Print Activities Dialog Box
The Print Activities dialog box opens when you choose File | Print in the Activities view.    The title that 
appears on the dialog box, and the options available, change depending on which tab you have 
clicked.    Click the Internet Events tab if you want to be able to print a summary or the details of your 
group events. For other tabs, only Summary is available. 

Dialog Box Options

Print Summary/Internet Event Details
Click one button or the other to specify what you want to print. If you click Group Event Details, specify 
the events you want to include in the Group Event Details to Print pane. 

Event Details to Print
Click one button or the other to specify whether you want to print the details for only the selected items
or for all items.

Preview button
Click to see a preview of the printed output.



Password Setup Dialog Box

Dialog Box Options

Old Password
Enter your old password. This field is empty if this is the first time you are creating a password. 

New Password
Enter the new password. 

Repeat Password
Enter the password again, for confirmation. 
Note The Sidekick-Password Setup dialog box is case-sensitive.



Enter Password Dialog Box

Password
Enter your password. 
Note The Password dialog box is case-sensitive.



Color Preferences Dialog Box
Sets the Deskpad color for each Internet Sidekick view.
You can choose a different Deskpad color for each of Internet Sidekick’s views. Click the arrow by the 
color box, and then click the color you want from the drop-down palette.



Extract Criteria Dialog Box
When you select Documents By Condition in the Extract Documents dialog box, this dialog box 
appears so you can enter the conditions.

Dialog Box Options

Subject 
Enter any text you want to find in the documents’ subject line.

Contents
Enter any text you want to find in the documents’ contents.

Date Range
Choose whether you want to search After a date, Before a date, or Between two dates.

Match Whole Word Only
Check this box to extract documents containing the search text only in whole words. For example, if 
you search for the word “too” and checked the Match Whole Word Only box, documents with the word 
“too” would be extracted, but not documents with the word “tool.”

Match Case 
Check this box to extract documents containing the search text only when the capitalization matches 
exactly what you type in the Subject or Contents fields above.



Toll Prefixes Dialog Box
Used to specify any exchanges within your area code which must be preceded by 1+area code when 
dialing.    

Dialog Box Options

Local Phone Numbers
This list initially contains all possible three digit combinations, since all exchanges within an area code 
are usually dialed without the area code itself. 

Dial 1-xxx First
Add to this list any exchanges within in your area code that require dialing the area code first.

Add
Select a number in the Local Numbers list and click Add to move it to the Dial 1-xxx Before: list.

Remove
Select a number in the Dial 1-xxx Before list and click Remove to move it to the Local Numbers list.

Add All
Click this button to move all exchanges from the Local Numbers list to the Dial 1-xxx Before list.

Remove All
Click this button to remove all numbers from the Dial 1-xxx Before list.



Setup Wizard: General Information
The Setup Wizard runs the first time you start Internet Sidekick. It asks you for some essential 
information about yourself and your location, such as where you live (your time zone) and your 
electronic mail information.    Later, you can change these settings by starting the Setup Wizard again 
(Tools | Setup | Wizard), or by choosing Tools | Preferences | Group Scheduling.
Enter or revise the information about yourself. If Windows knows your name and company name, they 
are automaticallly entered, although you can change them as desired.
When done, click Next to continue or Cancel.



Setup Wizard: Choose Location
Click the arrow in the Choose the Country box, and click the country where you are located. Then click
the arrow in the Choose the City box, and specify your city.    
Note If your city doesn’t appear in the list, pick the closest city to you that is in the same time zone.
When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: E-mail Type
Click one of the buttons to select your choice:
Automated Setup (recommended) lets Internet Sidekick scan    for e-mail services on your computer.
Custom setup lets you specify your e-mail service yourself, after the Wizard scans to see what 
systems are available on your system.
Do not set up now disables all electronic mail services. You will not be able to use Internet Sidekick’s 
group scheduling, features, which rely on e-mail.
The e-mail systems recognized by the Setup Wizard are the following: Eudora Pro, Eudora Light,    
Microsoft Exchange, Microsoft Internet Mail, Pegasus, Netscape Mail.
Note If your hard disk contains lost clusters or other damaged data, it can interfere with the scanning 

process.    If the scan takes a very long time, you can interrupt it by pressing Cancel, and run the
Windows 95 ScanDisk program. Click the Start button, Programs, Accessories, System Tools, 
ScanDisk.

When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: Set Up Your Service
If you click the Continue Setup… option, the Wizard will set up the e-mail service it has found for the 
messages required for group scheduling. 
If you click the Go to Custom Setup… option, the Wizard takes you to the option to select the e-mail 
transport you want to use.
When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: Which Service?
If the Wizard found more than one e-mail systems on your computer, the list appears here. Click the 
one you want to use for group scheduling messages.
When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: No Service Found
No Internet Mail service was found on your system. 
If you choose I Do Not Have an Internet E-mail System, the Wizard will check to see if you have 
Microsoft Exchange installed. 
If you choose I Do Have an Internet E-mail System, you will be asked to provide information about it.
When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: Choose Profile
Click the arrow next to Preferred Profile, and choose the Microsoft Exchange profile you want to use 
for group scheduling (your profile includes information about the location of your Inbox, Outbox, and 
address lists).
The Delete Messages after Retrieving box should be checked unless you need to be able to access 
group scheduling messages from more than one location.
Enter your Internet address in the box so that Internet Sidekick can use Exchange for group 
scheduling on the Internet.
When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: Mail Server Information
Internet Sidekick needs to know the location of the mail servers for your incoming mail (called a POP3 
server) and outgoing mail (called an SMTP server). Enter the information in the text boxes provided. If 
necessary, ask your network administrator or Internet service provider for assistance.
When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: POP3 Information
Enter the required information about your electronic mail account for incoming mail. 
POP3 account is the name you use for logging on to the POP3 server. Type the name exactly as it is 
entered when you log on.
Delete messages after retrieving them, when checked, deletes messages after they have been read
by Internet Sidekick.    Uncheck the box if you want to leave the messages on the server.
POP3 Password is the password associated with your account name. Type it again in the Retype box 
to confirm.
When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: Name and Address 
Enter the name and electronic mail address to be used with group scheduling messages.
Name is your name as you would like it to appear in group scheduling messages (this does not have 
to match your log-in name).
E-mail Address is the address where you want e-mail messages for scheduling events and replying 
invitations sent. 
When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: Flash Sessions 
Check Activate Flash Sessions if you want Internet Sidekick to automatically initiate electronic mail 
sessions to send and receive group scheduling messages.
Specify the time when you want the first session, and how often sessions should occur after that.
Check each day when you want flash sessions to occur.
When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: Registration Information
Starfish Software’s electronic registration makes it easy for you to become a registered user. Just fill in 
the information in the text fields provided.    Be sure the Yes response at the top of the screen is 
selected.
The completed registration form will be automatically sent to Starfish Software by e-mail during your 
next online session.
When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: Registration Address
Type your address information in the text boxes.    By providing your mail address, you make it 
possible for Starfish Software to keep you informed of updates to Internet Sidekick and new products.
When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: Registration Options
Click the apprpropriate responses to the questions regarding e-mail notification and use of the Starfish 
Software list.
When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: Mail Registration
Because you have not entered e-mail information, electronic registration is not available. If you want to
enter e-mail information now, click the Back button and choose Automated Setup (the recommended 
choice) or Custom Setup. 
You can also double click the file called REGISTER.TXT in the Internet Sidekick directory to open it.    
Fill in your information, and print a copy of the completed file to mail to Starfish Software.
When done, click Next to continue, Back for the previous page, or Cancel.



Setup Wizard: Finish 
You have entered the required information. Click Finish to complete the setup process and return to 
Internet Sidekick.
Or click Back for the previous page, or Cancel.



Attach a Uniform Resource Locator
 Related topics

Lets you enter a    Web site address (URL)in the Message text field. Click the Attach URL button on the
Message page to open the Attach a Uniform Resource Locator dialog box.    
Recipients can click the URL to launch their default browsers and jump directly to the site (requires a 
32-bit browser).

Dialog Box Options

Description
Type a description of the URL you’re attaching. Recipients click on the URL to launch their browsers 
and go directly to the site.

Uniform Resource Locator (URL)
Enter the URL address for the site, such as http://www.starfishsoftware.com.



E-mail Setup dialog box
Use the E-mail Setup dialog box to enter your Internet e-mail configuration.

Dialog Box Options

Outgoing Mail (SMTP) Server 
Enter the name of your outgoing server or host, such as mail.xyz.com.

Incoming Mail (POP3) Server
Enter the name of your incoming mail server or host, such as mail.xyz.com.

Pop User Name
Enter your user name, such as jsmith@xyz.com.

Pop User Password
Type your password.

Time Out After
Determines how long the POP3 server waits for data before “timing out.”

Your Name
Type your name as you would use it in correspondence.

Your E-mail Address
Enter your e-mail address, such as jsmith@xyz.com.

Your Organization
Type the name of your company or organization.



Select a Different Time Zone 
The Select a Different Time Zone command (Tools | Select Different Time Zone) lets you choose a 
temporary time zone, so you can view your appointments and group scheduling events in a diffferent 
time.
Use this dialog box if you are scheduling appointments in a different time zone, and want to see and 
work with your schedule as it will appear when you are at your destination. 
For example, if you will be in Tokyo next week, you can schedule events in Tokyo time by changing the
time zone temporarily. Then you can enter your appointments in the local time. When you restore your 
normal Local Clock time, your Tokyo appointments will appear in your local time.
Note This dialog box changes all time related events to the time zone you specify, except that the 

Local Clock in EarthTime is not affected. If you exit and restart Internet Sidekick, your Local 
Clock time is restored for all time-related functions.

Shortcut

Toolbar:

Dialog Box Options

Time Zones 
Displays your current Local Clock time as set in EarthTime, and the current time zone selected in this 
dialog box.

Country
Determines what cities appear in the City list below. Initially set to All Countries.

City
Select the city from this list, and its time zone will automatically be selected.

Time Zone
You can specify a time zone without selecting a city by choosing from this list.

Find the Local Time Zone
Once you have change the temporary time zone, you can return to your Local Clock time by clicking 
this button. Your local time zone will appear in the Time Zone list, and you can click OK to select it.



New Report Dialog Box
The New Report dialog box opens when you click the New Report button on the Custom Toolbar.

Dialog Box Options

New Report
Click to create a new report.

Open Report
Click to open a report saved on disk.

Current Report
Click to go to the currently open report.

Create New (report type)
If you check New Report, check the report type you want in this list.



Select Cardfile to Save To Dialog Box
The Select Cardfile To Save To dialog box opens when you click Save To Card in the Phone Dialer. 
The currently selected item in the Call History window is saved to the cardfile you specify in this dialog 
box. 
Click the cardfile you want to save to, and click OK. 



Starfish TrueSync
Starfish TrueSync™ is an add-on feature which synchronizes information in Internet Sidekick with 
portable electronic organizers and other devices. 
For more details, visit the Starfish Software Web site: 
http://www.starfishsoftware.com/products/truesync/truesync.html



Introducing Starfish Internet Sidekick 
Welcome to Starfish Internet Sidekick!
Internet Sidekick brings you Internet scheduling technology with the convenience of the world’s best-
selling personal information manager. The key features of Internet Sidekick are summarized below. 
Note If you have the Lite version, it does not include all features of the full Internet Sidekick. For 

details about the Lite features, see the file called Readme.txt, which can be found on the 
distribution disk and is installed in the Internet Sidekick directory. You can double-click 
Readme.txt to read it, or open it with any text editor or word processor.

Internet scheduling features

Event and resource scheduling are handled automatically using Internet messaging. Internet 
Sidekick’s peer-to-peer, agent-based design means you can easily schedule events with people 
anywhere in the online world, whether they are in your own city or on the other side of the world.    All the 
messaging needed to schedule the event is handled in the background.

Message-based scheduling, using sophisticated store-and-forward technology, ensures the 
integrity of scheduling data. Internet Sidekick keeps redundant data files to help you recover if a disaster, 
such as a power failure, should occur. When Internet Sidekick starts up after such a system failure, it 
rebuilds the scheduling files by working back from the fragments left behind to reconstruct the data, 
minimizing the chance of lost information.

The sophisticated messaging technology also lets you reserve resources, working unattended in 
the background to generate a reply confirming a reservation or listing alternate available times.

QuickZip technology is used for automated resource transfer, to collect and deliver data files in 
compressed form, with minimum transmission time. Backup copies are maintained until automatic 
confirmation is returned from the new resource manager’s system.

Your Eudora Pro (32-bit), Netscape Navigator, or Microsoft Exchange address book can be used 
for event scheduling. 

Other key new features 

Automatic caller ID looks up incoming phone numbers in your Sidekick cardfile and displays caller
information.

Launch URL takes you directly to an Internet site from the Cardfile or Internet scheduling 
message.

Synchronization lets you coordinate files between two computers running Internet Sidekick.

Automatic spell checking looks up words as you type.
…and much more.



Overview: Learning About Internet Sidekick
   Related topics  

Starfish Internet Sidekick is divided into a number of “views,” such as the Calendar view and the 
Cardfile view. To learn about Internet Sidekick, use the series of “About…” topics which introduce the 
views and major features. 
Here is how to use these overview topics:

Read each topic, using the scroll bars if necessary to see all the information.    

Click the >> button at the top of each screen to go to the next topic.    You can click the << button 
to go back to the previous topic.    

To see more information relating to the current subject, click the Related Topics button that 
appears below the topic title. Double-click the topic you want in the list. 

To return to this topic, click the Related Topics button and choose the “Overview…” topic.
The overview topics are also listed in the Table of Contents, at the start of most major sections.
For more information about using the books and topics in this Help system, click the underlined text 
that follows, and you will go directly to How To Use Sidekick Help.



About the Calendar View
   Related topics  

The Calendar view organizes your appointments, To Do items, and calls you need to make in one 
convenient place.    It includes the Viewport, which lets you see other Sidekick views and create an 
activity with someone in your Cardfile using drag-and-drop. You can also create group events in the 
Calendar (or Activities view), where Internet Sidekick sends invitations and books the event for you 
automatically. 

Features and Options
Events pane is where you create and view scheduled events. At the top is the current time zone in 
which Calendar events are displayed. Click any line and begin typing to enter a basic appointment. 
Double-click a time slot or appointment icon to open the Schedule an Event dialog box. See Adding an
Appointment.
To Do pane contains your list of items you need to do. You can assign a due date and priority, and add
text. Click the Show By button to specify how the items are sorted. Click the left column to check off a 
completed To Do item.    Uncompleted To Do items are automatically forwarded from day to day. See 
To Do / Goals Dialog Box.
Calls pane lists calls you need to make. Click the left column to check off a completed call.    
Uncompleted calls are automatically forwarded from day to day. See Calls.
Viewport is at the bottom of the Events pane.    Click the arrow button to open or close it.    You can 
view Cards, the Contact Log, or Goals list in the Viewport. You can drag a card from the Viewport to a 
time slot in the Events pane, or to the Calls or To Do panes, to create an event.
Calendar pane, above the To Do pane, displays the current date and calendar of the month.    Click a 
date in the month calendar, or click the arrows next to the month and year to change the date 
displayed.
Daily, Weekly, Monthly, Yearly tabs let you select the view of your calendar.    Double-click a date in 
the Weekly, Monthly or Yearly views to jump directly to that date in Daily view.
Toolbar contains buttons you can click to perform various tasks. To see what a button does, hold the 
mouse pointer over it and pause for a moment. A “tool tip” will appear. 
Status bar appears at the bottom of the display.    You can turn it on or off using the View | Status Bar 
command.
Custom Toolbar contains a set of buttons you define. Display or hide the Custom Toolbar using View |
Custom Toolbar.    Customize it using Tools | Setup | Custom Toolbar.



About Internet Scheduling and the Activities View
   Related topics  

The Activities view lists all your Internet events, plus your Calendar events: Calls, To Do items, and 
appointments. Use it to view events, create event invitations, reply to incoming invitations, and more.    
You can also see an overview of all your Calendar activities for a time period you select.
Internet Scheduling uses Internet messaging to send invitations and collect replies automatically for a 
group event you want to schedule. 
The people you invite receive a message showing the meeting information, and they can click buttons 
to Accept, Decline, Request Rescheduling, or Delegate the event to someone else. Internet Sidekick 
sends the invitation and reply messages. The event information is displayed in the Activities view and 
added to participants’ calendars. 
You also can schedule resources, such as conference rooms, projectors, and vehicles. You get an 
automatic response from the resource’s calendar confirming your reservation or listing available times.
The icon on the Deskpad (shown above) is animated and changes color when you have unread 
Internet scheduling messages, including invitations or replies to your invitations. 
The easiest way to schedule an event is to use the Internet | Scheduling Wizard command in the 
Activities, Calendar, or Cardfile view.

Activities View Features and Options
Tabs let you select what to display: All, Appointments, To Do items, Calls, and Internet    Events. The 
All tab displays all events that appear in your Calendar View, including Appointments, To Do items, 
Calls, and confirmed group scheduling events, plus Special Days and Multi-Day Events. 
Show box lets you choose the time period or events you want to see.
Column headings provide brief information about the event: Type, New, Outbox, Date and Time, 
Subject, Initiator, Location (for group events).    Icons in the New column indicate a new incoming 
invitation, reply or other message. An icon in Outbox indicates a message that hasn’t been sent yet. 
Click a column heading to sort entries on that field.
Details pane (Internet Events) shows the date and time, participants, and other information about the 
selected event. Click the + next to an entry to expand it, if necessary.
Information pane (Internet Events) shows the specifics of the selected event, or the item selected in 
the Details pane. 
Buttons change depending on the type of event that is selected. For example, the New button opens 
the Schedule an Event dialog box when an incoming or outgoing event is selected, or the Resource 
Wizard if a resource message is selected. For Calendar events, the Go To button takes you to the 
Calendar and highlights the selected event.



About the EarthTime View
   Related topics  

The EarthTime view lets you see the time in eight locations around the world, along with a world map 
where you can follow the movement of the sun and seasonal changes.

Features and Options
Map displays the sunrise/sunset line, updated every minute. Right-click a map location and choose 
Center Map Here to shift the map horizontally.
City Clocks show the current time in eight locations. Drag from one city clock (the time panel) to 
another to see the Time Difference display for those two cities.    Drag one city name to another to 
switch the positions of the two clocks.
Right-click a clock to see a menu of options. Facts About the City shows you language, currency, 
telephone codes and other useful information about the city.    Other menu options let you modify the 
city’s information, change the displayed city, and more.

Icons
The house icon indicates your Home clock.

The person icon indicates your Local clock.
The yellow diamond icon indicates a city where daylight saving time is in effect.



About the Cardfile View

   Related topics  

The Cardfile stores names, addresses, phone numbers, e-mail addresses, and any other kind of data 
you need. The e-mail addresses are used for Internet scheduling in the Calendar. You can store the 
Uniform Resource Locators (URL) of your favorite sites on the World Wide Web, and use them to start 
your browser and jump directly to the site. You can use Mail Merge to combine information from a 
cardfile with a Write document or letter, and dial phone numbers automatically with the Phone Dialer. 

Features and Options
Index line in the left pane contains the indexes of each card in the cardfile. Each index consists of one
to three card fields. The cards are sorted according to their index lines. Click the index line of a card to 
see its data.
Card data appears in the right pane. The field names appear at the left, and the data for the current 
card is to the right.
Viewport is at the bottom of the card data pane. Click the arrow to open and close the Viewport.    
Click the button to choose what to display in the Viewport: Appointments, Calls, To Do items, Contact 
Log or Goals List.
Cardfile tabs at the bottom of the window represent the open cardfiles. 



About the Write View

   Related topics  

Use the Write view to create and format your letters, memos and other documents.    Auto Spell Check 
works in the background to check spelling as you write. You can use Mail Merge to create documents 
using name and address information from the Cardfile, and you can send your documents by e-mail or
fax directly from Internet Sidekick (requires an e-mail account and fax modem).

Features and Options
Index pane lists the documents in the current folder. Documents are sorted by date or subject (use 
Write | Document | Sort to change the order). 
Text pane contains the text of the current document.
Toolbar formatting buttons let you apply formats to the characters and paragraphs of your 
documents. 

Viewport is at the bottom of the text pane.    Click the arrow to open and close the Viewport.    Click the
button to choose what to display in the Viewport: Appointments, Calls, To Do items, Cards or Goals 
List.    



About the Expense View

   Related topics  

The Expense view lets you enter information from your receipts, and then totals your receipts in a 
formatted expense report, ready for you to print and sign. As you enter receipts, you choose data such 
as city names and restaurants from lists that grow automatically to include your new entries. 

Features and Options
Receipt view is where you enter the raw data from the pile of receipts you have collected. Enter the 
receipts just as you find them, and Sidekick will take care of sorting and categorizing.    The receipt 
type, date, and amount appear in the left pane, and the details of the currently selected receipt appear 

at the right.    Click the Add button  to enter a new receipt.    
Report view totals your receipts in a formatted expense report.    You can edit the personal information at 
the top. 

By determines what is included in your report. By Week lets you create a report by week. By 
Range lets you specify a range of dates. By Folder lets you create a report for the contents of the current
folder.

Account lets you select an account, or all accounts, to include in the report. 

From Receipt view, click  to go to Report view.

From Report view, click  to go to Receipt view.



About the Phone Dialer

   Related topics  

The Phone Dialer can dial your voice calls using a phone number from your cardfile, or a number you 
type. It also can answer incoming calls and look up the caller’s number in the current cardfile (if you 
have Caller ID service and required hardware). You can type notes about the call to record in a card’s 
Contact Log, which you can view in the Viewport. 
To open the Phone Dialer, click its icon on the desktop, or drag a card that contains a phone number to
the icon, or press F9.

Features and Options
Phone Number pane displays the phone number(s) in the current card. You can leave the Phone 
Dialer open and click a different card in the Viewport or Cardfile view, and its phone numbers appear in
the display. The pane includes a status line that displays the current dialing status.
Number to Dial is the currently selected number in the Phone Number pane, or a number you type or 
enter in the keypad.
Dial button causes the number in the Number to Dial field to be dialed.
Redial button causes the last number dialed to be redialed. The number that will be redialed appears 
in the title bar.
Answer button answers an incoming call, and stamps Answer to the Contact Log.
Hang Up button disconnects the modem.
History button opens the History pane, where you can see a log of recent Phone Dialer activity. If you
have been away from your desk, the History pane will contain a list of incoming calls, and the number 
calling if you have Caller ID.
Call Note button opens the Call Note pane. You can type a Call note in the text area provided. Click 
Save to Current Contact Log to save the note.    
Timer, at the top of the Call Note pane, times your calls.    The Start and Reset buttons control the 
operation of the timer.
Setup button opens the Phone Dialer Setup dialog box.
Delete button (In Call History window) deletes the selected entry in the Call History.
Save to Card button (in Call History window) saves the current entry in the Call History pane to a new
card.



About the Report View

   Related topics  

The report view displays reports, which collect and organize information from the Cardfile or Calendar. 
To see the Report view, choose a report type from the Reports menu in the Calendar or Cardfile views.
The report types are 

Cardfile report
Calendar report
Free Time report
To Do Items report
Contact Log report



About Internet Time Synchronizer
Internet Time Synchronizer precisely synchronizes your computer’s system clock with an Internet time 
server, ensuring that your system time is accurate and reliable. 
Internet Time Synchronizer can monitor your dial-up connections, and check the time once you are 
connected for any other purpose. For example, if you periodically connect to check your mail, it can 
automatically get the precise time in the background during your mail session.
If you have the Timex Datalink, you can set your watch from your computer, so it too is always 
accurate.
For help using Internet Time Synchronizer, right-click its icon in the System Tray (in the Windows 
taskbar), and choose Help.



Information About File Conversions
The import/export and synchronizing technology is provided by IntelliLink. 
IntelliLink, the leader in products to facilitate information exchange between mobile handheld devices 
and applications running on PCs, offers support for a wide range of popular PDAs and handheld 
organizers, including models from the following manufacturers:

Casio
Franklin
Hewlett-Packard
Motorola
Psion
Sharp
Sony
Tandy

Intellilink is constantly adding to this list.    For a complete, up-to-date listing of supported devices or to 
place your order, please contact Intellilink at 603-888-0666 or visit their web site at http://www.ilink-
corp.com.



Using Internet Sidekick Help

Help Contents 
To get Help at any time, choose Contents from the Help menu. The Help Contents window contains 
three tabs. Click the one you want to use.

Contents:    Double-click any closed book to “open” it and see its contents. Double-click any page to read 
its contents. From there you can click the Contents button to return to the Contents window. Double-click 
an open book to close it.
Index:    Type a word you want to search for in the index. Then double click a topic in the list that appears 
to jump to that topic. You can click the Contents button to return to the Contents window.
Find:    When you click this tab for the first time, a complete word list of the Help system is created (it’s 
automatically stored, so it doesn’t need to be re-created after the first time). Type a word or part of a word,
and double-click the topic title you want. 

Context-sensitive Help
When you are in a dialog box that has a Help button, click the button for help on your current location. 
To see detailed reference information about menu commands, highlight a menu command press 
(using the keyboard) and press F1. The Help topic for that command appears. 

ToolTips
Sidekick identifies each menu command or Toolbar button when you move the mouse pointer over it 
and pause. A description appears in a small box next to the button, and disappears when you move 
the mouse off the button.

Navigating in Help
Help topics appear in different kinds of windows depending on the nature of the topic.    Most Help 
windows have buttons at the top to help you navigate, including some or all of the following:

Contents takes you to the contents window for the Help system
Index takes you to the index for the Help system, where you can type a word you want information 
about. 
Back takes you to the previous Help topic you viewed.
>> and << are the browse buttons. They take you forward (>>) and back (<<) in a series of related 
Help topics. 
Related Topics, appearing in the Help topic title region, shows you a list of related Help topics you 
can jump to.
Jumps appear as underlined text which you click to see more information. A dotted underline 
indicates a definition or other “pop-up” window which closes as soon as you click the mouse button. 
Here’s an example of a definition: Internet scheduling. A solid underline indicates a jump to another 
Help topic, for example, Introducing Internet Sidekick. 

More Information
For more details about standard Windows Help features, including Help menus and buttons, press F1 
in any Help window. 



Toolbar and Custom Toolbar
The Toolbar and Custom Toolbar contain buttons that immediately execute certain Internet Sidekick 
commands. For example, instead of choosing File | Save All, you can simply click the Save All button.

You can configure Sidekick's Custom Toolbar differently for most views of Sidekick. The list of buttons you
can choose when setting up the Custom Toolbar varies for each part of Internet Sidekick. 
For information about configuring a Custom Toolbar, choose Tools | Setup | Custom Toolbar. 

Additionally, there is a non-customizable Toolbar available in several views. This Toolbar contains 
buttons for the most common commands of each view.



Contacting Starfish Software

World Wide Web
Be sure to visit the Starfish Web site any time you want the latest product information. (If this link 
doesn’t work with your browser, launch your browser and paste in the following address: 
http://www.starfishsoftware.com).

Frequently Asked Questions
For the answers to frequently asked questions, click the underlined text to jump directly to the FAQ 
page on the Starfish Web site. Or paste this URL into your browser: 
http://www.starfishsoftware.com/service/ti.html

Technical Support Services
For technical assistance, please contact one of the following services.

CompuServe
GO STARFISH

America Online
Keyword: Starfish

Microsoft Network
Go Word: Starfish

Starfish Web Site
http://www.starfishsoftware.com

Free Starfish BBS
408-461-5930 8-N-1 Up to 28.8 kbps

Free Fax Information
U.S. 1-800-503-3847 Requires a fax machine

Product orders
24-hours a day, 7 days a week
800-765-7839

Customer Feedback
Your feedback, wish lists, and ideas for future enhancements to our products are very important to us. 
Please feel free to drop us a line via mail or fax with your ideas and suggestions. 

Starfish Software
Attn: Product Management
1700 Green Hills Road
Scotts Valley, CA 95066
Fax: 408-461-5900

International Support
For technical and customer support outside North America, please contact one of the online services 
listed above or your local Starfish office. 

Australia:
Tech Support Phone: 02 899 5888
Tech Support Fax: 02 899 5728



France:
Tech Support Phone: 33 1 46 04 29 32
Tech Support Fax: 33 1 47 12 99 15
Monday through Friday, 9:30-12:00, 14:30-17:00

Germany:
Tech Support Phone: 49 0 89 143 12 666
Tech Support Fax: 49 0 89 143 12 670
Monday through Friday, 9:00 to 12:00, 13:00 to 17:00 

Italy:
Tech Support Phone: 39 2 9358 2260
Tech Support Fax: 39 2 9358 2280

Japan:
Tech Support Phone: 81 3 5352 1172
Tech Support Fax: 81 3 5352 1171

Spain:
Tech Support Phone: 91 352 62 00
Tech Support Fax: 91 352 94 31
Monday through Friday, 09:00 to 14:00

UK:
Tech Support Phone: 44 1923 209 107 (Registration)
Monday through Friday, 09:00-17:00



Sidekick Files

Filename Extensions
The following extensions are used by Internet Sidekick.
Extension Description

.SKTmpCard Cardfile temporary data file

.TMP Calendar temporary data file

.SKTmpContent Write temporary data file

.TPT Report template file

.LOG Back Up And Restore file that lists files being copied

.RPT Report file

.SKCard Cardfile

.SEE Expense file

.SKB A backup copy of your Sidekick 95 calendar file, if you open one in 
Internet Sidekick.

Calendar files
Your calendar file is actually eight files in the *????.SKW format, where * represents the name you 
enter. When saving, opening, backing up, or restoring calendar files, Sidekick lists * as the name of the
calendar. The ???? part of the file name represents four characters that stand for the type of calendar 
file, as listed here. Thus a group of calendar files might have names in the form Jean workEVEN.SKW,
Jean workCALL.SKW, and so on.
*EVEN.SKW Appointment list data file
*CALL.SKW Call list data file
*TASK.SKW To Do list data file
*MAST.SKW Goals list data file
*RECR.SKW Recurring Appointment, Call, and To Do data file
*INIT.SKW Calendar initialization data file
*DATA.SKW Multi-day events and Special Days data file
*CSCA.SKW Categories, assigns, call status, and predefined activities data file

Write files
A Write file is composed of three files in the formats listed below. The asterisk represents the name 
you give the file when you save it from the Write view. 
*.SKWrite Write folder file
*.SKNoteHeader Write header file
*.SKContent Write data file
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Glossary
Click any topic below to see information about it.
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Viewport



activity
An appointment, To Do, call, or Goal. 



appointment
A scheduled meeting or event. Appointments can occur once or they can be recurring.



binder
A Write file containing documents arranged in one or more folders.



Calendar files
A collection of Sidekick files representing the various parts of the Calendar. The files all begin with the 
user name and have an .SKW extension. Calendar files can be located anywhere, as long as they are 
all in the same directory (normally the Internet Sidekick USERDATA directory, unless you have 
specified otherwise).



Call icon

A drag and drop target that triggers the Phone Dialer dialog box, when a card or other item containing 
a phone number is dropped on it.



Cardfile
A database or organized collection of information, such as an address book. Each cardfile can have up
to 30,000 cards.



cardfile template
A collection of field names to apply to a new cardfile. You can create your own cardfile templates, or 
use the ones supplied with Sidekick.



card
An individual record or entry in a cardfile, such as a person in an address book. Each cardfile can have
up to 20,000 cards.



Clipboard
A temporary storage area for cut or copied text. The Clipboard holds the information until new text is 
cut or copied.



condition
An equation consisting of a field name, an operator, and a value used to find specific cards in a 
cardfile. For example, City Equal to San Jose is a condition for finding all cards in a cardfile with San 
Jose in the City field. 



contact
A person or company listed as a card in a cardfile. Manage your contacts with the Tools | Contact 
Manager command.



Contact Log
A place for entering documents specific to a particular card in the Cardfile, or for recording a history of 
phone calls made or answered, appointments, and mail merges performed with the card. Each card 
has its own Contact Log.



Custom Toolbar
The customizable palette of buttons that appear to the right side of the screen (as the default position).
You can customize the buttons on the Custom Toolbar in each view. To change the buttons on the 
Custom Toolbar for any Sidekick view, choose Tools | Setup | Custom Toolbar. You can “dock” the 
Custom Toolbar to any side of the the Sidekick Deskpad, or make it a floating palette. You can also 
hide the Custom Toolbar.



Delete icon

A drag and drop target on the Sidekick Deskpad for deleting cards, documents, or calendar activities.



Deskpad
The visual metaphor used by Sidekick. Each of the components of Sidekick appears in a    desk-like 
area where you organize your activities.



Deskpad icons
A vertical column of icons to the right of the Sidekick Deskpad. Most of these icons correspond to the 
various views in Sidekick. There are eight icons: Cardfile, Calendar, Write, Expense, Events, 
EarthTime, Call, and Delete.



Drag and Drop
Dragging an object onto another and “dropping” it is an easy way to move the object or use it to launch
another process.    To drag, move the mouse over the object. Hold down the left (primary) mouse 
button and then move the mouse toward the drop “target.”    Release the button over the drop target.
Examples:

Dragging a Cardfile card from the Viewport and dropping it on a time in the Calendar Appointments, 
Calls or To Do pane creates an entry using the card information.
Dragging any Calendar event to the Phone Dialer icon and dropping it opens the Phone Dialer. If 
there is a phone number in the Calendar event, it is ready to dial.
Dragging the index of a Write document or Cardfile card to a tab moves the document or card to that
tab.



Exchange
The exchange is the first three digits of a telephone number, such as 555 in the phone number 555-
1234.



Extract Cards
A command that lets you copy the results of a cardfile search to a new cardfile. You can extract cards 
either on text, on an index range, or on condition.



fields
Pieces of data that make up a card, such as a name, address, phone number, and so on. Each cardfile
can have up to 100 fields defined.



field names
The description or label for a cardfile field to identify its use and distinguish it from other fields. Field 
names can be up to 39 characters long, either uppercase or lowercase.



flash session
An e-mail session which sends all your pending outbound group scheduling messages and collects all 
inbound messages before logging off automatically.



Free Time report
A report showing your free time for the next 30 days. You can attach it to a reply declining an invitation 
or requesting rescheduling.    Appointments that are Public or Personal are indicated as booked time; 
Confidential appointments do not appear on the report.    



Goals list
Though similar to the To Do list, the Goals list can contain tasks that are longer term or have due dates
in the distant future. The tasks don't need your immediate attention, but you don't want to forget them.
Unlike the To Do list, which changes with each day, the Goals list shows all long-term tasks for an 
entire calendar year, independent of the date displayed in the calendar.



handle
A lack square box that appears at the corners and edges of a graphic element (such as the fields in a 
label printing template) when you select it.    Handles let you re-size the element. Move the mouse over
a handle until the double-headed arrow appears. Then click and hold down the left mouse button while
you drag the handle to a new position.



Home clock
In EarthTime, the time you designate as your home. Home Clock remains unchanged when you travel,
but you set Local Clock for your current location.



HTML
Hypertext Markup Language, the standard language for documents used on the World Wide Web.



Index line
The “title” of a card. An index line (or simply “index”) is composed of any three fields in a cardfile. The 
cardfile’s cards are sorted according to their indexes.



Internet scheduling
Internet scheduling lets you create a meeting or other event and select a list of participants. Internet 
Sidekick uses electronic messaging to automatically notify attendees, collect their replies, and add the 
event to the calendars of those who will attend. 



Local clock
The Local Clock is normally the same as your Home Clock. When you travel, you change the Local 
Clock to your current location. When you do, your computer’s system time is reset to match the Local 
Clock time. All your appointments are displayed in Local Clock time. 



Look For
A search box at the top of the Cards list and document list that lets you quickly find any card or 
document by typing a few characters of text from the desired card’s index or desired document’s 
subject. The first card matching the text is selected. Press Enter to get a list of the first 20 cards or 
documents that contain that text string anywhere in their indexes or subjects.



manager
The person whose computer stores the reservation schedule information for a resource. The 
manager’s Internet Sidekick receives reservation requests and sends back confirming or denying 
messages in the background, without direct involvement by the manager. The manager should have 
flash sessions at fairly frequent intervals so resource requests can be handled promptly. 



pages
In Sidekick, paper refers to a physical printing sheet, most commonly 8 1/2 x 11 inches, in the U.S.. 
Each piece of paper can be one section or divided into two, three, or four sections, called pages, each 
with it's own index tab and page number.



report style
A report file containing the font settings, title, and subtitles saved from an existing report. The saved 
formatting, or style, can then be applied to another report to change its formatting.



Resource
A resource is a facility such as a conference room, or equipment such as a projector or vehicle. You 
can reserve a resource automatically using the Internet | Reservation Wizard command. 



Ruler
An optional tool to show the dimensions of the current Write document. You also use the Ruler to 
change margins and set tabs. Use View | Ruler to show or hide the ruler.



Shortcut menu
A menu that appears when you right-click certain objects in Sidekick. For example, if you right-click an 
appointment on the Calendar, a Shortcut menu appears letting you perform tasks such as Undo, Cut, 
Copy, Paste, Edit, Reschedule, or make it a Recurring appointment..



To Do
Any task in need of attention that is not scheduled for a particular time of day. To Dos can occur once 
or they can be recurring.



Toolbar
A collection of preset buttons for each view. The Toolbar contains buttons to let you perform standard 
actions for that view. You can choose to hide the Toolbar. The buttons on the Toolbar are not 
configurable, as they are on the Custom Toolbar.



Uniform Resource Locator (URL)
An address on the Internet. The World Wide Web uses URLs to specify the locations of files on other 
servers.



Unimodem V
A modem driver that is required for using Caller ID and other advanced modem features.



Viewport
A window in the lower right corner of the Cardfile, Calendar, and Write views that lets you work with a 
part of another view without having to leave the one you're in. You can use the Viewport to drag 
information from one part of Sidekick to another, or simply to display information.



Shortcut Keys
Calendar Shortcut Keys
EarthTime Shortcut Keys
Cardfile Shortcut Keys
Write Shortcut Keys
Expense Shortcut Keys
Activities View Shortcut Keys
Reports Shortcut Keys
Calculator Function Keys



Calendar Shortcut Keys
Command Keys Description

File menu
New Calendar Ctrl+N Creates a new, untitled calendar.
Open Calendar Ctrl+O Opens a calendar.
Save Calendar Ctrl+S Saves the calendar.
Save Calendar As F12 Saves the calendar under a new name.
Save All Ctrl+L Saves all open Sidekick files in all views.
Print Sidekick Format Ctrl+P Prints the daily calendar in various Sidekick formats.
Exit Alt+F4 Exits Sidekick.

Edit menu
Undo Ctrl+Z Reverses the last edit operation.
Cut Ctrl+X Removes selected text and puts it on the Clipboard.
Copy Ctrl+C Copies selected text onto the Clipboard.
Paste Ctrl+V Inserts the Clipboard contents at the insertion point.
Go To Today Ctrl+G Goes to today's date in the Daily View. 
Find Ctrl+F Searches the calendar for specified text.
Add Card Ctrl+A Adds new cards to the cardfile.

View menu
Cardfile F5 Switches to the Cardfile.
Write F7 Switches to the Write view.
Expense F8 Switches to the Expense view.

Phone menu
Dialer F9 Opens and closes the Phone Dialer.

Help menu
Contents F1 Displays help on the selected command or dialog box, 

or displays the help contents.

Screen actions
Tab Moves the keyboard focus of the screen from one part of the Calendar to 

another in this order: To Do list, Calls list, Appointments list, Month 
selection, Year selection, and Date selection (mini calendar).

Arrow Up/Down Moves the insertion point up/down one line.
Ctrl+PgUp/PgDn Moves the insertion point to the top/bottom line in the selected list.
Page Up/Down Moves the insertion point up/down one screen.
Ctrl+Home/End Moves the insertion point to the top/bottom line in the list.
Shift+Arrow Up/Down Highlights lines one at a time.
Shift+PgUp/PgDn Highlights lines one screen at a time.
Ctrl+Alt+Enter Add daily appointments, calls, and tasks.



Ctrl+Alt+C Check off current activity as completed.
Ctrl+Alt+A Set or take off the current line’s alarm icon.
Ctrl+Alt+U Set or take off the unconfirmed icon for the current appointment, the 

urgent icon for the current call, or the due date setting for the current 
goal.

Ctrl+Alt+T Set or take off the default call status for the current call.
Ctrl+Alt+O Set or take off the default priority setting for the current goal.
Ctrl+Alt+E Set or take off the default category for the current goal.
Ctrl+Alt+I Set or take off the default assignment of the current goal.
Alt+W Opens/closes the Viewport.
Ctrl+T Inserts the current time into the Contact Log, if selected.
Ctrl+D Inserts the current date into the Contact Log, if selected.



EarthTime Shortcut Keys
Command Keys Description

File menu
Save All Ctrl+L Saves all open Sidekick files in all views.
Exit Alt+F4 Exits Sidekick.

View menu
Cardfile F5 Switches to the Cardfile.
Calendar F6 Switches to the Calendar.
Write F7 Switches to the Write view.
Expense F8 Switches to the Expense view.

Phone menu
Dialer F9 Opens and closes the Phone Dialer.

Help menu
Contents F1 Displays help on the selected command or dialog box, 

or displays the help contents.



Cardfile Shortcut Keys
Command Keys Description

File menu
New Cardfile Ctrl+N Creates a new, untitled cardfile.
Open Cardfile Ctrl+O Opens a cardfile.
Close Cardfile Ctrl+W Closes the active cardfile.
Save Cardfile Ctrl+S Saves the active cardfile.
Save Cardfile As F12 Saves the active cardfile under a new name.
Save All Ctrl+L Saves all open Sidekick files in all views.
Print Cards Ctrl+P Prints cards and/or Contact Log information.
Exit Alt+F4 Exits Sidekick.

Edit menu
Undo Ctrl+Z Reverses the last edit operation.
Cut Ctrl+X Removes selected text and puts it on the Clipboard.
Copy Ctrl+C Copies selected text onto the Clipboard.
Paste Ctrl+V Inserts the Clipboard contents at the insertion point.
Copy Special Ctrl+Y Copies fields and text to the Clipboard. Use Copy 

Special Setup to define the contents.
Go To Cardfile Ctrl+G Goes to specified cardfile.
Find Text Ctrl+F Opens the Find Text dialog box. Searches for the text 

you specify.
Find Next/Previous F3 Finds the next occurrence of the last text specified.

View menu
Calendar F6 Switches to the Calendar.
Write F7 Switches to the Write view.
Expense F8 Switches to the Expense view.
Index/Card View Ctrl+E Switches the Cardfile between Edit View and Indexed 

view.

Cards menu
Add Ctrl+A Adds new cards.
Mark Current Card Ctrl+K Marks or unmarks the active card.
Sort Ctrl+R Sorts the cardfile by any three fields by changing the 

index line of each card.
Reorder Tabs F11 Reorders the cardfile tabs at the bottom of the screen.

Phone menu
Dialer F9 Opens and closes the Phone Dialer.

Help menu
Contents F1 Displays help on the selected command or dialog box, 



or displays the help contents.

Screen actions
Alt+L Moves the insertion point to the Look For text box.
Ctrl+Home Moves the insertion point to the first field on the selected card.
Ctrl+End Moves the insertion point to the last field on the selected card.
Ctrl+Shift+Home Jumps to first card in the cards list.
Ctrl+Shift+End Jumps to last card in the cards list.
Ctrl+Shift+PgUp Moves up one card in the cards list.
Ctrl+Shift+PgDn Moves down one card in the cards list.
Ctrl+PgUp Selects the previous cardfile along the cardfile tabs as the active cardfile.
Ctrl+PgDn Selects the next cardfile along the cardfile tabs as the active cardfile.
Alt+W Opens/closes the Viewport.
Ctrl+T Inserts the current time into the Contact Log, if selected.
Ctrl+D Inserts the current date into the Contact Log, if selected.



Write Shortcut Keys
Command Keys Description

File menu
New Binder Ctrl+N Creates a new, untitled Binder.
Open Binder Ctrl+O Opens a Binder.
Save Binder Ctrl+S Saves all documents.
Save Binder As F12 Saves the Binder under a new name.
Save All Ctrl+L Saves all open Sidekick files in all views.
Print Ctrl+P Prints documents.
Exit Alt+F4 Exits Sidekick.

Edit menu
Undo Ctrl+Z Reverses the last edit operation.
Cut Ctrl+X Removes selected text and puts it on the Clipboard.
Copy Ctrl+C Copies selected text onto the Clipboard.
Paste Ctrl+V Inserts the Clipboard contents at the insertion point.
Go To Folder Ctrl+G Goes to the specified folder.
Find Ctrl+F Opens the Find dialog box. Searches for the text you 

specify.

View menu
Cardfile F5 Switches to the Cardfile.
Calendar F6 Switches to the Calendar.
Expense F8 Switches to the Expense view.
Folder/Document View Ctrl+E Switches Write between Edit View and Indexed view.

Write menu
Document | Add Ctrl+A Adds a new document.
Document | Sort Ctrl+R Sorts the documents.
Document Mark Current Document Ctrl+K Marks or unmarks the current document.
Binder | Reorder Tabs F11 Reorders the folder tabs at the bottom of the screen.

Phone menu
Dialer F9 Opens and closes the Phone Dialer.

Help menu
Contents F1 Displays help on the selected command or dialog box, 

or displays the help contents.

Screen actions
Ctrl+Delete Delete next word
Ctrl+Backspace Delete previous word
Ctrl+B Set selected text as bold.



Ctrl+I Set selected text as italic.
Ctrl+U Set selected text as underline.
Alt+L Moves the insertion point to the Look For text box.
Alt+W Opens/closes the Viewport.
Ctrl+Home Moves to the top of the document.
Ctrl+End Moves to the bottom of the document.
Arrow Up/Down Moves the insertion point one line up/down.
Home Moves the insertion point to the start of the line.
End Moves the insertion point to the end of the line.
PgUp Moves the insertion point up one window.
PgDn Moves the insertion point down one window.
Ctrl+Left/Right Arrow Moves to the previous/next word.
Ctrl+Up/Down Arrow Moves to the previous/next paragraph.
Ctrl+Shift+Home Selects from insertion point to the top of the document.
Ctrl+Shift+End Selects from insertion point to the bottom of the document.
Shift+movement keys Performs the same action as the movement keys, but selects from the 

insertion point.



Expense Shortcut Keys
Command Keys Description

File menu
New Expenses Ctrl+N Creates a new, untitled expense file.
Open Expenses Ctrl+O Opens an expense file.
Save Expenses Ctrl+S Saves the expense file.
Save Expenses As F12 Saves the expense file under a new name.
Save All Ctrl+L Saves all open Sidekick files in all views.
Print Ctrl+P Prints the expense file.
Exit Alt+F4 Exits Sidekick.

View menu
Cardfile F5 Switches to the Cardfile.
Calendar F6 Switches to the Calendar.
Write F7 Switches to the Write view.

Expense menu
Add receipt Ctrl+A Adds a new receipt.

Phone menu
Dialer F9 Opens and closes the Phone Dialer.

Help menu
Contents F1 Displays help on the selected command or dialog box, 

or displays the help contents.



Activities View Shortcut Keys
Command Keys Description

File menu
Save All Ctrl+L Saves all open Sidekick files in all views.
Print Ctrl+P Prints the Activities view.
Exit Alt+F4 Exits Sidekick.

View menu
Cardfile F5 Switches to the Cardfile.
Calendar F6 Switches to the Calendar.
Write F7 Switches to the Write view.
Expense F8 Switches to the Expense view.

Phone menu
Dialer F9 Opens and closes the Phone Dialer.

Help menu
Contents F1 Displays help on the selected command or dialog box, 

or displays the help contents.



Report Shortcut Keys
Command Keys Description

File menu
New Report Ctrl+N Creates a new, untitled report.
Open Report Ctrl+O Opens a report.
Save Report Ctrl+S Saves the report.
Save Report As F12 Saves the report under a new name.
Save All Ctrl+L Saves all open Sidekick files in all views.
Print Ctrl+P Prints the report.
Exit Alt+F4 Exits Sidekick.

Edit menu
Copy Ctrl+C Copies the highlighted area to the Clipboard.

View menu
Cardfile F5 Switches to the Cardfile.
Calendar F6 Switches to the Calendar.
Write F7 Switches to the Write view.
Expense F8 Switches to the Expense view.

Layout menu
Font Ctrl+Shift+F Sets the fonts used in the report.
Change Column Width Ctrl+U Changes the width of specified columns.

Help menu
Contents F1 Displays help on the selected command or dialog box, 

or displays the help contents.

Screen actions
Ctrl+Home Moves to the first cell.
Ctrl+End Moves to the last cell.
Arrow Keys Moves from cell to cell.
Ctrl+Down/Up Arrow Moves to the last/first cell in the current column.
Ctrl+Right/Left Arrow Moves to the last/first cell in the current row.
Shift+Arrow Keys Highlights multiple cells.
Ctrl+Shift+Arrow Keys Highlights the current row or column.
Ctrl+Shift+Home/End Highlights the entire report.



Calculator Function Keys
Button Keys Function

M+ P Adds the displayed value to any value already in memory. 
MS M Stores the displayed value in memory. 
MR R Recalls the value stored in memory. 
MC C Clears any value stored in memory. 
+/- Crtl+F9 Changes the sign of the displayed number. 
. . Inserts a decimal point in the displayed number. 
sqrt @ Calculates the square root of the displayed value. 
+ + Adds. 
- - Subtracts. 
* * Multiplies. 
/ / Divides. 
= Enter Performs any operation on the previous two numbers. 

Choose again to repeat the last operation. 
1/x Ctrl+R Calculates the reciprocal of the displayed number. 
F1 Ctrl+F1 Applies the operation set up for F1 to the displayed number.

Shift+F1 Resets the operation set up for F1.
F2 Ctrl+F2 Applies the operation set up for F2 to the displayed number.

Shift+F2 Resets the operation set up for F2.
F3 Ctrl+F3 Applies the operation set up for F3 to the displayed number.

Shift+F3 Resets the operation set up for F3.
Backspace Deletes the right-most digit of the displayed number. 

C Esc Clears the current calculation. 
CE Del Clears the displayed number. 



Calendar Menu
The Calendar menu provides most of the tools for creating, modifying and managing your scheduled 
events. 
For more information, highlight one of the Calendar menu options, and press F1.



 Events
The Calendar | Events command lets you schedule your appointments. 
For more information, highlight one of the menu choices, and press F1.



 To Do Items
The Calendar | To Do Items command lets you schedule daily and recurring To Do items. 
For more information, highlight one of the menu choices, and press F1.



 Calls
The Calls menu (Calendar | Calls) lets you schedule one-time and recurring Calls. 
For more information, highlight one of the menu choices, and press F1.



 Sort
The Calendar | Sort command lets you sort your To Do items and Goals. 
For more information, highlight one of the menu choices, and press F1.



Recurring Appointment
The Recurring Events command (Calendar | Events | Recurring) opens the Recurring Appointment 
dialog box, where you can create an appointment that occurs at regular intervals. Recurring 
appointments appear with a  in the Daily View.

Dialog Box Options

Recurring Appointments List
Lists already defined recurring events. Select an item from the list to change it.

Text
Sets the name (up to 180 characters) of the recurring appointment. For quick entry, select an 
appointment from the Recurring Appointments List.

Regarding
Type a description or note about the recurring appointment. The Regarding text can be up to 640 
characters.

Start Time
Sets the time of day of the recurring appointment.

End Time
Sets the ending time for the recurring appointment.

Alarm

Alarm sets an alarm to indicate each impending appointment. A 
 appears next to appointments with alarms.

Lead Time sets the number of minutes prior to an appointment that an alarm sounds. This option 
is available only when Alarm is checked.

Play lets you hear the currently selected Wave (.WAV) file.

Tone sets the Wave file used to sound an alarm for a scheduled appointment. This option is 
available only when Alarm is checked.

From/To
Sets the date range in which the recurring appointment could possibly occur.

Recurring
Specifies how often the appointment should occur (specific weeks of the month, days of the month, 
weekly, or daily). The box below the Recurring buttons changes depending on which Recurring button 
you choose.

Add button
Adds a new recurring appointment to the Recurring Appointments List.

Delete button
Deletes the selected recurring appointment from the Recurring Appointments List. You can choose to 
delete all occurrences, past occurrences, or future occurrences.

Change button



Replaces the selected recurring appointment with the new settings.



Multi-Day Event
The Multi-Day Events command (Calendar | Events | Multi-Day Event) opens the Multi-Day Event 
dialog box, where you can schedule events (such as conferences) that extend over several days.
You can also schedule important one-day events as multi-day events, to call attention to them.
In the Daily Calendar View, multi-day events appear at the top of the Appointments list. 

Shortcuts

Toolbar:

Dialog Box Options

Multi-Day Events List
Lists the multi-day events you have already added. Choose one from the list if you want to change or 
delete it. 

Description
Type in the text that should be used to name and describe the multi-day event.

Time Range

From/To sets the starting and ending date for the multi-day event.

Full Day sets the multi-day event to occur during the entire work day.

AM sets the multi-day event to occur in the morning of each day.

PM sets the multi-day event to occur after noon of each day.

Color
Sets the color used to display the multi-day event in the Weekly, Monthly, and Yearly Calendar.

Add button
Adds a newly defined multi-day event to the Multi-Day Events List.

Change button
Replaces a selected multi-day event with the new settings.

Delete button
Deletes a selected multi-day event from the Multi-Day Events List.



 Daily To Do Items 
The Daily To Do Items command (Calendar | To Do Items | Daily) opens the To Do dialog box, where 
you can create a new To Do.
For help on the options in this dialog box, see To Do/Goals List Dialog Box.



Recurring To Do
The Recurring To Do Items command (Calendar | To Do Items | Recurring) opens the Recurring To Do 
dialog box, where you can create a To Do that repeats at regular intervals. Recurring To Dos appear 
with a  in the Daily view.

Dialog Box Options

Recurring To Do List
Lists already defined recurring To Dos. Select an item from the list to change it.

Text
Sets the description text (up to 180 characters) of the recurring To Do. For quick entry, select a To Do 
from the Recurring To Do list.

Regarding
Type any notes about the recurring To Do. The Regarding text can be up to 640 characters.

Category
Specifies the category for the To Do. You can later sort To Dos by category. Select a category from the 
drop-down list.

Assign
Specifies the person assigned to the To Do (or a person who assigned it to you). Select a name from 
the Assign drop-down list. Names can be defined through the Personal List Setup dialog box.

Priority sets the priority for the To Do or goal to Low, Medium, High, or Advanced. If Advanced is 
chosen, you can click the Advanced button to specify additional levels of priority. 

Advanced specifies more detailed levels of priority than Low, Medium, or High. Advanced 
priorities sort on two levels, first on A-B-C and then on 1-2-3-4-5-6. 

No Priority sets no priority for the To Do.

From/To
Sets the date range in which the recurring To Do could possibly occur.

Recurring
Specifies how often the To Do should occur (specific weeks of the month, days of the month, weekly, 
or daily). The box below the Recurring buttons changes depending on which Recurring button you 
choose.

Add button
Adds a new recurring To Do to the Recurring To Do list.

Delete button
Deletes the selected recurring To Do from the Recurring To Do list. You can choose to delete all 
occurrences, past occurrences, or future occurrences.

Change button
Replaces the selected recurring To Do with the new settings.



Calls
The Daily Calls command (Calendar | Calls | Daily) opens the Call dialog box, where you can create a 
new call.

Dialog Box Options

Predefined Activities
Displays a list of predefined activities you can choose from. If you choose an item from the Predefined 
Activities list, you can edit the item in the Text field. If no Predefined Activities are listed, click the Setup
button to open the Calendar Setup dialog box.

Text
Sets the description text (up to 180 characters) of the call. For quick entry, select a call from the 
Predefined Activities list.

Regarding
Type any notes about the call. The Regarding text can be up to 640 characters.

Call Status
Sets the status of the call. The call status code (the initial letter of each word in the call status) appears
on the Calls list in the Daily view to remind you of the type of call or follow-up needed. Examples of call
status are Call, Left Message, and Voice Mail Message. Change the types of Status by clicking the 
Setup button.

Completed

When checked, indicates that the call is completed. A  appears next to completed calls in the 
Daily View.

Urgent
When checked, indicates that a call is urgent. An exclamation point  appears next to urgent calls in 
the Daily View.

Default button
Saves the call status, completed, and urgent settings as defaults for new calls.

Setup button
Opens the Personal List Setup dialog box, where you customize predefined activities and call status 
codes.

Recurring button
Opens the Recurring Call dialog box, where you can set the call to recur. Recurring calls appear with a

 in the Daily View.



Recurring Calls
The Recurring Calls command (Calendar | Calls | Recurring) opens a dialog box where you can create
a recurring call. Recurring calls appear with a  in the Daily View.

Dialog Box Options

Recurring Calls List
Lists already defined recurring calls. Select an item from the list to change it.

Text
Sets the description text (up to 180 characters) of the recurring call. For quick entry, select a call from 
the Recurring Calls List.

Regarding
Type any notes about the recurring call. The Regarding text can be up to 640 characters.

Urgent
When checked, indicates that a call is urgent. An exclamation point  appears next to urgent calls in 
the Daily view.

From/To
Sets the date range in which the recurring call could possibly occur.

Recurring
Specifies how often the call should occur (specific weeks of the month, days of the month, weekly, or 
daily). The box below the Recurring buttons changes depending on which Recurring button you 
choose.

Add button
Adds the new recurring call to the Recurring Calls List.

Delete button
Deletes the selected recurring call from the Recurring Calls List. You can choose to delete all 
occurrences, past occurrences, or future occurrences.

Change button
Replaces the selected recurring call with the new settings.



 Goals
The Calendar | Goals command adds a new item to the Goals list. The Goals list contains goals that 
have due dates in the distant future. Goals list items are things that do not require immediate attention,
but you want to be aware of them. You can create up to 480 goals for one calendar year. Once the end
of the year is reached, the goals remain in that year. They will not be forwarded into the next year.
If you want, you can set a due date for a goal. When that day is reached, Sidekick automatically 
transfers the goal to the To Do list.
When you choose the Goals List command, a dialog box opens, letting you define the goal. For help 
on the options in this dialog box, see To Do/Goal Dialog Box.



Special Day
The Special Day command (Calendar | Special Day) opens a dialog box where you can schedule 
special days, such as holidays, birthdays, and anniversaries. You can use Special Day to remind 
yourself about office events or family events.
In the Daily Calendar View, special days appear in the top left corner. If you have several special days 
scheduled for the same day, you can right-click the visible special day to see a list of them all.

Shortcuts

Toolbar:

Dialog Box Options

Special Days List
Click the down arrow to display a list of special days that have been defined. Select one from the list if 
you want to change or delete it. By default, the Special Days List contains traditional holidays. 

Description
Type a description of a special day.

Alarm
When checked, sets an alarm to indicate a special day.    A  appears next to special days with alarms.

Play button lets you hear the currently selected Wave (.WAV) file.

Lead Time sets the number of days prior to a special day that an alarm sounds. This option is 
available only when Alarm is checked. 

Tone sets the Wave file used to sound an alarm for a special day. This option is available only 
when Alarm is checked. 

Time

Day of Month sets the special day to occur on a specific day of the month. 

Day of Week sets the special day to occur on a specific day of the week. 

Month sets the month of the year on which the special day falls (1=JAN, 12=DEC). 

Day sets the day of the month on which the special day falls. This option is unavailable if the Day 
of Week option is chosen. 

Week
Sets the week of the month on which the special day falls; select either 1st, 2nd, 3rd, 4th, or Last. This 
group of choices is unavailable if the Day of Month option is chosen.

Week Day
Sets the day of the week on which the special day falls. This group of choices is unavailable if the Day 
of Month option is chosen.

Add button
Adds a newly defined special day to the list of descriptions.



Change button
Replaces the selected special day with the new settings.

Delete button
Deletes a special day from the Special Days List.



Delete Activities
The Delete command in Calendar View (Calendar | Delete) opens the Delete Activities dialog box, 
where you can delete Calendar activities within a specified range of days. You can delete 
appointments, calls, To Do, or Goals list items.
Note The Delete command removes all events including group events

Dialog Box Options

From/To
Sets the date range from which to delete the specified activities in the calendar.

Delete
Select the type of activities to delete from the specified range of days.



Sort To Do Items
The Sort To Do Items command (Calendar | Sort | To Do) opens a dialog box where you can sort items
on the To Do list. For a description of the sorting options, see Sort To Do Items/Goals List Dialog Box.



Sort Goals
The Sort Goals command (Calendar | Sort | Goals) sorts the items on the Goals list. For a description 
of the sorting options, see Sort To Do Items/Goals List Dialog Box.



Almanac
The Calendar | Almanac command displays almanac information for the current Local Clock city. The 
information applies to the city for the current date: sunrise, sunset, hours of daylight, moon phase, 
daylight saving time dates, day of the year.

Shortcuts

Toolbar:



Personal List Setup
The Calendar | Personal List Setup command lets you define your own lists of predefined activities, 
call status, activity categories, and assignments. For a description of the setup options, see Personal 
List Setup Dialog Box.



Schedule New Activity
Use the Schedule New Activity dialog box to choose the kind of activity you want to schedule 
(Appointment, Call, or To Do item).    The command to open this dialog box is Calendar | Daily Activity 
in the Calendar Weekly, Monthly, or Yearly views, or Edit | New Activity in the Activities view.

Dialog Box Options

Schedule
Sets the type of activity to schedule: event, call, or To Do item.

Date
Sets the date for the activity. Click the small arrows to increment the date, or click the large arrow to 
see a calendar for selecting the date.
When you click OK, Sidekick displays the appropriate dialog box for the type of activity you have 
chosen.



Cards Menu
The Cards menu lets you control the content and order of your cardfile. For more information, highlight
a specific Cards menu choice and press F1.



Add
The Cards | Add command adds a card. For a description of the dialog box options, see the Add Card 
Dialog Box.

Shortcuts

Toolbar:
Keyboard: Ctrl+A



Duplicate Card
In Cardfile View, the Duplicate command (Cards | Duplicate) opens the Duplicate Card dialog box, 
where you specify the number of copies to make of the current card.

Number of Duplicates
Type or select the number of duplicate cards you want to make.



Move Cards
In Cardfile View, the Move command (Cards | Move) opens the Move Cards dialog box, where you can
move cards from the current cardfile to another open cardfile. This menu item is dimmed unless at 
least two cardfiles are open.

Shortcuts
Mouse: Click and drag the card from the Cards list to another cardfile tab to use drag and drop.

Dialog Box Options

Select Cards to Move

Current Card moves the current card.

Marked Cards moves marked cards. If no cards are marked, this option is dimmed.

Selected Cards moves the selected card or cards. If no cards are marked, this option is dimmed.

All Cards moves all cards. 

To Cardfile
Chooses the cardfile to move cards to. 

Copy Instead of Move
Copies the cards to the destination cardfile instead of moving them.

OK
Click OK to move cards. The Match Cardfile Fields dialog box is displayed. 



Delete Cards
In Cardfile View, the Delete command (Cards | Delete) opens the Delete Card dialog box, where you 
can set up criteria for deleting cards from the cardfile.

Dialog Box Options

Delete

Current Card deletes the current card.

Marked Cards deletes marked cards. If no cards are marked, this option is dimmed.

Selected Cards deletes the selected card or cards. If no cards are selected, this option is 
dimmed.

Cards With Blank Index deletes any cards that have no data in any of the three index fields. If 
no cards have blank indexes, this option is dimmed.

Index Range deletes a range of cards. In the From and To boxes, type the index line information 
for the first and last cards in the range of cards you want to delete. If Index Range is not selected, this 
option is dimmed.

Confirm Each Delete
When checked, Sidekick prompts you before deleting each card.



Mark/Unmark Current Card
The Cards | Mark/Unmark Current Card command marks or unmarks the selected card.

Shortcuts
Keyboard: Ctrl+K
Mouse: Right-click cards in the Cards list to mark or unmark them.



Unmark All 
The Cards | Unmark All command unmarks all marked cards in the active cardfile.



Define Cardfile Fields
In Cardfile View, the Define Fields command (Cards | Define Fields) opens the Define Cardfile Fields 
dialog box, where you can define card fields and determine how the cards are sorted.

Dialog Box Options

Field Name
Sets the name of a new field you want to add or an existing field name you want to change. Click the 
down arrow for a list of some commonly used field names.

Add button
Inserts a field name after the highlighted position in the field names list. If the field name you typed 
already exists, Add is dimmed.

Add Before button
Inserts a field name before the highlighted position in the field names list. If the field name you typed 
already exists, Add Before is dimmed.

Change button
Changes a field name in the Field Names list. This command is dimmed if the field name already 
exists or a field name has not been selected.

Delete button
Select to delete a field from the cardfile. This command is dimmed if no field name is selected.

Sort By button
Opens the Sort Cardfile dialog box where you change the index line used for sorting the cards in the 
cardfile.

OK button
Updates the cardfile with the changes made to the field names. If no changes have been made to the 
cardfile fields, this button is dimmed.



Reorder Cardfile Fields
In Cardfile View, the Reorder Fields command    (Cards | Reorder Fields) opens the Reorder Cardfile 
Fields dialog box, where you can reorder the fields in the active cardfile.

Dialog Box Options

Current Order
Displays the current order of field names in the active cardfile. Select a field name, and click the > 
button to move it to the New Order list.

New Order
Displays the new order for the field names. Click > to move a field to the New Order list; click < to 
remove a field from the New Order list.

Reset button
Resets the field order to the original settings. This command is dimmed if the field order has not been 
changed.

Up button
Moves the selected field up in the New Order list. 

Down button
Moves the selected field down in the New Order list. 



Sort Cardfile
In Cardfile View, the Sort command (Cards | Sort) opens the Sort Cardfile dialog box, where you can 
create an index (or title) line for the cards based on any three of the cardfile’s fields. A cardfile is sorted
by its index line.
Note: If you do not select any fields to sort a cardfile, Sidekick uses the first three fields as they 

appear on the cards.

Shortcuts

Toolbar:
Keyboard: Ctrl+R

Dialog Box Options

Field Name
Select a field name, and then click the  button to add it to the Sort By list.

Sort By
Displays the fields you want to use to sort the cardfile. You can select up to three fields from the Field 
Name list. Click  to add a field to the Sort By list. Click 

 to remove a field from the Sort By list.

Up button
Moves the selected field in the Sort By list up by one.

Down button
Moves the selected field in the Sort By list down by one.

Sorting Order
Chooses the sorting order, either alphabetical or reverse alphabetical. 



Reorder Cardfile Tabs
In Cardfile View, the Reorder Tabs command (Cards | Reorder Tabs) opens the Reorder Cardfile Tabs 
dialog box, where you can change the order of the cardfile tabs. The default order of cardfile tabs is 
the order in which they were opened.

Shortcuts
Keyboard: F11

Dialog Box Options

Current Cardfile Order
Lists the cardfiles displayed on the tabs in their current order. 

Up button
Changes the order of cardfiles in the Current Cardfile Order list. Choose a cardfile and click Up to 
move the cardfile tab to the left.

Down button
Changes the order of cardfiles in the Current Cardfile Order list. Choose a cardfile and click Down to 
move the cardfile tab to the right.



Edit Menu
The Edit menu provides tools for revising your existing items. 
For more details, highlight an Edit menu choice in the appropriate view (Cardfile, Calendar, etc.), and 
press F1. 



Edit Menu (Cardfile)
The Edit menu provides tools for revising your existing items. 
For more details, highlight an Edit menu choice, and press F1. 



Find (Cardfile)
The Edit | Find command lets you search for Cardfile items. 
For more details, highlight a Find menu choice, and press F1. 



Edit Menu (Calendar)
The Edit menu provides tools for revising your existing items. 
For more details, highlight an Edit menu choice, and press F1. 



Edit Menu (Write)
The Edit menu provides tools for revising your existing items. 
For more details, highlight an Edit menu choice, and press F1. 



Edit Menu (Expense)
The Edit menu provides tools for revising your existing items. 
For more details, highlight an Edit menu choice, and press F1. 



Edit Menu (Report)
The Edit menu provides tools for revising your existing items. 
For more details, highlight an Edit menu choice, and press F1. 



Edit Menu (EarthTime)
The Edit menu provides tools for viewing and changing city information.
Select a Different City
Facts about the City
Modify City Information



Undo
The Edit | Undo command reverses the last action performed, returning Sidekick back to the state it 
was in before the action was taken. These are some of the actions it is possible to undo:

Undo Cut

Undo Paste

Undo Typing

Undo Delete

Undo Backspace

Undo Drag and Drop Cards

Undo Move

Shortcuts
Keyboard: Ctrl+Z



Cut
The Edit | Cut command removes selected text and puts it on the Clipboard. This command is dimmed
if you have not selected any text.

Shortcuts

Toolbar:
Keyboard: Ctrl+X



Copy
The Edit | Copy command copies selected text onto the Clipboard. This command is dimmed if you 
have not selected any text.

Shortcuts

Toolbar:
Keyboard: Ctrl+C



Paste
The Edit | Paste command inserts a copy of the Clipboard contents at the insertion point. This 
command is dimmed if the Clipboard is empty.

Shortcuts

Toolbar:
Keyboard: Ctrl+V



Copy Special
The Edit | Copy Special command copies specified fields from the current card to the Windows 
Clipboard. You can then paste the information into a Write document, or anywhere you can paste 
Clipboard contents.
Use the Copy Special Setup command to specify the fields you want to copy.



Copy Special Setup
The Edit | Copy Special Setup command opens a dialog box where you specify what fields of the 
current cardfile you want to copy using the Copy Special command. 

Dialog Box Options

Card Fields
Displays a list of fields. Click one or more you want to add to the contents.

Add/Insert
Click the Fields >> button to add the selected fields.    Click the New Line, Space or Comma buttons to 
add those elements, or type them in the contents work space.

Select or type contents
The work space where you create the contents from fields you select or text you type.



Go to Cardfile
The Go to Cardfile command (Edit | Go to Cardfile) opens the Go to Cardfile dialog box, where you 
can choose another cardfile to use. (This option is not available when you are viewing an Untitled 
cardfile.)

Shortcuts
Keyboard: Ctrl+G

Dialog Box Options

Select A Cardfile
Displays a list of cardfiles.

Go To button
Makes the cardfile name selected in the list box the active cardfile.



Find Text
The Find Text command (Edit | Find | Text) opens the Find Text dialog box, where you can specify text 
to search for in the cardfile, as well as what part of the cardfile to search.

Shortcuts

Toolbar:  
Keyboard: Ctrl+F

Dialog Box Options

Text to Find
Type the text (string) that you want to find in the cardfile.

Search Within

Index searches the card indexes only in the cardfile.

Contact Log searches the Contact Logs in the cardfile.

Cards searches the card contents in the cardfile.

Marked Cards searches only the marked cards in the cardfile. If no cards are marked, this option
is dimmed.

Find button
Finds and displays a card with the matching text. The first card found becomes the current card.



Find | Condition
The Edit | Find | Condition command searches for cards that meet specified conditions. For a 
description of the dialog box options, see the Find Condition dialog box.



Find Next
The Edit | Find Next command finds the next card with the specified search text or condition.

Shortcuts
Keyboard: F3



Find Previous
The Edit | Find Previous command finds the previous card with the specified search text or condition.

Shortcuts
Keyboard: Shift+F3



Go To
The Go To commands let you quickly jump to today's date or to a date you specify.
Today
Specific Date



Go To Today
Use the Edit | Go To | Today command to quickly jump to today's date (as set internally by your 
computer's system clock) in the daily calendar. If you are already at today's date on the calendar, the 
Edit | Go To | Today command is dimmed.

Shortcuts
Keyboard: Ctrl+G (Calendar only)



Go To Specific Date
In Calendar View, the Go to Specific Date command (Edit | Go To | Specific Date) opens a dialog box 
where you specify a selected date to quickly jump to in the daily calendar.

Dialog Box Options

Pick a Day
Specifies the date to go to. Type a new date or click the list box arrow to display a calendar. Click a 
date on the calendar to select that date. You can use the arrows next to the month title to change the 
month displayed.

Go To __ Days Later
Lets you jump ahead by a specific number of days from the current date. Type the number of days (up 
to 90), or click the list box arrow to set the number of days.



Find (Calendar)
In the Calendar, the Edit | Find command opens the Find dialog box, where you specify search criteria 
and text you want to find in the calendar.

Shortcuts

Toolbar:
Keyboard: Ctrl+F

Dialog Box Options

Search Range

From sets the beginning date to be searched. The default day is a week before today.

To sets the ending date to be searched. The default day is today.

Search For
Enter strings for Text or Regarding to search. The text can be the same for both. If the strings for Text 
and Regarding are different, the search results contain both search criteria.

Include
Check the sections of the Sidekick calendar to search. Choose from events, calls, To Do items, and 
Goals list.

Activities Found
Displays the results of the search. 

Find button
Begins searching. Choose Find after the parameters of the search are properly defined.

Go To button
Goes to an an activity selected in the Search Results list. Go to an activity without clicking this button, 
simply double-click the activity.



Reschedule Activity
In Calendar View, the Reschedule command opens the Reschedule Activity dialog box, where you can
reschedule calls or To Do items to another day or time. Highlight an item to reschedule, then choose 
Edit | Reschedule.

Dialog Box Options

Time
Sets the time to reschedule an appointment. The Time option is dimmed when rescheduling To Dos 
and calls.

Date
Sets the date to reschedule the item. You can click the arrow to choose a date from a mini calendar.



Add Card
The Edit | Add Card command adds new cards to the Cardfile. It is equivalent to the Cards | Add 
command from the Cardfile view. For a description of the dialog box options, see Add Card Dialog 
Box.

Shortcuts
Keyboard: Ctrl+A



Select All
Edit | Select All command selects all text in the current document.



Go To Folder
In Write View, the Go to Folder command (Edit | Go to Folder) opens the Go to Folder dialog box, 
where you can choose a folder to switch to. 

Shortcuts
Keyboard: Ctrl+G

Dialog Box Options

Select a Folder
Displays the folders currently available. Click the folder you want to switch to.

Go To button
After you have selected a folder, click Go To to switch to that folder.



Find (Write)
In Write View, the Find command (Edit | Find) opens the Find dialog box, where you specify search 
criteria and text you want to find in documents.

Shortcuts

Toolbar:
Keyboard: Ctrl+F

Dialog Box Options

Find Text
Type the text to find on the document subject line.

Match Case
Check this box to find the search text only when the capitalization matches exactly.

Match Whole Word Only
Check this box to find the search text only when it is not contained in another word.

Find Next button
Click this button to find the next occurrence of the specified text.

Advanced Options button
Click this button to expand the dialog box to show the following advanced options.

Date Range lets you search for documents entered within a date range, or entered before or after
a specific date.

Select Folders tells which folders to include in the search.

All Folders includes all folders in the search.

Find Text in Subject lets you type additional text to find in the documents' subject lines.



Find and Replace (Write)
In Write View, the Replace command (Edit | Replace) opens the Find and Replace dialog box, where 
you specify search criteria, text to find, and replacement text. You can search for text and replace it in 
the subject and/or contents of documents in a selected folder or in all folders.

Dialog Box Options

Find Text
Type the text to find in the documents.

Replace With
Type the replacement text.

Match Case
Check this box to find the search text only when the capitalization matches exactly.

Match Whole Word Only
Check this box to find the search text only when it is not contained in another word.

Find Next button
Click this button to find the next occurrence of the specified text.

Replace button
Click to replace the found text and move to the next occurrence.

Replace All button
Click to replace all occurrences of the specified text.

Advanced Options button
Click this button to expand the dialog box to show the following advanced options.

Include Subject includes subject lines in the find and operation.

Search within Folders tells which folders to include in the search.

All Folders includes all folders in the search.



 Found Text
In the Write view, the Edit | Found Text command displays the Found window with the results of the 
last Find command. You must use Edit | Find before you can use Edit | Found.
The Found window lists the subject lines of all documents that match the search criteria. To switch to a
document, click its subject line in the list. The Found window’s title bar lists the number of documents 
found. 
Clicking the window’s close button or choosing Edit | Found again closes the window. 



Find Next
The Edit | Find Next command finds the next match for the specified search text.

Shortcuts
Keyboard: F3



Find Previous
The Edit | Find Previous command finds the previous match for the specified search text.

Shortcuts
Keyboard: Shift+F3



Find (Expense)
In Expense view, the Edit | Find command opens the Find dialog box.

Find Text
Enter the text you want to find.

Find Next
Click to find the next occurrence of the specified text.



Delete Column/Row
The Edit | Delete Column/Row deletes selected columns or rows from the report. Only complete rows 
and columns can be deleted.
Note You cannot use Edit | Undo to restore rows or columns that have been deleted using Edit | 

Delete Highlighted Column/Row. Regenerate the report to restore the deleted columns or rows.



GoTo
The Edit | Go To command in the Activities view takes you to the currently selected calendar item 
(appointment, To Do item, or call).    You also can click the event and click the Go To button, or double-
click the event.



Delete
The Edit | Delete command in the Activities view deletes the currently selected event or calendar item.  
Deleting group scheduling events in the Activities view does not remove them from your calendar, and 
does not send cancellation notices to participants. Use the Delete command to clean up your Activities
view without affecting events on your calendar.    
NOTE: Here are some issues to consider when you delete a group event:
1. If the item is for a group event that you initiated and that has not been completed, you will not be 

able to track and modify the deleted event.
2. If the item is a group event that is still in your calendar, deleting the item will delete all participant 

and resource information for the event. You can safely do so after the event has taken place. 
3. If you delete an item in Activities view and then delete it from the Calendar, you will not be prompted 

to send cancellation notices to participants, because the participant and resource information has 
been deleted. 

4. If you delete an event, incoming replies to that event are discarded.



File Menu
The File menu has options for opening, saving, printing, and other file-related activities.
For more information, highlight one of the File menu options, and press F1.



File Menu (Activities)
The File menu has options for saving, printing, and other file-related activities.
For more information, highlight one of the File menu options, and press F1.



File Menu (Cardfile)
The File menu has options for opening, saving, printing, and other file-related activities.
For more information, highlight one of the File menu options, and press F1.



Print (Cardfile)
The File | Print menu has options for printing your cardfile data.
For more information, highlight one of the menu options, and press F1.



File Menu (Calendar)
The File menu has options for opening, saving, printing, and other file-related activities.
For more information, highlight one of the File menu options, and press F1.



File Menu (Write)
The File menu has options for opening, saving, printing, and other file-related activities.
For more information, highlight one of the File menu options, and press F1.



File Menu (Report)
The File menu has options for opening, saving, printing, and other file-related activities.
For more information, highlight one of the File menu options, and press F1.



File Menu (Expense)
The File menu has options for opening, saving, printing, and other file-related activities.
For more information, highlight one of the File menu options, and press F1.



File Menu (EarthTime)
The File menu has options for opening, saving, printing, and other file-related activities.
For more information, highlight one of the File menu options, and press F1.



New Cardfile
The File | New Cardfile command creates a new cardfile in Sidekick, using a pre-defined template if 
you select one. See Select Cardfile Template Dialog Box for more information.

Shortcuts

Toolbar:
Keyboard: Ctrl+N



Open Cardfile
The File | Open Cardfile command opens an existing cardfile in Sidekick. 
In addition to opening Internet Sidekick cardfiles, you can import files created in other programs by 
selecting the format in the Files of Type list. 

Shortcuts

Toolbar:
Keyboard: Ctrl+O

For a description of common dialog box options, see File-Handling Options.



Close Cardfile
File | Close Cardfile closes the current cardfile. 

Shortcut
Keyboard: Ctrl+W



Close Cardfiles
The Close Cardfiles command (File | Close Cardfiles) opens the Close Cardfiles dialog box. 
From the list of opened cardfiles, select each file you want to close (use Ctrl+click to select multiple 
files, and Shift+click to select a range of files). When you have selected all the files you want to close, 
click OK.



Set Up Cardfile Template
The Template command (File | Template) displays the Set Up Cardfile Template dialog box.

Dialog Box Options

Cardfile Template
Sets the cardfile template to use as a basis for your new cardfile. Select a template from the list, or 
type in a new name. 

New button
Creates a new template with the name you have specified. Opens the Modify Cardfile Template dialog 
box so you can define the new template’s fields.

Modify button
Modifies the selected template. Opens the Modify Cardfile Template dialog box.

Rename button
Renames the selected template to the name in the Cardfile Template field.

Delete button
Deletes the selected cardfile template.



Save Cardfile
The File | Save Cardfile command saves the file under its current name. If you use File | Save Cardfile 
on a cardfile that has not yet been saved, Sidekick displays the File | Save Cardfile As dialog box.

Shortcuts
Keyboard: Ctrl+S
For a description of common Save As dialog box options, see File-Handling Options.



Save Cardfile As
The File | Save Cardfile As command saves a cardfile under a new name or to a different location or 
format. You can save to the Sidekick 95 Cardfile format (*.SKCard), Sidekick 2.0 format (*.SDB), or 
other formats found in the Save as Type list.

Shortcuts
Keyboard: F12
For a description of the dialog box options, see File-Handling Options.



Save All
The File | Save All command saves all open files: cardfiles, calendar, Write files, expense files, and 
reports.

Shortcuts

Toolbar:
Keyboard: Ctrl+L



Back Up and Restore
File | Back Up and Restore backs up and restores files from any or all Sidekick views.
For more information, see:

Back Up Dialog Box
Restore Dialog Box



Print Setup
The File | Print Setup command specifies the target printer, and sets its properties. This command 
opens the Windows 95 Print Setup dialog box.



Print Cards
The Print Cards command (File | Print | Cards) opens the Print Cards dialog box, where you specify 
cards and printing options. You can print cards and/or Contact Log information.

Shortcuts

Toolbar:
Keyboard: Ctrl+P

Dialog Box Options

What to Print

Current Card prints the current card of the active cardfile.

Selected Cards prints the selected cards of the active cardfile.

Marked prints the marked cards in the active cardfile.

All prints all the cards in the active cardfile.

Index Range prints cards from a range of cards in the active cardfile.

From/To: Type the index line information for the first and last card in the range of cards to print.

Print
Select whether you want to print the card, Contact Log, and/or field names.

Cards Per Page
Select the number of cards you want to have printed per page. As you specify more cards per page, 
the cards themselves become smaller. If a card becomes too small to contain all its fields, Sidekick 
drops the extra fields from the bottom of the card.
If you specify Continuous, Sidekick will print all information from each card in continuous form without 
regard to page breaks. If you choose Separate, each card will begin on a new page, but will not be 
restricted to fit on one page. If you specify One Card, Sidekick will drop fields if needed to make the 
card fit.

Margins
Sets up the margins for the left, top, right and bottom of the printout. Type each margin number or use 
the up or down arrow buttons to increment or decrement the margins.

Font button
Displays the Font dialog box in which you can set the fonts for the index, card, and Contact Log.

Setup button
Sets up your printer.

Preview button
Lets you see how the printed cards will look.



Print Labels
The File | Print | Labels command prints card information to any size label. For a description of the 
dialog box options, see Print Labels/Address Book/Envelopes Dialog Box.



Print Address Book
The File | Print | Address Book command prints card information in an address book format. For a 
description of the dialog box options, see Print Labels/Address Book/Envelopes Dialog Box.



Print Envelopes
The File | Print | Envelopes command prints address information on envelopes. For a description of the
dialog box options, see Print Labels/Address Book/Envelopes dialog box.



Exit
The File | Exit command exits Sidekick. You can also use the Close command on the application 
Control menu. Sidekick prompts you to save any active files if it has unsaved changes.

Shortcuts
Mouse: Click the  button on Sidekick's title bar.

Keyboard: Alt+F4



File 1,2,3,4
The File | File 1,2,3,4 commands at the bottom of the File menu display the names of the four most 
recently opened files. Choose the number of the file you want to open. 
Note Even if you delete a file, its name will still appear here until it is bumped out of the list by more 

recently opened files.



New Calendar
The File | New Calendar command creates a new calendar.

Shortcuts

Toolbar:
Keyboard: Ctrl+N



Open Calendar
The File | Open Calendar command opens an existing calendar. Each calendar consists of a group of 
files all beginning with a four letter User Name.
In addition to opening Internet Sidekick calendar files, you can import files created in other programs 
by selecting the format in the Files of Type list.

Shortcuts

Toolbar:
Keyboard: Ctrl+O
For a description of common dialog box options, see Calendar File-Handling Options.
Note If you open a Sidekick 95 calendar, the event times stored in the calendar are converted to GMT

(Greenwich Mean Time), which Internet Sidekick uses to store times. This conversion is based 
on your Windows 95 Time Zone setting, which must be set to your time zone for the times to 
convert correctly. To see this setting, open the Control Panel (click Start button, Settings, Control
Panel), and double-click Date/Time. Click the Time Zone tab and check that the setting is 
correct.



Save Calendar
The File | Save Calendar command saves the calendar files under their current name. If you use File | 
Save Calendar on a calendar that has not yet been saved, Sidekick displays the File | Save Calendar 
As dialog box.

Shortcuts
Keyboard: Ctrl+S
For a description of common Save As dialog box options, see Calendar File-Handling Options.



Save Calendar As
The File | Save Calendar As command saves your calendar under a new name or to a different 
location. Your calendar file is actually eight files in the XXXX????.SKW format, where XXXX stands for
the letters you enter as your initials when you install Sidekick (from one to four letters). When saving, 
opening, backing up, or restoring calendar files, Sidekick lists the initials (XXXX) as the name of the 
calendar. For more information about the calendar files, see Sidekick Files. 

Shortcuts
Keyboard: F12
For a description of common dialog box options, see Calendar File-Handling Options.



Print
Different Print options are available for each view of the Calendar:
Sidekick Daily Format prints the daily calendar in various Sidekick formats.
At-A-Glance Daily Format prints the daily calendar on various At-A-Glance forms.
At-A-Glance Weeky Format prints the weekly calendar on various At-A-Glance forms.
At-A-Glance Monthly Format prints the monthly calendar on various At-A-Glance forms.
Day Runner Format prints the calendar on various Day Runner forms.
Day-Timer Format prints the daily calendar on various Day-Timer forms.
Franklin Format prints the daily calendar on various Franklin Planner forms.
Filofax Format prints the calendar on weekly and monthly Filofax forms.
One-Week Sidekick Format prints the weekly calendar.
Two-Week Sidekick Format prints the bi-weekly calendar.
Six-Week Sidekick Format prints a six weeks calendar.
One-Month Sidekick Format prints the monthly calendar.
Sidekick Year Planner prints a yearly calendar.
Four Months by Three Rows prints a yearly calendar in a 4 x 3 months grid.
Two Months by Six Rows prints a yearly calendar in a 2 x 6 months grid.



Print Sidekick Format
The Sidekick Daily Format command (File | Print | Sidekick Daily Format) opens the Print Sidekick 
Format dialog box, where you set Sidekick format options for printing your daily calendar.

Shortcuts

Toolbar:
Keyboard: Ctrl+P

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible day of the calendar.

Style
Sets the type of calendar to print: Single Column, Double Column, Triple Column and Organizer. The 
Organizer style is very similar to the Sidekick Daily Calendar view.

Contents In Columns
Sets what type of activity is listed in each column.

Paper Type
Sets the type of paper to print to. A list of paper types is provided to get you started. However, since all
printers are different, you should make sure the paper type you choose prints correctly to your printer 
before printing many pages. You may have to adjust the margins slightly. Click the Edit button to edit 
the margins.

Options button
Opens up more printing options:

Include Mini Calendar includes the mini calendar in the printout.

Include Regarding prints the Regarding note text for each activity.

Include Completed Item prints completed items.

Skip Empty skips all empty cells, printing only those with information in them.

Text Wrap includes all text of entries (up to 500 characters) wrapping to multiple lines if needed.

One Page prints only what will fit on a single page.

Font button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer defaults.

Preview button
Previews the printed calendar with the settings you choose.



Print At-A-Glance Daily Format
The At-A-Glance Daily Format command (File | Print | At-A-Glance Daily Format) opens the Print At-A-
Glance Daily Format dialog box, where you set At-A-Glance format options for printing your daily 
calendar.

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible day of the calendar.

Format
The drop down list contains the various At-A-Glance forms available for printing. Choose the desired 
forms here.

Start On
Specify whether to start printing on a left page or a right page.

Origin of Left/Right Page
Specify the printing margins of both the left and right pages. You may have to adjust the left and top 
margins for printing to forms on your printer. The margins can be negative, if necessary. Make sure to 
test your settings before printing many pages.

Fonts button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Opens the Print Setup dialog box.

Preview button
Previews the printed calendar with the settings you choose.



Print At-A-Glance Weekly Format
The At-A-Glance Weekly Format command (File | Print | At-A-Glance Weekly) opens the Print At-A-
Glance Weekly Format dialog box, where you set At-A-Glance format options for printing your weekly 
calendar.

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible week.

Format
The drop down list contains the various At-A-Glance forms available for printing. Choose the desired 
forms here.

Paper
Specify whether the paper you are using includes the date or not.

Origin of Left/Right Page
Specify the printing margins of both the left and right pages. You may have to adjust the left and top 
margins for printing to forms on your printer. The margins can be negative, if necessary. Make sure to 
test your settings before printing many pages.

Fonts button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Opens the Print Setup dialog box.

Preview button
Previews the printed calendar with the settings you choose.



Print At-A-Glance Monthly Format
The At-A-Glance Monthly Format command (File | Print | At-A-Glance Monthly Format) opens the Print 
At-A-Glance Monthly Format dialog box, where you set At-A-Glance format options for printing your 
monthly calendar.

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible month.

Format
The drop down list contains the various At-A-Glance forms available for printing. Choose the desired 
forms here.

Paper
Specify whether the paper you are using includes the date or not.

Origin of Left/Right Page
Specify the printing margins of both the left and right pages. You may have to adjust the left and top 
margins for printing to forms on your printer. The margins can be negative, if necessary. Make sure to 
test your settings before printing many pages.

Fonts button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Opens the Print Setup dialog box.

Preview button
Previews the printed calendar with the settings you choose.



Print Day Runner Format
The Day Runner Format command (File | Print | Day Runner Daily/Weekly/Monthly Format) opens 
Print Day Runner Format dialog box, where you set Day Runner format options for printing your daily, 
weekly, or monthly calendar. You can print the calendar directly to Day Runner personal organizer 
notebook pages of various sizes.

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible date in the calendar.

Format
The drop-down list at the top of this dialog contains the various Day Runner forms available for 
printing.

Entrepreneur Edition: 8 x 11

Classic Edition: 5.5 x 8

Running Mate Edition: 3.75 x 6.75

Start On (Daily only)
Sets the first page for printing to dated Day Runner daily forms. Select Left Page if the first page you're
printing to is on the left (back side). Select Right Page if the first page you're printing to is on the right 
(front side). 

Paper (Weekly and Monthly only)
Sets the printing for dated or non-dated Day Runner pages. 

Origin of Left/Right Page
Sets the printing margins for both the left and right pages. The margins can be negative, if necessary. 
Make sure to test your settings before printing many pages.

Fonts button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer.

Preview button
Previews the printed calendar with the settings you choose.



Print Day-Timer Format
The Day-Timer Format command (File | Print | Day-Timer Format) opens the Print Day-Timer Format 
dialog box, where you set options for printing the daily calendar in various Day-Timer forms.

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible day of the calendar.

Format
The drop down list at the top of this dialog contains the various Day-Timer forms available for printing. 
The desired forms should be chosen here.

Day-Timer Sr. Desk: 8.5 x 11

Day-Timer Jr. Desk: 5.5 x 8.5

Day-Timer Sr. Pocket: 3.75 x 6.75

Day-Timer Jr. Pocket: 2.75 x 5

Day-Timer Sr. Reference: 8.5 x 11

Day-Timer Jr. Reference: 5.5 x 8.5

Margins
You may have to adjust the left and top margins for printing to forms on your printer. The margins can 
be negative, if necessary. Make sure to test your settings before printing many pages.

Font button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer.

Preview button
Previews the printed calendar with the settings you choose.



Print Franklin Format
The Franklin Daily Format command (File | Print | Franklin Daily Format) opens the Print Franklin 
Format dialog box, where you set options for printing the daily calendar in various Franklin Planner 
forms.

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible day of the calendar.

Format
The drop down list at the top of this dialog contains the various Franklin forms available for printing.

Franklin Monarch: 8.5 x 11

Franklin Classic: 5.5 x 8.5

Franklin Compact: 4.25 x 6.75

Margins
Adjust the left and top margins for printing to forms on a specific printer. The margins can be negative, 
if necessary.

Font button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer.

Preview button
Previews the printed calendar with the settings you choose.



Print Filofax Format
The Filofax Format command (File | Print | Filofax Weekly/Monthy Format) opens the Print Filofax 
Format dialog box, where you set options for printing the weekly or monthly calendar directly to 
Personal size Filofax dated organizer paper.

Dialog Box Options

From/To
Sets the dates to print. The default date is the currently visible date in the calendar.

Origin of Left/Right Page
Sets the printing margins for both the left and right pages. The margins can be negative, if necessary. 
Make sure to test your settings before printing many pages.

Fonts button
Sets the fonts to be used in printing; opens the Fonts dialog box.

Setup button
Sets up your printer.

Preview button
Previews the printed calendar with the settings you choose.



Print One-Month Sidekick Format
The File | Print | One-Month Sidekick Format command prints the monthly calendar in Sidekick format. 

Shortcuts

Toolbar:
Keyboard: Ctrl+P (from Monthly view)

For a description of dialog box options, see Print Dialog Box.



Print One-Week Sidekick Format
The File | Print | One-Week Sidekick Format command prints the weekly calendar in Sidekick format. 

Shortcuts

Toolbar:
Keyboard: Ctrl+P (from Weekly view)
For a description of dialog box options, see Print Dialog Box.



Print Two-Week Sidekick Format
The File | Print | Two-Week Sidekick Format command prints the weekly calendar, two weeks per 
page. For a description of dialog box options, see Print Dialog Box.



Print Six-Week Sidekick Format
The File | Print | Six-Week Sidekick Format command prints the weekly calendar, six weeks per page. 
For a description of dialog box options, see Print Dialog Box.



Print Sidekick Year Planner
The File | Print | Sidekick Year Planner command prints the yearly calendar in Sidekick format. 

Shortcuts

Toolbar:
Keyboard: Ctrl+P
For a description of dialog box options, see Print Dialog Box.



 Print Four Months By Three Rows
The File | Print | Four Months by Three Rows command prints the yearly calendar, four months 
horizontally, and three months vertically. For a description of dialog box options, see Print Dialog Box.



Print Two Months By Six Rows
The File | Print | Two Months by Six Rows command prints the yearly calendar, two months 
horizontally, and six months vertically. This format lists multi-day events and special days between the 
two columns. For a description of dialog box options, see Print Dialog Box.



New Binder
The File | New Binder command creates a new binder.

Shortcuts

Toolbar:
Keyboard: Ctrl+N



Open Binder
The File | Open Binder command opens an existing Write binder.
In addition to opening Internet Sidekick files, you can import files created in other programs by 
choosing the format in the Files of Type list.

Shortcuts

Toolbar:
Keyboard: Ctrl+O

For a description of common dialog box options, see File-Handling Options.



Save Binder
The File | Save Binder command saves all binders and folders.

Shortcuts
Keyboard: Ctrl+S 



Save Binder As
The File | Save Binder As command saves the binder to a new name.

Shortcuts
Keyboard: F12
For a description of common dialog box options, see File-Handling Options.



Print Documents
In Write View, the File | Print command opens the Print Documents dialog box, where you specify 
documents to print. You can print the selected document, all documents, marked documents, or 
documents found in the last search from one or more folders.

Shortcuts

Toolbar:
Keyboard: Ctrl+P

Dialog Box Options

Print
Select which documents to print (Current Document, Selected Documents, Found Documents, Marked
Documents, or All Documents). 
Check Include Subject to print the subject line with the documents.

Select Folders to Print
Select the folders from which to print all or marked documents. 
Check All Folders to print from all folders.

Style

Continuous prints the documents without page breaks.

Start Each Document on a New Page prints the documents with each starting on a separate 
page.

Options

Number of copies determines how many copies of each page are printed.

Print Page Numbers adds page numbers to the printed document.

Print Misspelled Words in Strikeout Font Style prints all words found by Auto Spell Check to 
be incorrectly spelled in strikeout font, as they appear on-screen.

Preview button
Previews the documents before you print.



Page Setup
The File | Page Setup command sets up the page for printing. 

Dialog Box Options

Size
Sets the page dimensions. You can choose from a number of different paper and envelope sizes.

Source
Sets the printer’s paper feed source.

Orientation
Sets whether you are printing to a tall page, or a wide page.

Margins
Sets the margins for the page.

Printer button
Opens the Windows 95 Page Setup dialog box, which is used to select another printer or change its 
properties.



New Report
When you’re viewing a report, you can use the New Report command (File | New Report) to open the 
New Report dialog box, where you can choose the kind of report you want to create next.

Shortcuts

Toolbar:
Keyboard: Ctrl+N

Dialog Box Options

Card Report
Generates a report from the cardfile.

Calendar Report
Generates a report from appointments, calls, To Dos, Task List items, multi-day events, and/or special 
days.

Free Time Report
Generates a report of the free time between appointments.

To Do Items Report
Generates a report from To Dos and/or Goals List items.

Contact Log Report
Generates a report from the Contact Log for each card.



Open Report
The File | Open Report command opens an existing expense report in Sidekick. Report files have the 
extension .RPT.

Shortcuts
Keyboard: Ctrl+O
For a description of common dialog box options, see File-Handling Options.



Save Report
The File | Save Report command saves the report file under its current name. If you use File | Save 
Report on a report that has not yet been saved, Sidekick displays the File | Save Report As dialog box.

Shortcuts
Keyboard: Shift+S
For a description of common Save As dialog box options, see File-Handling Options.



Save Report As
The File | Save Report As command save a report under a new name or to a different location. Report 
files are saved with the extension (*.RPT).

Shortcuts
Keyboard: F12
For a description of common dialog box options, see File-Handling Options.



Print Report
The File | Print Report command sends the current report to the printer.

Shortcuts
Keyboard: Ctrl+P



Print Preview
The File | Print Preview command previews the file before you print it.



Print Preview (Write)
In Write View, the File | Print Preview command lets you preview a document before you print it.



Print Preview (Expense)
In Expense View, the File | Print Preview command lets you preview an expense receipt or report 
before you print it.



New Expense File
In Expense View, the New Expenses command (File | New Expenses) opens the New Expense File 
dialog box, where you can create a new expense file in Sidekick.

Shortcuts

Toolbar:
Keyboard: Ctrl+N

Dialog Box Options

Name for First Folder
When you create a new Expense file, this name will be used for the first folder (you can change it 
using the Expense | Folder | Properties command).

Person’s Name
The name of the person whose expenses will be entered here.

Department
The person’s department, or the department incurring the expenses.

Organization
The name of the company or organization.

Purpose of Expenses
The purpose of the expenditures.

File Currency Setting
Select the currency from the drop-down list.

Expense Types to Display 
Highlight the expense types you want displayed in the default pick list for expense types.

File Country Setting
Check the one that applies to your location. The tax designations are VAT (Value Added Tax), GST 
(Goods and Services Tax) and PST (Provincial Sales Tax).

U.S.A. and other countries (without VAT/GST/PST)

European Countries (with VAT)

Canada (with GST/PST)



Open Expenses
The File | Open Expenses command opens an existing expense file in Sidekick. The file must be in the
Sidekick expense file format (.SEE or Sidekick 95’s .SKExpense format).

Shortcuts

Toolbar:
Keyboard: Ctrl+O

For a description of common Save As dialog box options, see File-Handling Options.



Save Expenses
The File | Save Expenses command saves the file under its current name. If you use File | Save 
Expenses on an expense file that has not yet been saved, Sidekick displays the File | Save Expenses 
As dialog box.

Shortcuts
Keyboard: Ctrl+S
For a description of common dialog box options, see File-Handling Options.



Save Expenses As
The File | Save Expenses As command saves a expense file under a new name or to a different 
location. 

Shortcuts
Keyboard: F12
For a description of common dialog box options, see File-Handling Options.



Print Receipt/Report
The File | Print command prints your receipts or expense report. When printing receipts you have the 
option to print the current receipt or all receipts in the folder. 

Shortcuts

Toolbar:
Keyboard: Shift+P



Print (Activities)
The File | Print command prints events in the Activities view. For Internet events, you can choose 
either summary or detail format, and print selected events or all events. This command opens the Print
Activities dialog box. 

Shortcuts
Keyboard: Ctrl+P



File-Handling Options
Commands that operate on files require the name of a file to work on. When you choose one of these 
commands, you'll see a dialog box with the options described below.

Look In
Displays the folder or directory whose contents are listed in the window below. To move to a higher 
directory, select it from the drop-down list. To move to a lower subdirectory, double-click it in the 
window below.

File Name
Displays the name you enter for the file to be saved or opened. Either type the name in this field or 
click its name in the window above. 

Files of Type
Selects the file type shown in the window. Where importing or exporting files of another format is 
available, choose the file type in this list.



File-Handling Options (Calendar)
Commands that operate on files require the name of a file to work on. When you choose one of    these
commands, you'll see a dialog box with the options described below.

User Name
The name that identifies the calendar files. 

Folders
Displays the startup directory. To change to a different directory, double-click it.

Drives
Lets you switch to another drive. Click the arrow at the right of the box and double-click the drive name
you want to switch to.

List Files of Type
Selects the file type shown in the window. To import files of another format, choose the file type in this 
list.



Help Menu

 Related topic

Contents
Displays the table of contents for the Internet Sidekick Help file (also accessible by clicking the 
Contents button in the Help window).

Search
Opens the Windows Help Search dialog box, which lets you select a word or phrase you want to 
search for.

Toolbar
Displays information about using Internet Sidekick's Toolbar.

Keyboard
Displays Shortcut keys.

About Sidekick
Displays the Internet Sidekick version number and copyright information.



Write Menu
The Write Menu includes the tools for managing documents, folder, and binders, and for Mail Merge.
For more information, highlight one of the Write menu options, and press F1.



Document
The Write | Document menu provides tools for working with documents. 
For more information, highlight one of the Document menu options, and press F1.



Folder
The Write | Folder Menu includes the tools for managing folders.
For more information, highlight one of the Folder menu options, and press F1.



Binder
The Write | Binder Menu provides the tools for working with your binders.
For more information, highlight one of the Binder menu options, and press F1.



MailMerge
The Write | Mail Merge Menu provides tools for creating merge templates and performing a mail 
merge.
For more information, highlight one of the Mail Merge menu options, and press F1.



Document | Add
The Write | Document | Add command creates a new document in the current folder.

Shortcuts

Toolbar:
Keyboard: Ctrl+A



Delete Documents
In Write View, the Document Delete command (Write | Document | Delete) opens the Delete 
Documents dialog box, where you specify documents to delete from a folder.

Dialog Box Options

Delete

Current Document deletes the current document.

Marked Documents deletes all marked documents in the current folder. If no cards are marked, 
this option is dimmed.

Selected Documents deletes the selected documents. If no documents are selected, this option 
is dimmed.

Confirm Each Delete
When checked, Sidekick prompts you before deleting each document.



Move Documents
In Write View, the Document Move command (Write | Document | Move) opens the Move Documents 
dialog box, where you specify the documents to move from one folder to another. If there is only one 
folder in the open Write file, this command is dimmed. 
You can also drag and drop documents to another folder. 

Dialog Box Options

Select Documents to Move

Current Document moves the current document.

Marked Documents moves all marked documents in the current folder. If no cards are marked, 
this option is dimmed.

Selected Document moves the selected documents. If no cards have been selected, this option 
is dimmed.

All Documents moves all documents. 

To Folder
Indicates the folder to move documents to. 



Sort Documents By
In Write View, the Document Sort command (Write | Document | Sort) opens the Sort Documents By 
dialog box, where you specify documents and sort order. 
You can sort documents by subject or date created, in ascending or descending order; you can sort 
documents in the current folder or in all folders.

Shortcuts
Keyboard: Ctrl+R

Dialog Box Options

Sort Documents By

Subject sorts documents by the text contained in the Subject line of each document.

Date sorts documents by date. 

Document List Order

Ascending sorts documents in ascending order according to subject (A-Z) or date (oldest first). 

Descending sorts documents in descending order according to subject Z-A) or date (most recent
first). 

Apply to All Folders
Performs the sort on all folders, including the current one.



Mark/Unmark Current Document
The Write | Document | Mark/Unmark Current Document command marks or unmarks the current 
document.

Shortcuts
Keyboard: Ctrl+K
Mouse: Right-click documents in the document list to mark or unmark them.



Unmark All Documents
The Write | Document | Unmark All command unmarks all documents in the current folder. If no 
documents are marked, this command is dimmed.



Extract Documents
In Write View, the Document Extract command (Write | Document | Extract) opens the Extract 
Documents dialog box, where you specify documents to copy to a new Write binder. 

Dialog Box Options

What to Extract
Choose All Documents, Marked Documents, Selected Documents, Found Documents, or Documents 
by Condition.

Select Folders
Select which folders to extract from.
If you choose Documents by Condition, the Extract Criteria dialog box appears after you click OK. Use 
this dialog box to specify further conditions of the documents to extract.



Import Files
In Write View, the Document Import command (Write | Document | Import) opens the Import Files 
dialog box, where you specify the files to import. You can import text and RTF (Rich Text Format) files 
into Write. 

Dialog Box Options

File Name
Choose the file(s) you want to import into the current folder.

List Files of Type
Controls the file names that are displayed in the File Name list.

Directories
Displays the current directory. To change to a different directory, double-click it.

Drives
Displays the current drive. To change drives, click the arrow at the right of the box and double-click the 
drive you want.

Import File List
Displays the files to be imported into the current folder.

Network button
Click to map a network drive to a drive letter.

Add button
Click the Add button to add the file selected in the File Name list to the Import Files List. 

Delete button
Click the Delete button to remove the selected file from the Import Files List. 



Export Documents
The Write | Binder | Export command lets you save documents to the clipboard, a text file, or rich text 
format (RTF) file. 

Dialog Box Options

Documents to Export
Click your choice. You can export the current document, documents selected by a Find command, 
documents you have marked, or all documents in the selected folders.

Include Subject
Includes each document’s subject in the export file.

Select Folders
Sets the folders to export documents from. You can choose one folder, multiple folders, or all folders.

Export Documents To
Sets the export destination as the Clipboard or a text or rich text file. If you choose Text File or Rich 
Text File, the Save As dialog box appears.



Export Current Document
The Write | Document | Export command exports the current document to a rich text (RTF) file. The 
new RTF file’s name is the name of the Write document, with an RTF extension.



Add Write Folder
In Write View, the Folder Add command (Write | Folder | Add) opens the Add Write Folder dialog box, 
where you can create a new folder.

Dialog Box Options

Folder Name
Type the name of the new folder. 

Folder List
Lists the folders in the current Write file. 

Sort Folders Alphabetically
Sorts folder tabs alphabetically. 

Add button
Adds each new folder to the Write file. 



Modify Folder
In Write View, the Modify Folder command (Write | Folder | Modify) opens the Modify Folder dialog 
box, where you can change the name of a folder.

Dialog Box Options

Folder Name
Type the new name of the folder.

Folder List
Lists the folders in the current Write file.

Sort Folders Alphabetically
Sorts folder tabs alphabetically. 

Modify button
Changes the folder to the new name.



Delete Folder
In Write View, the Folder Delete command (Write | Folder | Delete) opens the Delete Folder dialog box,
where you select folders and delete them. This menu option is dimmed if there is only one folder.

Dialog Box Options

Folder List
Lists the folders in the current Write file. 

Delete button
Deletes the selected folder from the Write file.



 Folder | Combine
The Write | Folder | Combine command merges the documents and folders from one Write file into 
another. In the Combine Write Files dialog box, open the cardfile you want to add cards to.
For a description of the dialog box options, see File-Handling Options.
Note If the second Write file has any folder names in common with the open one, new folders are not 

added. Instead, their documents are added to the open Write file's in the folder of the same 
name.



Reorder Tabs
In Write View, the Reorder Tabs command (Write | Binder | Reorder Tabs) opens the Reorder Folder 
Tabs dialog box, where you can change the tab order of the binders. By default, folders are shown in 
the order of creation.

Shortcuts
Keyboard: F11

Dialog Box Options

Current Folder Order
Lists the folders displayed on the tabs in their current order. 

Up button
Changes the order of folders in the Current Folder Order list. Choose a folder and click Up to move the
folder tab to the left.

Down button
Changes the order of folders in the Current Folder Order list. Choose a folder and click Down to move 
the folder tab to the right.



Export Binder
In Write View, the Export command (Write | Binder | Export) opens the Export Documents dialog box, 
where you specify documents to export. You can export documents as text files and RTF (Rich Text 
Format) files, or copy them to the Clipboard.

Dialog Box Options

Documents to Export

Current Document exports the current document.

Found Documents exports documents found using Edit | Find.

Marked Documents exports all marked documents in the current folder. If no cards are marked, 
this option is dimmed.

All Documents exports all documents. 

Include Subject
Includes each document’s subject in the export file.

Select Folders
Sets the folders to export documents from. You can choose one folder, multiple folders, or all folders.

Export Documents To
Sets the export destination as the Clipboard or a text or rich text file. If you choose Text File or Rich 
Text File, the Save As dialog box appears so you can name the file.



Insert Card Fields
In Write View, the Create Template command (Write | Mail Merge | Create Template) opens the Insert 
Card Fields dialog box. This dialog box inserts fields from the active cardfile into the current document.

Dialog Box Options

Field Names
Choose the name of the field to insert into the document. 

Insert button
Click the Insert button to insert the field into the document template. 



Merge Card
In Write View, the Cardfile command (Write | Mail Merge | Cardfile) merges the document template 
with the active cardfile and creates new documents. If the current document has no field placeholders, 
such as {First Name}, this command will bring the first ten cardfields of the current card into the body 
of the document, and give the document the same subject as the card’s index line.

Dialog Box Options

Merge
Choose which cards (current, selected, marked, or all) to merge. 

Options

Print Merged Result prints the merged documents immediately. 

Enter in Contact Log stamps the subject lines of the new documents to the selected cards' logs. 

Save Merged Documents to Folder saves the new documents in a different folder than the 
template. Choose the folder in the Which Folder drop down box. 



Phone Menu
The Phone Menu provides tools for using and managing the Phone Dialer.
For more information, highlight one of the menu choices, and press F1.



Phone Dialer

 Related topics

The Phone Dialer dials the phone number displayed in the Number to Dial field, making the connection
for your voice call. Usually the number to dial is the number in the default phone field in the current 
card. You can change the number or card, or key in a different number. 
To open the Phone Dialer, do one of the following:

Choose Phone | Dialer.

Click the Call icon 

 on the Deskpad.

Drag a phone number in the Calendar onto the Call icon.

Press F9.    (Press F9 again to close the Phone Dialer)

Phone Dialer Options

Information Pane
The information pane at the top shows the index line of the current card in the Cardfile, and other 
telephone fields for that card. You can click the up-arrow or down-arrow to select a different field. You 
also can select a different card by clicking it in the Cardfile view or Viewport, and its telephone 
numbers will appear in the Phone Dialer.
The bottom line of the information panel shows the current status of your call, such as “Ready to Make 
Call” or “Dialing”.

Dial button
Click to dial the selected number. This can be a phone number in the Number to Dial field, or an entry 
you select in the Call History pane. When you see the Call Status dialog box, pick up your telephone 
handset and click Talk. Sidekick disconnects the modem so you can use the handset.    (Note: You 
must use the handset even if you have a voice modem and microphone.)

Redial button
Click to redial the latest number dialed. The redial number appears in the title bar. 

Answer button
Click this button and pick up your telephone handset to answer an incoming call. If you click Save to 
Card in the History pane, the call information is saved to the current contact log with the word 
ANSWERED.

Hang Up button
Click to hang up and end the connection. The timer is stopped, and the Call Note information is 
stamped to the Contact Log (if the “Automatically Enter Call Information…” option is checked in the 
Phone Dialer Setup).

Number to Dial
Shows the number to dial. You can choose a different phone number from the information pane or Call 
History pane. Or enter a new number using your keyboard or the keypad in the Phone Dialer. You can 
also click the index line of a different card in the Cardfile or Viewport while the Phone Dialer is open, 
and that card will be used by the Phone Dialer. (If you do not see the Number to Dial and the dialing 



keypad, click the Keypad button in the lower left corner of the Phone Dialer.)

Call History
Click the History button in the lower left corner of the Phone Dialer to open the Call History pane.    
Each incoming call is recorded here with three lines of information. Click the scroll arrows if necessary 
to see more call entries (the 40 most recent calls are displayed). Click the Keypad button to close the 
History pane and restore the dialing keypad.

Delete button removes the selected call entry from the History window.

Save to Card button saves the selected call entry information in the History window to a cardfile.
If no matching card exists, a new card is created.

Setup button 
Click to set up the dialing properties, line properties, and other settings. Opens the Phone Dialer 
Phone Dialer Setup dialog box. 

Call Note button
Click Call Note to open a panel for writing notes and timing the call. To close the notes panel, click the 
Call Note button again.



Setup Default SpeedDial Field

 Related topics

The Phone | Cardfile SpeedDial Field command opens the Setup Default SpeedDial Field dialog box, 
where you can specify which field in the current cardfile contains the number you will be using to dial 
most calls.

Dialog Box Options

Select a Phone Field
Click the field that contains the telephone number, and click OK. That number will be selected and put 
into the Number to Dial field when you open the Phone Dialer, although you can always choose 
another phone field in the card or the Phone Dialer, or type a number to dial.



Phone Dialer Setup

 Related topics

The Phone | Setup command opens the Phone Dialer Setup dialog box, where you specify dialing 
properties and modem settings.

Dialog Box Options

Dialing Properties

I am dialing from: Choose the location you are calling from. 

Ignore “My Locations” Settings: Check the box to bypass the settings for the current location 
when dialing.

Setup button: Click to open the Dialing Properties dialog box, where you can change the dialing 
information for your location.    Use Setup to create new locations, or to change properties, such as your 
area code, and any special numbers you must dial before making a call (such as outside line numbers, or 
calling card numbers). The Windows 95 Dialing Properties dialog box appears. If you travel with a 
portable computer, you can create dialing locations for different places you travel to.

Toll Prefixes button: Click to open the Toll Prefixes dialog box. Here you can specify local phone
exchanges that must be prefixed with 1+Area Code.

Modem Properties

Current Modem: Select the current modem fromt the drop-down list. 

Setup button: Click Setup to open the Windows 95 Modem Properties dialog box, where you can
specify settings such as communications port, modem speed, and other options.

Phone Dialer Properties

Dial using the handset instead of the modem: Check this box if you want to dial calls manually
using your telephone.

Automatically enter Call information into Contact Log at the end of call: Check if you want 
Sidekick to automatically record an entry in the Contact Log of the current card when you complete the 
call.

Phone Dialer Options

Monitor current modem for incoming calls:    Click Yes if you want Internet Sidekick to monitor 
for incoming calls and open the Phone Dialer automatically when an incoming call arrives.

Enable caller lookup in the current Cardfile: Check to enable Caller ID for incoming calls. 
Sidekick checks the number of the incoming call to see if it is in the current cardfile. If it is, the card is 
displayed.



Call Note

 Related topics

The Call Note panel in the Phone Dialer opens or closes when you click the Call Note button. 

Call Note
Type notes about the call. When you click the Save to Current Contact Log button (see below), this 
information is saved in the Contact Log of the current card. You can select a different card before 
saving.

Start button
Click Start to start or stop the timer.

Reset button
To reset the timer, click the Reset button.

Save to Current Contact Log button
Click to stamp the word CALLED or ANSWERED in the Contact Log of the ca0rd you have called, plus
the start time and call duration (from the Timer), and Call Notes.



Reports Menu
The Reports Menu lets you create, open, or return to a report on other Sidekick views. 
For more information, highlight one of the Reports Menu choices, and press F1.



Layout Menu (Report View)
The Layout Menu lets you modify the style and formatting of your report.
For more information, highlight one of the Layout Menu choices, and press F1.



Card Report
The Reports | Cardfile command opens the Card Report dialog box, where you can create a cardfile 
report.

Dialog Box Options

Report On

All Cards reports on the entire cardfile.

Index Range reports on only those cards that fall within an alphanumeric index range. Enter the 
range limits in the From and To boxes.

Marked Cards reports on only those cards marked with a red triangle on their index lines.

Selected Cards reports on only selected cards.

Cardfile Fields
Selects the cardfile fields to include in the report by moving them from the Cardfile Fields list to the 
Report Columns list using the >> or All --> buttons. Move individual fields out of the Report Columns 
list using the << button, or move all fields out using the <-- All button.



Calendar Report
The Reports | Calendar command opens the Calendar Report dialog box, where you can create a 
calendar report. 

Dialog Box Options

From/To
Sets the date range in the calendar to include in the report. One day is the minimum range.

Text to Find
Type text here to limit your report to items related to a specific person or key word.

Report On
Sets the type of activities from the calendar to include in the report: appointments, calls, To Dos, goals,
special days, and multi-day events.

Completed
Includes completed activities in the report.

Regarding
Includes any Regarding text attached to activities in the report.

Options button
Adjusts the level of detail for your report. Options become available as the selections are made in the 
Report On group. 

Details 
Sets further levels of details about appointments, calls, To Dos, and goals.

Include All Details
Selects all of the available options at once instead of selecting each option individually.



Free Time Report
The Reports | Free Time command opens the Free Time Report dialog box, where you can create a 
report on the times when you have no scheduled appointments.

Dialog Box Options

Date Range
Sets the date range in the Appointment list to report on. One day is the minimum setting.

Time Range
Sets the time range for each day to include in the report. One hour is the minimum setting.

Time Increments
Sets the level of detail for the report, displaying either 15 minute, half hour, or hour increments.



To Do Items Report
The Reports | To Do Items command opens the To Do Items Report dialog box, where you can create 
a report based on goals and To Dos.

Dialog Box Options

From/To
Sets the date range in the calendar to include in the report. One day is the minimum range.

Report On
Sets which tasks to include in the report: To Dos and/or goals.

Report on All
Includes all To Dos or goals in the report, regardless of their properties, due dates, or entry dates.

Text to Find
Type text here to limit your report to items related to a specific keyword.

With Due Date Between
Includes only those tasks with due dates within a specified date range.

Enter Date Between
Includes only those tasks with enter dates within a specified date range. 

Category
Selects the task categories to include in the report. Check All Categories to include all categories 
listed.

Assign
Selects the assigned people to include in the report. Check All Assigns to include all assigned names 
listed.

Priorities
Selects the priority levels to include in the report. Check No Priorities to include tasks that are not 
assigned a priority. Check All Priorities to include all priorities listed.

Include

Time Used includes a record of the accumulated time on the timer for each task in the report.

Completed includes only completed tasks in the report.

Regarding includes the Regarding text attached to each task in the report.



Contact Log Report
The Reports | Contact Log command opens the Contact Log Report dialog box, where you can create 
a Contact Log report.

Dialog Box Options

From/To
Sets the date range to report on. A minimum of one day must be designated.

Categories
Sets the type of logged entries to include in the report: Call, Document, or Appointment.

Report On

All Cards reports on the entire cardfile.

Marked Cards reports on only those cards marked with a red triangle on their index lines.

Selected Cards reports on only the selected cards (chosen by clicking, Shift+clicking, or 
Ctrl+clicking).

Index Range reports on only those cards that fall within an alphanumeric index range. Enter the 
range limits in the From and To boxes.

Cardfile Fields
Selects the cardfile fields to include in the report by moving them from the Cardfile Fields list to the 
Report Columns list using the >> or    All --> buttons. Move individual fields out of the Report Columns 
list using the << button, or move all fields out using the <-- All button.



Reports | Open Report
The Reports | Open Report command opens a report that was saved using File | Save Report. Choose
the report you want from the Open dialog box (for information about the dialog box options, see File-
Handling Options).



Reports | Go To Current Report
The Reports | Go To Current Report command switches to the current report in the Report view. 

Shortcuts
Keyboard F8



Layout | Choose Report Style
The Layout | Choose Report Style command copies the formatting from a report template to the 
current report. For information about the dialog box options, see File-Handling Options.



Layout | Save Report Style
The Layout | Save Report Style command saves the current font settings and headers as a template. 
For information about the dialog box options, see File-Handling Options.



Layout | Update Report
The Layout | Update Current Report command updates the data in the current report. It opens the 
same dialog box as the one you used to create the current report, with all the same options as you 
selected before. You can change the options if you want.



Layout | Font
The Layout | Font command sets the fonts used in the report. For information about the dialog box 
options, see Font Dialog Box.

Shortcuts
Keyboard: Ctrl+Shift+F
Mouse: Right-click



Report Title
When viewing a report, you can use the Layout | Header command to add a title and subtitles to the 
report header in the Report Title dialog box.

Dialog Box Options

Report Title
Type a title for the report.

Subtitles
Type subtitles for the report. Subtitles can contain up to three lines of text.
Note Sidekick prints reports with a footer indicating the page number and the placement of each page

in a multi-page array (if necessary) in (row, column) format. For example, if three pages in a 
report are to be viewed side by side, to see all the fields (columns) for each record (row), the 
footers for the last page will read “Page 3 (1,3)”.



Change Column Width
When viewing a report, you can use the Layout | Change Column Width command to set column 
widths for a report in the Change Column Width dialog box.

Dialog Box Options

Column
Sets the column you want to resize.

Width
Sets the width for the selected column in the Column list.

Choice

Fitted Width changes the width of each column to the length of its longest entry.

Fixed Width changes the width of all columns to the setting in the Width box.

Assign Width changes the width of the selected column to the setting in the Width box.

Wrap Text
When checked, wraps information in report cells to multiple lines.

Change button
Saves the requested changes to the specified column.



Hide Row Title
The Layout | Hide Row Title command hides the selected row title. If the title is already hidden, 
choosing this command displays it again.



Hide Column Title
The Layout | Hide Column Title command hides the selected column title. If the title is already hidden, 
choosing this command displays it again.



Tools Menu
The Tools menu contains a number of convenient utilities and options for working with Internet 
Sidekick. 
For more information, highlight one of the Tools menu options, and press F1.



Tools Menu (Cardfile)
The Tools menu contains a number of convenient utilities and options for working with Internet 
Sidekick. 
For more information, highlight one of the Tools menu options, and press F1.



Tools Menu
The Tools menu contains a number of convenient utilities and options for working with Internet 
Sidekick. 
For more information, highlight one of the Tools menu options, and press F1.



Tools Menu (Write)
The Tools menu contains a number of convenient utilities and options for working with Internet 
Sidekick. 
For more information, highlight one of the Tools menu options, and press F1.



Tools Menu (Expense)
The Tools menu contains a number of convenient utilities and options for working with Internet 
Sidekick. 
For more information, highlight one of the Tools menu options, and press F1.



Tools Menu 
The Tools menu contains a number of convenient utilities and options for working with Internet 
Sidekick. 
For more information, highlight one of the Tools menu options, and press F1.



Tools Menu (Report)
The Tools menu contains a number of convenient utilities and options for working with Internet 
Sidekick. 
For more information, highlight one of the Tools menu options, and press F1.



Extract Cards
The Tools | Extract Cards menu contains options for extracting cardfile data to a new cardfile.
For more information, highlight one of the Extract menu options, and press F1.



Contact Manager
The Contact Manager command (Tools | Contact Manager) searches your calendar and cardfile for 
calls, appointments, To Dos, and Contact Log entries relating to a specific card (or contact). Use this 
command to quickly review past and future activities with a contact, and schedule new activities.

Shortcuts

Toolbar:

Dialog Box Options

Activities For
Specifies the text searched for in the Calendar and Cardfile. (By default, this text is the index line of the
current card.)

Date Range
Sets the date range for searching contacts. Choose from: Today, Tomorrow, This Week, Next Week, 
This Month, Next Month, or Pick A Date Range. If you select the Pick A Date Range option, the Select 
Date Range dialog box appears, prompting you to specify the dates. You can then choose After, 
Before, or Between specific dates.
The default date range is set to Pick A Date Range, with the range being one month: from two weeks 
previous to today to two weeks after.

Activities List
Shows all activities found after you choose Search. This can include appointments, To Dos, calls, 
goals, multi-day events, and special days, as well as Contact Log entries, including [Regarding Text], 
[Called], [Answered] and [Calendar]. The activities are listed in this format: Date, Type, Text, such as 
"7/26      To Do      Write thank-you note to Ed".

Search Setup button
Opens the Setup Search dialog box, which lets you set the parameters for searching for activities 
relating to a contact.

Refresh button
Performs another search based on the current settings.

Schedule New button
Opens the Schedule New Activity dialog box, which lets you create new appointments, calls, or To 
Dos.

Go To button
Takes you to the exact location of the selected call, appointment, or To Do in the Activities List. If a file 
name entered in the Contact Log is selected, Go To opens the file in its respective application.



Quick Letter
The Quick Letter command (Tools | Quick Letter) opens the Create a Letter dialog box, where you can 
create a letter using data on the current card.
In the Create a Letter dialog box, choose the desired document template, and click OK. A mail merge 
function is performed on the selected template using the current card. 
The fields in the pre-defined templates are based on the fields from the Business and Personal cardfile
templates. If there are fields in the selected template that don’t exist in your active cardfile, the fields 
are not replaced with cardfile data. Instead, the field names enclosed in brackets remain in the letter.
If you uncheck the box labeled “Show this dialog when clicking Quick Letter Button”, you can still see 
the dialog box by choosing Tools | Quick Letter.

Shortcuts

Toolbar:



Synchronize
The Tools | Synchronize menu has options for synchronizing calendar files and cardfiles.

Synchronize Appointments
Synchronize Cards

For information about the conversion technology, see Information About File Conversions.
In addition, the Synchronize menu contains commands for using the Internet Time Synchronizer.    For 
more information, right click the Time Synchronizer icon in the system tray, and choose Help from the 
menu.
Note The files to be synchronized must not be read-only.



Synchronize Appointments
The Tools | Synchronize | Appointments command synchronizes appointments between two calendar 
files. After synchronizing, the two files will contain the same appointments. 
In the Choose Appointment File to Synchronize dialog box, choose the calendar file whose 
appointments you want to synchronize with the open calendar. 
You can synchronize between Sidekick calendar files and other file types by selecting the file format 
from the List Files of Type box. For a description of the dialog box options, see Calendar File-Handling 
Options.
When you click OK, the Reconcile Date Range Dialog Box appears, where you select the date range.
Note Identical appointments are not added to the files. If the appointments are at all different, they are

added as separate appointments. Since calendars can have up to three appointments occurring
at the same time, Sidekick will add appointments for any block of time until it reaches this limit. 



Synchronize Cards
You can synchronize data in two cardfiles using the Synchronize Cards command (Tools | Synchronize
| Cards).
After choosing this command, select the cardfile in the Synchronize Cardfile dialog box. You can 
synchronize Sidekick cardfiles and other file types by selecting the file format from the List Files of 
Type box.
Click the Help button in the dialog boxes that appear for more information. 



Conversions

 Example

The Conversions command (Tools | Conversions) opens the Conversions dialog box, where you can 
convert between English and metric measurement, or between numerous other units of standard or 
scientific measurement.

Dialog Box Options

Categories
Specify the category of units you want to convert, such as length, area, capacitance, weight, mass, 
luminance, or other category.

From
In the Value box, type the number you want to convert. 
Specify the Unit you are converting from by selecting it from the drop-down list. 

To
In the Unit box, specify the unit you are converting to. 
Read the converted quantity in the Value box.

Precision
You can set the number of significant digits in the Precision box. Type a number between 4 and 12, or 
use the spin control arrows to change the number. 



Conversion example
To convert 75 square kilometers to acres, 
1. Choose Area as the Category.
2. Type 75 in the Value box.
3. Select square kilometers as the From unit.
4. Select acres as the To unit.
5. Read the answer: 75 square kilometers = 18532.8 acres. This result has a precision of 6 significant 

digits.



Calculator
The Tools | Calculator command shows the Sidekick Calculator.

Shortcuts

Toolbar:

Options

Off
Closes the Calculator.

Up/Down Arrows
Scrolls through the Calculator tape containing results from the current calculations.

Reset
Resets the Calculator completely, clearing the tape and all function keys.

F1, F2, F3
Customizable function keys for special calculator operations.



Setup

 Related topics

The Tools | Setup menu has options for using the Setup Wizard and modifying the Custom Toolbar.
Wizard
Custom Toolbar



Custom Toolbar Setup
The Custom Toolbar command (Tools | Setup | Custom Toolbar) lets you choose the buttons that 
appear in the Custom Toolbars. 

Dialog Box Options

Available Buttons
Displays the available buttons. Select the button you want to add to the Custom Toolbar.

Current Buttons
Displays the currently selected buttons. Select the button from this list if you want to remove it.

Add After button
Adds the new button after the button highlighted in the Current Icons list.

Add Before button
Adds the new button before the button highlighted in the Current Button list.

Remove button
Removes the selected button from the Current Button list.

Separator button
Inserts a separator before the button selected in the Current Button list. In the Toolbar, this appears as 
an extra space between the buttons.



Preferences
The Tools | Preferences menu has options for customizing Internet Sidekick.
General
Calendar
Write
Expense
Group Scheduling



General Preferences
Use the General command (Tools | Preferences | General) to set up the overall program defaults in the
General Preferences dialog box.

Dialog Box Options

Default Deskpad View
Sets the default view at startup. Choose between Calendar, Weekly View, Monthly View, Yearly View, 
EarthTime, Cardfile, Write, Expense, or Activities. This option is dimmed if the Remember Last Active 
Deskpad View box is checked.

Remember Last Active Deskpad View
When this box is checked, Internet Sidekick opens at the view you last used in your previous session. 
(However, the Expense view always opens on the Receipt view, even if you were viewing an expense 
report when you exited.) When this box is unchecked, you can select the default view from the Default 
Deskpad View list.

Deskpad Icons On

Right Side displays icons on the right side of the Deskpad. 

Left Side displays icons on the left side of the Deskpad. 

Hide Deskpad Icons hides the icons. 

Deskpad Colors button
Click to setup colors for Internet Sidekick's views. 

Options

Password at Start-Up asks for a password when you start Internet Sidekick.

Start Maximized starts Internet Sidekick in a maximized window.

Digital Clock shows a digital clock in the Deskpad Controls instead of an analog clock.

Prompt for Save on Exit prompts you to save files when you exit.

Show Animation uses an animated effect each time you select a card or document.

Key to Move between Fields in Card Entry
Choose the Tab key or the Enter key to move from field to field in the Add Card dialog box.

Default Working Directory
Shows the default directory where Sidekick will look for or store files. You can type a different path, or 
click the Browse button, to change the default directory.

Fonts button
Click to change the display font for the Cardfile and Write. 

Password button
Click to set a Sidekick password. 





Calendar Preferences

 Related topics

The Calendar Preferences command (Tools | Preferences | Calendar) lets you set your preferred 
configuration for the Calendar views. For more information, click a topic in the following list:
Daily Page
Weekly Page
Monthly Page
Yearly Page



Daily Page (Calendar Preferences)

 Related topics

Use the Daily page of the Calendar Preferences dialog box to set options for the Daily Calendar. The 
Calendar Preferences command (Tools | Preferences | Calendar) opens this dialog box.

Dialog Box Options

Time

From/To sets the beginning and ending time for the Appointments schedule.

Increment sets the time intervals to show on the Appointments schedule; select 15, 30, or 60 
minutes.

Forward Incomplete Items
Check or uncheck any of the following items to reschedule overdue items to the next day if they 
remain uncompleted: calls, To Dos, and (overdue) goals.

Auto Forward From X Days Back sets the number of days back Sidekick checks when searching 
for incomplete items to forward to today.

Alarm Snoozes For
Sets the "snooze" duration for alarms. If you click the Snooze button on an alarm message, Sidekick 
will wait this duration until displaying another alarm message.

Display Appointment Starting and Ending Time
Determines whether the appointments in the Appointments list display their starting and ending times. 

Work Space
Choose what you want to see in the four quadrants of the work space. The Viewport is always 
displayed in the Bottom Right.



Weekly Page (Calendar Preferences)

 Related topics

Use the Weekly page of the Calendar Preferences dialog box to set options for the Weekly View of the
Calendar. The Calendar Preferences command (Tools | Preferences | Calendar) opens this dialog box.

Dialog Box Options

View
Check all entries you want to display: Multi-Day Events, Special Days, Appointments, Calls, and To 
Dos in the view.

Option
Check or uncheck the following options:

Summary displays items in summary. For example, if you have four appointments scheduled, the
Summary displays "4 Appointments." Regarding notes, icons, and durations do not display.

Detail displays calendar items in full detail.

Completed Items displays completed items.

Wrap Text text of long entries wraps to new line; otherwise, long lines are truncated. 

Regarding displays the description from the Regarding field for all activities.

Appts. w/Duration displays the starting and ending times of appointments.

Leading Icon the activity icons display next to the appointments, To Dos, and calls.

Week of Year displays the week of year.

Fonts
Opens the Change Display Font dialog box.



Monthly Page (Calendar Preferences)

 Related topics

Use the Monthly page of the Calendar Preferences dialog box to set options for the Monthly View of 
the Calendar. The Calendar Preferences command (Tools | Preferences | Calendar) opens this dialog 
box.

Dialog Box Options

View
Check all entries you want to display: Multi-Day Events, Special Days, Appointments, Calls, and To 
Dos in the view.

Option
Check or uncheck the following options:

Summary displays items in summary. For example, if you have four appointments scheduled, the
Summary displays "4 Appointments." Regarding notes, icons, and durations do not display.

Detail displays calendar items in full detail.

Completed Items displays completed items.

Wrap Text text of long entries wraps to new line; otherwise, long lines are truncated. 

Regarding displays the description from the Regarding field for all activities.

Appts. w/Duration displays the starting and ending times of appointments.

Leading Icon the activity icons display next to the appointments, To Dos, and calls.

Day of Year displays the day of the year on each day.

1st Day of the Week sets the first day of the week to display.

Fonts
Opens the Change Display Font dialog box.



Yearly Page (Calendar Preferences)

 Related topics

Use the Yearly page of the Calendar Preferences dialog box to set options for the Yearly View of the 
Calendar. The Calendar Preferences command (Tools | Preferences | Calendar) opens this dialog box.

Dialog Box Options

Yearly Planner
Shows the entire year in a planner format with each column representing a different day of the week 
and each row representing each month.

Horizontal Yearly View
Shows the yearly calendar in a 4x3 grid format. The months are shown in order horizontally from left to
right for each row.

Vertical Yearly View
Shows the yearly calendar in a 4x3 grid format. The months are shown in order vertically from top to 
bottom for each row.



Write Preferences
Use the Write Preferences command (Tools | Preferences | Write) to set options for the Write view in 
the Write Preferences dialog box.

Dialog Box Options

Default Font for Subject
Select the default font and size that appears in the subject of the document.

Default Font for Document Text
Select the default font and size used for the document text.

Auto Spell Check
Check to have automatic spelling check turned on by default.



Expense Preferences

 Related topics

Use the Expense Preferences command (Tools | Preferences | Expense) to open the Expense 
Preferences dialog box. You can change your expense report defaults, such as mileage rate and 
currency, and you can add your own custom expense types.

Shortcut

Toolbar:
Note Changes you make in Expense preferences affect only new receipts you create after changing 

the preferences.
For more information, see:

Defaults
Currency
ExpenseType
Pick List



Expense Preferences: Defaults Page

 Related topics

Use the Defaults page of the Expense Preferences dialog box to set defaults for Expense View. The 
Expense Preferences command (Tools | Preferences | Expense) opens this dialog box.

Dialog Box Options

Home Currency
Select your home currency from the drop-down list.

Mileage Rate
Enter the mileage reimbursement rate. When you enter a mileage receipt, this rate will be multiplied by
the number of miles you enter to calculate the amount.

1st Day of the Week in the Report
Choose the first day of the week for expense reports from the drop-down list.

My Preferred Country Setting
Check the one that applies to your location. The tax designations are VAT (Value Added Tax), GST 
(Goods and Services Tax) and PST (Provincial Sales Tax).

U.S.A. and other countries (without VAT/GST/PST)
European Countries (with VAT)
Canada (with GST/PST)

Show Currency in the Receipt
Check the box if you want the Currency field displayed in the receipt. If enter receipts only in a single 
currency, you can uncheck the box to hide the Currency field. 



Expense Preferences: Currency Page

 Related topics

Use the Currency page of the Expense Preferences dialog box to specify the current exchange rate for
the currency you specified on the Defaults page. The Expense Preferences command (Tools | 
Preferences | Expense) opens this dialog box.

Dialog Box Options

Currency Exchange Rate

One ___ 
Select the basic currency you use, typically $.

= ___      ___
Type an exchange rate value in the first field, and select the currency in the second field. For example,
if you are from the U.S. and travel to France, you would enter (using the whatever is then current 
exchange rate ):    one $ = 5.0352 FF.

Modify button
If you change the exchange rate value, click the Modify button to save the change.



Expense Preferences: Expense Type Page

 Related topics

Use the Expense Type page of the Expense Preferences dialog box to set up custom expense types. 
The Expense Preferences command (Tools | Preferences | Expense) opens this dialog box.

Dialog Box Options

Custom Expense Type
Type the name of a new expense type you want to create.

Based On
Select an existing type the new type is to be based on.

Add to the Category
Select the category you want the new type to belong to.

Add to Expense Report
Check if you want the new type added to your expense report. 

Add button
Click to add the custom expense type to the list.

Delete button
Click an expense type and click the Delete button to remove it from the list.



Expense Preferences: Pick List Page

 Related topics

Use the Pick List page of the Expense Preferences dialog box to add or delete pick list items for fields 
on expense receipts. The Expense Preferences command (Tools | Preferences | Expense) opens this 
dialog box.
The pick list items consist of entries you have typed as you enter expense receipts. For example, once
you type a name in the City field of a receipt, it automatically appears in the drop-down list for the City 
field on all receipts. On the Pick List page, you can add more items to as many fields as you like.

Dialog Box Options

Select a Field
Click a field. Its current pick list items appear under Pick List items. 

Pick List Items
Type a new item for the Field in the top text box.

Add Item button
After typing a new item, click Add Item to add it to the selected field.

Delete Item button
Click a Pick List item, and click Delete Item to remove it.



Group Scheduling Preferences
Use the Group Scheduling Preferences command (Tools | Preferences | Group Scheduling) to open 
the Scheduling Preferences dialog box, where you set options that control Internet group scheduling 
and e-mail messaging on your computer. 

Scheduling Page Options

Flash Sessions

Activate Flash Sessions turns on or off automatic sessions to send and receive group 
scheduling messages. These messages include invitations for events you create, reply messages, and 
Sidekick-generated messages for any resources you manage.

Every sets the interval. Specify how often you want your system to check for incoming schedule 
messages and send your outgoing ones.

On the following days
Check all days of the week that you want automatic message sending and receiving active.

Delete entries from Activities View ___ days after completion
Determines how long events that have passed stay in your Activities list before being automatically 
deleted.    Uncheck the box if you do not want automatic deletion of completed events.



Group Scheduling Preferences: Electronic Mail Page
The Electronic Mail page of the Group Scheduling Preferences dialog box (Tools | Preferences | Group
Scheduling) contains messaging options.

Dialog Box Options

Transports to Use
Click the service you use for messaging.

Microsoft Exchange
Select this option if you are using Microsoft Exchange mail. Click the Exchange button to set up 
account information. 

Internet 
Select this option if you are using Internet mail. Click the Internet button to set up account information. 

None
Select this option if you do not have e-mail, or do not want to enable Internet group scheduling. If you 
select multiple participants for an event, you will have to use the phone or fax options for notifying 
them. 

Delete Group Scheduling Messages after retrieving them 
Check the box if you want Internet Sidekick messages in the Inbox or POP3 server to be deleted 
automatically after retrieving them.
Would you like Internet Sidekick to send and receive Microsoft Schedule+ compatible 
messages? If you click Yes, the following option is not available. 

Authenticate incoming group scheduling messages
Check this option to have incoming group scheduling messages or replies automatically tested for 
authenticity. If a non-Sidekick user is replying manually and makes changes in the “do not modify” 
section of the message, for example, the reply will fail authentication.    Note: when this option is 
checked, any message that fails the authenticity test is discarded.



Group Scheduling Preferences: Signature Page
The Signature page of the Group Scheduling Preferences dialog box (Tools | Preferences | Group 
Scheduling) lets you define a signature for your messages. The text of the signature appears at the 
end your replies and other Internet scheduling messages.
Under Your Personal Signature, type the signature you want at the end of your messages. For 
example, you might include your real name, company name, phone and fax information.    It initially 
contains information you entered in the Setup wizard. 
Note You should limit your signature to a few brief lines, to ensure efficient messages.



Exchange settings
Use this dialog box to enter Microsoft Exchange settings for Internet e-mail addressing.    (To open this 
dialog box, choose Tools | Preferences | Group Scheduling. In the Electronic Mail page of the dialog 
box, choose Microsoft Exchange, and click the Exchange button.)
In the upper pane, click each Exchange service you want to be able to use for group event messaging.
In the lower panel, enter your Internet Address. If you use Exchange and send group scheduling 
messages to non-Exchange users via the Internet, this address is used for their replies.



Merge Cardfile
The Tools | Merge Cardfile command lets you merge the fields and data from one cardfile into another. 
In the Merge Cardfile dialog box, open the cardfile you want to add cards from.
For a description of the dialog box options, see File-Handling Options.
When you click OK, the Remove Duplicated Cards dialog box appears, where you choose how to 
handle cards that have the same index line.
Note There is no Undo option for merges. When you merge cardfiles, the cardfile you add data to 

changes to accommodate the new data and fields. To keep a copy of the original cardfile, save 
the merged cardfile to a new name.



Extract On Text
The Extract Cards On Text command (Tools | Extract Cards | On Text) opens the Extract on Text dialog
box, where you can specify text to search for in the cardfile, as well as what part of the cardfile to 
search. It then copies the matching cards to a new, untitled cardfile.

Dialog Box Options

Text to Find
Type the text you want to find in the cardfile.

Extract From
Select the areas of the cardfile you want to search. Choose from Index, Contact Log, Selected Cards, 
Cards, or Marked Cards. If there are no marked cards in the cardfile, the Marked Cards option is 
unavailable.



Extract Cards On Index Range
The Extract Cards On Index Range command (Tools | Extract Cards | On Index Range) opens the 
Extract on Index Range dialog box, where you can enter the index lines of the first and last cards of a 
range that you want to copy to a new cardfile.

Dialog Box Options

From
Type the index line information for the first card of the range of cards you want to add to a new cardfile.

To
Type the index line information for the last card of the range of cards you want to add to a new cardfile.



Extract Cards On Condition
The Tools | Extract Cards | On Condition command searches the active cardfile for data meeting a 
specific condition. Once matching data has been found, a copy of the card is added to a new cardfile.
For a description of the dialog box options, see Extract Cards on Condition Dialog Box.



Spelling
The Spelling command in Write View (Tools | Spelling) begins the spelling check, and opens the 
Spelling dialog box if a word is not found in the dictionary.    You can select text before using the 
Spelling command, to check only the text you have selected.
Tip To check a single word, right click with the pointer on the word. If the Spelling Checker does not 

recognize the word, the shortcut menu will have suggested replacements.

Shortcut

Toolbar:

Dialog Box Options

Not In Dictionary
Displays the word that may be misspelled.

Change To
Displays the correction that Sidekick suggests.

Change button
Inserts the suggested replacement.

Change All button
Replaces all instances of the found word with the replacement.

Ignore button
Ignores the found word, and continues.

Ignore All button
Ignores all instances of the found word.

Add To User Dictionary
Adds the found word to your user dictionary.

Undo Last Change
Reverses the last replacement.



Auto Spell Check
The Tools | Auto Spell Check command in Write View turns on and off the automatic spelling checker.   
After turning on Auto Spell Check, text you type is continuously checked for spelling errors. Words not 
in the dictionary are marked with Strikeout as possible misspellings. Right-click a misspelling to see 
proposed corrections.
When you print, you can uncheck Print Misspelled Words In Strikeout Font Style in the Print dialog box
if you want words in Strikeout to print in normal style.
Note To avoid conflicts with marked misspellings, you should avoid using strikeout in your text.



Word Count
The Word Count command (Tools | Word Count) displays several useful statistics about the current 
document: Pages, Words, Characters, Paragraphs, and Lines.



View Menu
The View menu lets you switch to a different Sidekick view and control the display.
For more information, highlight one of the View menu options, and press F1.



View Menu (Cardfile)
The View menu lets you switch to a different Sidekick view and control the display.
For more information, highlight one of the View menu options, and press F1.



View Menu (Calendar)
The View menu lets you switch to a different Sidekick view and control the display.
For more information, highlight one of the View menu options, and press F1.



View Menu (Write)
The View menu lets you switch to a different Sidekick view and control the display.
For more information, highlight one of the View menu options, and press F1.



View Menu (Expense)
The View menu lets you switch to a different Sidekick view and control the display.
For more information, highlight one of the View menu options, and press F1.



View Menu (EarthTime)
The View menu lets you switch to a different Sidekick view and control the display.
For more information, highlight one of the View menu options, and press F1.



View Menu (Report)
The View menu lets you switch to a different Sidekick view and control the display.
For more information, highlight one of the View menu options, and press F1.



View Menu (Activities)
The View menu lets you switch to a different Sidekick view and control the display.
For more information, highlight one of the View menu options, and press F1.



Calendar
The View | Calendar command switches to the Calendar.

Shortcuts
Keyboard: F6
Deskpad Icon:



EarthTime
The View | EarthTime command switches to EarthTime.

Shortcuts
Deskpad Icon:



Cardfile
The View | Cardfile command switches to the Cardfile.

Shortcuts
Keyboard: F5
Deskpad Icon:



Write
The View | Write command switches to Write.

Shortcuts
Keyboard: F7
Deskpad Icon:



Expense
The View | Expense command switches to the Expense view.

Shortcuts
Keyboard: F8
Deskpad Icon:



Activities
The View | Activities command switches to the Activities view.

Shortcuts
Deskpad Icon:

    



Daily View
The View | Daily View command switches to the Daily Calendar view.



Weekly View
The View | Weekly View command switches to the Weekly Calendar view.



Monthly View
The View | Monthly View command switches to the Monthly Calendar view.



Yearly View
The View | Yearly View command switches to the Yearly Calendar view.



Toolbar
The View | Toolbar command shows the Toolbar.for the current view. 
Note In the Calendar, the Toolbar’s on/off state is saved with the calendar file, so opening a different 

calendar can cause the Toolbar to be displayed or hidden.



Custom Toolbar
The View | Custom Toolbar command shows the Custom Toolbar.



Status Bar
The View | StatusBar command shows the Status Bar. 



Index View
The View | Index View command in the Cardfile displays the current card in Index View, which includes
the Card list (index). 

Shortcuts
Keyboard: Ctrl+E



Card View
The View | Card View command in the Cardfile displays the current card using the whole screen as 
editing space. 

Shortcuts
Keyboard: Ctrl+E



Document View
The View | Document View command in Write displays the current document full-screen, with the index
hidden. 

Shortcuts
Keyboard: Ctrl+E



Folder View
The View | Folder View command in Write displays the current document in Folder View, which 
includes the document list (index).

Shortcuts
Keyboard: Ctrl+E



Ruler
The View | Ruler command displays the ruler in the Write view. Use the ruler to change margins and 
set tabs. 
Note Any changes you make to the ruler only affect the selected lines. 
To change a margin, drag the lower arrow at either end. The arrow’s position marks the margin for the 
selected line.
To change the indent of the first line of a paragraph, move the upper arrow on the left of the ruler. Note 
that you can set the indent to the left of the left margin, thus creating an outdent. 
To add a tab stop, click on the ruler where you want it set. To move a tab stop, drag it along the ruler. 
To delete a tab stop, drag the tab stop downward, away from the ruler.



Line Numbers
The View | Line Numbers command displays line numbers in the current document.



Receipt View
In Expense View, the View | Receipt View command switches to the Receipt View of your expenses.
Enter your receipts using the Receipt View. The Report View arranges the receipts you have entered 
by date and category, and totals them, ready to be printed.



Report View
In Expense View, the View | Report View command switches to the Report View of your expenses.
Enter your receipts using the Receipt View. The Report View arranges the receipts you have entered 
by date and category, and totals them, ready to be printed.



All Events 
The View | All Events command displays all events that appear in your Calendar view. This includes 
Appointments, To Do items, Calls, Multi-Day and Special Day events, plus confirmed Internet 
scheduling events. 
Note The All Events tab does not include intems from the Internet Events tab that you have not 

accepted yet.



Appointments
The View | Appointments command displays appointments only in the Activities view.



To Do Items
The View | To Do items command displays To Do items only in the Activities view.



Calls
The View | Calls command displays Calls only in the Activities view.



Internet Events
The View | Internet Events command displays group events only in the Activities view.



Creating a Cardfile
Using cardfile templates Topic 1 of 4

To create a cardfile

1. Click the New Cardfile button , or choose File | New Cardfile. The Select Cardfile Template 
dialog box appears. 

2. Click each template, and view the fields they contain (you can add or modify fields later).
3. Select the template you want. If you don’t want to use a template, and you want to create all the 
fields yourself, choose None as the cardfile template.
4. Click OK.

If you selected a template, an empty cardfile appears, containing the fields from the selected template. 
If you want to change any of these fields, see the next topic in this series. If you selected None, the 
Define Cardfile Fields dialog box appears. 
Note Use the Browse buttons    >>    (next topic)    and    <<    (previous topic) to move through this 

series.



Creating a Cardfile
Adding new cards Topic 2 of 4

To add cards to the cardfile 

1. Choose Cards | Add, or click the Add button  on the Toolbar. The Add Card dialog box appears.
2. Type the data in each field. 
3. Click Add to add the information as a new card. Click Close when you have added all the new 
cards you want.

Note Use the Browse buttons    >>    (next topic)    and    <<    (previous topic) to move through this 
series.



Creating a Cardfile
Changing cardfile fields Topic 3 of 4

Choose Cards | Define Fields to display the Define Cardfile Fields dialog box,. 

To add a field
 Type a name in the Field Name box, and click Add or Add Before. 

To change a field name
 Select it from the list, and then type the new name and click Change. 

To delete a field
 Select it from the list and click Delete. 

You can also change the order of fields in the cardfile.

To reorder the cardfile fields
 Choose Cards | Reorder Cardfile fields. The Reorder Cardfile Fields dialog box appears.
Note Use the Browse buttons    >>    (next topic)    and    <<    (previous topic) to move through this 

series.



Creating a Cardfile
Sorting a cardfile Topic 4 of 4

Every card has an index, or title line defined for a cardfile by up to three fields. Sidekick sorts the cards
alphabetically (or reverse alphabetically, if you choose) according to its index. 

To define the index

1. Choose Cards | Sort Cardfile, or click the Sort button  on the Toolbar. The Sort Cardfile dialog 
box appears. 

2. Choose up to three fields to use as the index.
Note Use the Browse buttons    >>    (next topic)    and    <<    (previous topic) to move through this 

series.



Adding Cards
To add cards to the cardfile 

1. Choose Cards | Add, or click the Add button  on the Toolbar. The Add Card dialog box appears.
2. Type the data in each field. 
3. Click Add to add the information as a new card. Click Close when you have added all the new 
cards you want.



Moving Cards Between Cardfiles
To move a group of cards from the current cardfile to another open cardfile 

 Drag and drop the cards on another cardfile’s tab. 

To copy cards instead of moving them
 Hold Ctrl while dragging and dropping. 

You can also choose Cards | Move to move the current card, selected cards, marked cards, or all cards to
a different open cardfile.
When you move or copy cards between two cardfiles, the Match Cardfile Fields dialog box appears. This 
dialog box automatically matches fields that share the same name in both cardfiles. You can match other 
fields manually by selecting a field from each cardfile and clicking the Match button. 

Information from unmatched fields will be placed in the last field of the new card.



Adding a To Do

 Related topics

You can enter tasks into Sidekick’s To Do list and check them off when completed. Sidekick forwards 
any incomplete To Dos to the next day. You can also give a To Do attributes like a priority, category, 
due date, and person assigned to handle it.

To create a new To Do 
 Click any blank line in the To Do list and begin typing. Or you can choose Calendar | To Do Items | Daily, 

which opens the To Do dialog box.
You can also edit the text of existing To Do items by clicking the To Do line and typing. 



Adding an Appointment

 Related topics

Put all your appointments and scheduled tasks into the Appointments list. You can have any number of
appointments scheduled throughout the day, and up to three appointments scheduled for the same 
time. 

To create an appointment 
 Click the Appointments list’s time line on the time you want to start your appointment, and type its 

description. When you’re done typing, press Enter.

To drag an appointment to change its start time
 Grab its icon and drag it up or down to a new time. 

To change its duration 
 Click on the appointment, and drag its bottom edge up or down. 



Making a Recurring Appointment, To Do, or Call

 Related topics

To schedule a recurring event (one that occurs at regular intervals) 
1. Choose the type of activity you want from the Calendar menu in the Daily view: Event, Call, or To Do

item, and then choose Recurring.
2. Enter information in the Text and Regarding text boxes. 
3. Set the range of days, weeks, or months that the activity will recur using the From and To dates. 

There is a dialog box for each kind of recurring activity:
Recurring To Do,
Recurring Appointment,
Recurring Call.

4. Choose the interval of recurrence. When you’re done, click Add.
Tip To change an existing activity into a recurring one, click the Recurring button in the activity’s Daily 
dialog box.



Adding Multi-Day Events
To schedule a multi-day event 

1. Choose Calendar | Events | Multi-Day Event, or click the multi-day event button.  The Multi-Day
Event dialog box appears.

2. Type the name of the multi-day event in the Description text box.
3. Select the month, day, and year for the starting and ending dates of the event. 
4. Select Full Day, AM, or PM (visible in Yearly Planner), and a Color for the event’s bar.
5. Click Add to place the event in the Multi-day events list and add it to your calendar.



Adding a Document
To add a document to the current folder 

1. Click the Add Document button  or choose Write | Document | Add. 
2. Type a subject for the document.
3. Press Enter to move into the body of the document, or click in the document space. 
4. Type and format your document.



Faxing a Document
You can fax a Write document directly from Sidekick using the Windows 95 Fax capability. 

To fax a Write document
1. In the Write view, open the Viewport and display the Card list.
2. Select one or more cards as the fax recipients. (These cards must have a field that includes the 

word "fax" in the field name, and there must be a fax number in the field.) If you don't make a 
specific selection, Sidekick uses the current card.

3. Right-click the current Write document and choose Send to | Fax from the shortcut menu. The Write 
document is faxed to the people whose cards you selected. 



E-mailing a Document
You can e-mail a Cardfile card or a Write document with the click of your mouse, using either Eudora 
Pro (32-bit) or Microsoft Exchange.. 

To send a document or card as e-mail
1. Right-click the text of a document, or the data area of a card, 
2. Choose Send To, and choose your e-mail software: Eudora Pro or Exchange. 
3. Use your e-mail software to address and send the information.



Backing Up Your Files

 Related topic

Back Up copies the Sidekick files you specify to a backup location, such as another disk drive or 
diskettes. When you Restore, Sidekick puts the files back in their original locations, either on the same
computer or on another. 
You can copy multiple files across multiple diskettes, as long as no single file is larger than the 
capacity of the backup disk, usually 1.44Mb for a diskette..

To back up files
1. Save your open files. The backup program only copies the last-saved versions of your files.
2. Choose File | Back Up And Restore. The Back Up And Restore dialog box appears.
3. Click the Back Up button and click Next. The Back Up dialog box appears.
4. Select all the files you want from the Source Files list. Click > to add the selected files to the Backup

List. Click >> to add all files in the Source Files directory to the Backup List. Change the Source or 
Destination directories if needed.

5. After you’ve selected all the files you want to back up and specified the directory to copy them to, 
click Begin. 



Restoring Your Files

 Related topic

To place backed-up files onto another computer, or restore them to their original source
1. Choose File | Back Up And Restore. The Back Up And Restore dialog box appears.
2. Click the Restore button. The Restore dialog box appears. Notice that each file to be restored 

already indicates its own destination directory. 
3. Select which files you want to restore from the Files To Restore list, and click >. Or restore all listed 

files by clicking the >> button. Change the Source or Destination directories if needed.
4. Click Begin, and Sidekick copies the selected files to the correct directories.
Note You can only restore files backed up using Internet Sidekick. Files created by earlier versions of 

the Back Up utility are not compatible.



Designing Printing Label Contents 
Overview Topic 1 of 7

The design you create in the Set Up Contents dialog box will repeat on each printed label (or envelope
or address book page). To open this dialog box, click Set Up Contents in the Print Labels dialog box. 
The design is made up of four types of elements: 

    Card Fields

    Text

    Graphics

    Stamp
These are discussed later in this series.
When you are finished with your design, click the Save As button to save your contents.
Note Use the Browse buttons    >>    (next topic)    and    <<    (previous topic) to move through this 

series.



Designing Printing Label Contents
Creating and editing elements Topic 2 of 7

Create the four types of elements by clicking their buttons: 

    Card Fields

    Text

    Graphics

    Stamp
These are discussed in the following topics.

To edit an element 
 Right-click it, or click the Modify Selection button while the element is selected. A shortcut menu 

appears, with different options available depending on the type of element you’ve selected. 

To resize an element

 Click it to select it, and then drag one of its handles to make it larger or smaller.

To move or edit multiple elements

 Shift-click to select each one, then move or edit them as a group. 
Note Use the Browse buttons    >>    (next topic)    and    <<    (previous topic) to move through this 

series.



Designing Printing Label Contents
Creating Card Fields elements Topic 3 of 7

Card Fields elements insert information from the cardfile into the label, address book page, or 
envelope.

To add a card field
1. Click the Card Fields button. The Edit Label Text dialog box appears. 
2. Click the field in the list on the left, and click the Fields >> button. The field name appears in the box 

on the right. You can type a space, carriage return, or punctuation if you want it to appear between 
fields.

3. If you want any other text to appear on every label, type it in the box on the right.
When you print, the information from the cards will appear in place of the field names.
Note Use the Browse buttons    >>    (next topic)    and    <<    (previous topic) to move through this 

series.



Designing Printing Label Contents 
Creating Text and Stamp elements Topic 4 of 7

To add a Text element
1. Click the Text button. 
2. Type in the Edit Text dialog box and click OK.

To add a Stamp element

 Click the Stamp button and choose the phrase you want.
After the element is created, you can change its type style, color, and alignment by right-clicking and 
choosing from the menu. You can also drag its handles to resize it. . 

Tip You can rotate a Stamp by right-clicking it and choosing Rotate from the menu.
Note Use the Browse buttons    >>    (next topic)    and    <<    (previous topic) to move through this 

series.



Designing Printing Label Contents 
Creating Graphic elements Topic 5 of 7

To create a Graphic element 

 Click the Graphics button, and choose what kind of graphic to place: Bitmap, Frame, Round Frame, 
or Line. 
If you choose Bitmap, you can import a BMP file, which you can then resize if needed.    If you create a 
Frame, Round Frame, or Line, you can resize the element, change its line thickness, and its color by 
right-clicking it and choosing from the menu.

Note Use the Browse buttons    >>    (next topic)    and    <<    (previous topic) to move through this 
series.



Designing Printing Label Contents 
Resizing elements Topic 6 of 7

To change the size of a graphic element 
1. Select it. Black squares (called handles) appear at its edges. 
2. Drag a handle to resize the element. 

To change the size of a Text, Card Fields, or Stamp element

 Right click it and use the Font menu choice to specify a larger font.
With Text, Card Fields or Stamp elements, you can drag the handles to new positions, but the actual text 
within the element remains the same size. Note that it’s possible to size the element too small, so not all 
the text fits within it.

Note Use the Browse buttons    >>    (next topic)    and    <<    (previous topic) to move through this 
series.



Designing Printing Label Contents
More options Topic 7 of 7

To zoom in or out of your design 

 Click the Zoom button and choose the magnification or reduction you want.

To impose a regular grid of points that elements will snap to

 Check the Snap To Grid option. This is useful for aligning elements.

To display this grid

 Check Show Grid.

To display hints 

 Click the Hint button.
Note Use the Browse buttons    >>    (next topic)    and    <<    (previous topic) to move through this 

series.



Expense Menu
The Expense menu provides tools for creating, managing, and organizing your expense folders and 
receipts. 
For more information, highlight one of the Expense menu choices, and press F1.



Folder

 Related topics

In Expense View, the Expense | Folder command has options to create, delete, and modify expense 
folders.
Add
Delete Current Folder
Modify



Add Expense Folder

 Related topics

In Expense View, the Add Folder command (Expense | Folder | Add) opens the Add Expense Folder 
dialog box so you can create a new Expense folder.

Dialog Box Options

Folder Name
Type the name you want for the folder tab at the bottom of the screen.

Folder List
Displays a list of folders in the current Expense file.

Person’s Name
Enter your name or the name of the person whose expenses will be entered in this folder.

Department
Enter the person’s department name.

Organization
Enter the company name.

Purpose of Expenses
Enter the purpose.

Sort Folders Alphabetically
Check if you want the folder tabs to appear in alphabetical order. 



Delete Current Folder

 Related topics

Expense | Folder | Delete Current Folder deletes the current Expense folder. You will see a message 
asking you to confirm that you want to delete the curent folder and all receipts it contains.



Modify Expense Folder

 Related topics

In Expense View, the Modify Folder command (Expense | Folder | Modify) opens the Modify Expense 
Folder dialog box so you can modify an Expense folder.

Dialog Box Options

Folder Name
Type the name you want for the folder tab at the bottom of the screen.

Folder List
Displays a list of folders in the current Expense file.

Person’s Name
Enter your name or the name of the person whose expenses will be entered in this folder.

Department
Enter the person’s department name.

Organization
Enter the company name.

Purpose of Expenses
Enter the purpose.

Sort Folders Alphabetically
Check if you want the folder tabs to appear in alphabetical order. 



Receipt command

 Related topics

In Expense View, the Expense | Receipt command has options to create and delete expense receipts.
New
Delete



New Receipt

 Related topics

The Expense | Receipt | New command adds a new blank receipt to the current expense file.

Shortcuts

Toolbar:
Keyboard: Ctrl+A



Delete Receipt 

 Related topics

The Expense | Receipt | Delete command deletes the current receipt.



Expense File Properties

 Related topics

The File Properties command (Expense | File Properties) opens the Expense File Properties dialog 
box, where you can set properties for new Expense files you create. 

Dialog Box Options

Name for the First Folder (can’t be modified in this dialog box)
When you create a new Expense file, this name will be used for the first folder (you can change it 
using the Expense | Folder | Properties command).

Person’s Name
The name of the person whose expenses will be entered here.

Department
The person’s department, or the department incurring the expenses.

Organization
The name of the company or organization.

Purpose of Expenses
The purpose of the expenditures.

File Currency Setting (can’t be modified in this dialog box)
Select the currency from the drop-down list.

Expense Types to Display 
Highlight the expense types you want displayed in the default pick list for expense types.

File Country Setting (can’t be modified in this dialog box)
Check the one that applies to your location. The tax designations are VAT (Value Added Tax), GST 
(Goods and Services Tax) and PST (Provincial Sales Tax).

U.S.A. and other countries (without VAT/GST/PST)

European Countries (with VAT)

Canada (with GST/PST)



Format Menu
The Format menu gives you tools for controlling the appearance of your documents.
For more information, highlight one of the Calendar menu options, and press F1.



Font
In Write View, the Font command (Format | Font) opens the Font dialog box, where you can set the 
character attributes for the selected text.

Shortcuts

Toolbar:

Dialog Box Options

Font
Sets the font of the selected text.

Font Style
Sets the font style (Regular, Italic, Bold, or Bold Italic) of the selected text.

Size
Sets the point size of the selected text.

Effects

Strikeout sets the the selected text in Strikeout style.

Underline sets the the selected text in Underline style.

Color sets the the selected text in the specified color.

Sample
Displays a sample of the selected text with all the specified attributes.

Script
Sets the alphabet to use for the selected text.



Paragraph Formatting
In Write View, the Paragraph command (Format | Paragraph) opens the Paragraph Formatting dialog 
box, where you can set the indentation and alignment of the selected paragraph.

Dialog Box Options

Indentation
Sets the indentation of the first line and the right and left sides of the selected paragraph.

Alignment
Sets the alignment of the selected paragraph. The choices are: Left, Right, and Center.



Tabs
In Write View, the Tabs command (Format | Tabs) opens the Setup Tab Stop dialog box, where you 
can set tab stops for the selected paragraph.

Dialog Box Options

New Tab Stop
Sets the placement of a tab stop, measured in inches.

Set button
Adds a tab stop at the location specified in the New Tab Stop field.

Clear button
Clears the tab stop selected from the Tab Stop list to the left.

Clear All button
Clears all the tab stops.



Bullet
The Format | Bullet command sets the selected paragraphs as a bulleted list. A bullet is added at the 
first line of each paragraph, and each paragraph is indented. Applying this command to a bulleted list 
will set the text back to normal.



EarthTime Settings

 Related topics

The Settings dialog box lets you specify the cities you want displayed in EarthTime.
EarthTime displays clocks for eight different cities. Choose the cities you want in this dialog box. You 
can easily change your selections later. 

Dialog Box Options

Country
Normally set to All Countries, so all cities in the EarthTime database appear. To narrow down the city 
list, choose a country from the drop-down list. Only cities from that country will appear in the City list.

City
Click in the City field and type the first few characters of a city to find it. Then click the city name and 
click one of the right arrows to move it to the Local City, Home City, or Other Cities list. If necessary, 
you can select a city in the Other Cities list and click the left arrow to remove it and make room for 
another city of your choice.

Local City (my current location)
The Local City is normally the same as your Home City. When you travel, you change the Local City to
your current location. When you do, your computer’s system time is reset to match the Local City time. 
All your appointments are displayed in Local City time. The Windows Time Zone dialog box opens so 
you can specify the Time Zone. 

A person icon  appears next to the Local City.

Home City (my home location)

The Home City is where you live. A home icon  appears next to the Home City.

Six/Seven other cities of interest to me
Select the remaining cities whose clocks you want displayed in EarthTime. If your Home City and 
Local City are the same, you can choose seven others; if they are different, you can choose six 
additional cities.



Select a Different City

 Related topics

The Select a Different City command changes the city in the indicated time panel. To select another 
city, right-click the panel you want to change and choose Select a Different City. Or you can click the 
city and choose Select a Different City from the Edit menu.

Dialog Box Options

Country
Sets the country from which to show cities in the City list below.

City
Sets the city to display in the City panel.
Note To display Greenwich Mean Time, choose GMT/UTC/Zulu, Time Center from the City list. 

Facts about the City
Shows the Facts about the City dialog box.



Facts About the City and Almanac

 Related topics

The Facts About the City dialog box displays information about the current Local Clock city, or about a 
city you select in the Select a Different City dialog box. The Almanac displays time zone, sun and 
moon phases, and other calendar related information for that location.
The Facts information includes:

Language

Currency

Population

City Phone Code

Country Phone Code

Latitude and Longitude
The Almanac information includes:

Time zone

Sunrise and sunset 

Daylight

Moon phases

Daylight saving time

Days of the year
You can change the Date setting to see the sunrise, moon, and other information for the current city for
any date you select. For example, if you want to know when daylight saving time starts in Sydney, 
Australia, in 1999, choose Sydney, open the Facts About dialog box and change the year in the Date 
field to 99. 



Modify City Information

 Related topics

The Modify City Information dialog box lets you change some of the information about each city in the 
EarthTime database. This feature lets you update certain parameters that might change from time to 
time.
To open this dialog box, right-click a city and choose Modify City Information, or click the city and 
choose Modify City Information from the Edit menu.
Note You cannot modify the city information for the Local Clock city. If you need to do so, change the 

Local Clock to another city temporarily while you make the changes.

Dialog Box Options

City and Country Facts
You can change the Phone Area Code and the Phone Country Code for any city, as well as the 
Language, Currency, and Population.

Standard Time
Set the standard time difference from Greenwich Mean Time. For example, the East Coast of the U.S. 
(Eastern Standard Time) is 5 hours earlier than GMT.

Daylight Saving Time
You can change how daylight saving time is determined for a city. Specify the dates when it starts and 
ends, or the means of determining it (such as: “Begins at 2 a.m. on the 1st Sunday of April”). When 

daylight saving time is in effect for a city, a diamond  appears on its clock.

Browse Cities
Opens the Select a Different City dialog box.



Make (city) the Map Center 

 Related topics

The Make (city) the Map Center command lets you shift the map to the left or right to center the current
clock. Right-click a city panel and choose Make (city) the Map Center.
Note You can also center any location you point to on the map. Move the mouse pointer to the 

location you want to center, and right-click. Click the Center Map Here choice. The pointer 
location is centered in the window.



EarthTime Menu
The EarthTime menu has the following commands:
Choose as Local Clock
Choose as Home Clock
Clock Setup
Time Difference



Choose as Local Clock

 Related topics

The Choose as Local Clock command lets you choose one of the eight displayed cities as your Local 
Clock city. Right-click the city panel where you are currently located, and click Choose as Local Clock 
from the menu. Or you can click the city and select Choose as Local Clock from the EarthTime menu.
This option updates your computer’s system clock to reflect the Local Clock time when you travel to 
another time zone. All your Appointments are shown in Local Clock time. You can keep a different city 
set as your Home Clock city. 

A person icon  appears on the Local Clock. When daylight saving time is in effect for a city, a 
diamond 

 appears on its clock.



Choose as Home Clock

 Related topics

The Choose as Home Clock command lets you choose one of the eight displayed cities as your Home 
Clock city. This city is set when you install. Changing this city changes the Home Clock city displayed 
in the Time Difference dialog box.
To change the Home Clock, right-click the city panel you want to make the Home Clock, and click 
Choose as Home Clock from the menu. Or you can click the city and select Choose as Home Clock 
from the EarthTime menu.

A home icon  appears on the Home Clock. When daylight saving time is in effect for a city, a 
diamond 

 appears on its clock.



Clock Setup

 Related topics

The Clock Setup command displays a dialog box where you can set a preferred name, color, and time 
options for the selected city. To open this dialog box, right-click a city panel and choose Clock Setup 
from the menu, or open the EarthTime menu and choose Clock Setup. 

Dialog Box Options

Clock Name
You can display the city/country name supplied by EarthTime, or type a different name that you want 
displayed. This lets you display any city name even if it is not in the database. 
Note The Facts about the City will still refer to the city in the database, not the city whose name you 

type in the Alternate Name box.

Clock Colors
Select the Text and Background color for the selected city panel. Once you choose the colors, you can 
click Apply Colors to All Clocks to use the colors for all clocks.

Time Formats 

Display Seconds shows or hides the seconds counter for all cities. 

Military Time displays time in 24-hour time format when checked. 

Apply button
Click to see the colors you have chosen to the clock panel in the dialog box.



Time Difference

 Related topics

The Time Difference command shows the time difference between two cities. Right-click a city and 
choose Time Difference to see the time difference between it and the Local Clock. Or you can click a 
city and choose Time Difference from the EarthTime menu.
Note To see the Time Difference for any two of your eight displayed cities, drag from the clock 

numerals of one city to the clock numerals of the other.

Dialog Box Options

City 1
By default, shows the selected city. You can change this city by clicking the Browse Cities button. 
(Changing the city in this dialog box does not change the city displayed in EarthTime.)

City 2
By default, shows your Local Clock city. You can change this city by clicking the Browse Cities button. 
(Changing the city in this dialog box does not change the city designated as your Local Clock city in 
EarthTime.)

Time Difference
Displays the time difference between City 1 and City 2.

Time Comparison
Shows a graphical hour-by-hour comparison between the two cities for every hour of the day. 

Switch Cities button
Switches City 1 and City 2 in the Time Comparison.



Rearranging Cities

 Related topics

You can change the order of cities in EarthTime using drag-and-drop.
To switch the position of two cities, drag the city name from one of the displayed cities to another.
Note Be sure to drag the city name. Dragging the clock’s time display (rather than the city name) to 

another opens the Time Difference dialog box, where you can view the time difference between 
the two cities.



Daylight Saving Time change
During the transition from daylight saving time to standard time there can be ambiguity about the time. 
When you set the clock back in the fall, the hour between 1 a.m. and 2 a.m. is, in effect, repeated.    So
there can are two moments when the clock reads 1:15 a.m., for example.    
Also, when USA Eastern Time “springs” forward in the Spring, USA Pacific Time will be 4 hours behind
during a 3-hour period. Similarly, in the Fall, there will be a period when the difference is 2 hours during
the transition.
The dialog box asks you to specify whether the current time is standard time or daylight saving time.    



Center map here
When you right-click a map location and click Center Map Here, the map shifts horizontally so the 
place you clicked is centered in the window.



Checking Your Schedule

 Related topics

To view your Internet scheduling and Calendar events, To Do items, and Calls
1. Switch to the Activities view by clicking its icon on the Deskpad.
2. Click the tab for the events you want to see, Internet Events or the Calendar event tabs (All, 

Appointments, To Do, or Calls). 
3. Click the Show button and select the time period or event type you want to see. 
4. For Internet events, click the item, and view the information in the Details and Information panes. If 

you click an entry in the Details pane, you see more specifics in the Information pane.    

You can also:

Double-click a Calendar activity (appointment, To Do item, or Call) to jump directly to that event. 

Click a heading, such as Date and Time or Subject, to sort on that field.

If there is a URL attachment to a group event, click the URL to launch your default browser and 
jump directly to the World Wide Web site.    



Viewing Event Details

 Related topics

To view details of your Internet scheduling events
1. Click the event in the list (you may need to set the Show list to include the event type you want to 

see, such as Incoming Events or All Events).
2. In the Details pane, click an item and check the Information pane for more specifics. 
The buttons at the bottom of the window change depending on the kind of event you have selected: 
incoming, outgoing, resource message, and so on. Use the buttons, or right click an event and use the
shortcut menu, to respond to event invitations or take other actions.



Creating a Group Event

 Related topics

To schedule an event and send invitation messages automatically to the attendee list using the 
Internet Scheduling Wizard
1. In the Calendar, Cardfile, or Activities views, choose Internet | Scheduling Wizard.
2. Fill in the information in each Wizard page, and click Next to continue. Click the Help button on each

page if you need information about the options.

To schedule a group event using the Schedule an Event dialog box
1. Click Calendar | Events | Daily. If you are in Activities view, click the New button (while a group event

is selected).
2. Fill in the information in each page of the dialog box. Click the Help button on each page if you need

information about the options.
If you select participants or resources, the event is treated as a group event:    invitations are sent to 
participants and the resources are scheduled. If you do not select participants or resources, the event 
is a local event, added to your calendar only.
Note If you create an event or accept an invitation, the activity is added to your current calendar. If 

you use more than one calendar file, be sure the right one is open when you create or respond 
to Internet scheduling messages.



Replying To an Event Invitation

 Related topics

When you are invited to a group event, the invitation appears in the Activities view. An icon appears in 
the New column until you click the event to read it.

To accept or decline an invitation
1. Click the incoming invitation in the Activities view.    Read about the event in the Information pane.
2. Right-click the event, or click one of the buttons, to respond:

Accept – Sends a reply accepting the invitation, and adds the event to your calendar. You can 
include a reply message of up to about 2,000 characters.
Decline – Sends a reply declining the event. You can include a reply message of up to about 2,000 
characters.
Reschedule Request – Opens the Reschedule Request dialog box. You can enter up to three 
proposed alternative times and include your Free Time Report.
Delegate – Forwards the invitation to another person you select, with an optional message. The 
event originator receives notification that you have delegated the event to someone else.



Checking Event Replies

 Related topics

To check replies to an event you have initiated
1. Switch to the Activities view by clicking its icon on the desktop. Be sure the Internet Events tab is 

selected.
2. Click the event in the list (if necessary, set the Show list to include the event type you want to see).
3. In the Details pane, check the Participants list.    The icon by each name tells you the reply status:

No Reply Yet
Accepted
Declined
Reschedule Requested
Delegated

Click each participant and check the Information pane for any message that participant may have have
sent with the reply.

Click the Expand button        to read the meeting details more easily.



Entering the Reply Status Manually

 Related topics

This option is useful when you receive a reply verbally for an event you have initiated.

To enter the status of event partipants 
1. Click the event in the list.
2. In the Details pane, check the Participants category. The icons next to the participants indicates 

their status. You can click a participant in the Details pane and read that person’s status and 
response details in the Information pane.

3. Right-click a participant, and choose the status you want: Accept, Decline, Reschedule Request, or 
Delegate.



Rescheduling a Group Event

 Related topics

To reschedule a group event you have initiated
1. Switch to the Activities view by clicking its icon on the desktop. Be sure the Internet Events tab is 

selected.
2. Click the event in the events list.
3. Click the Reschedule button to change the event, and enter the new time. 
The participants are notified of the schedule change. When they click the notification message, they 
can Accept, Decline, or choose another reply to the rescheduled event. (The reschedule event icon 
remains in the New column as a reminder until the participant replies.) 



Canceling a Group Event

 Related topics

To cancel a group event you have initiated
1. Switch to the Activities view by clicking its icon on the desktop. Be sure the Internet Events tab is 

selected.
2. Click the event in the events list.
3. Click the Cancel button. 
The participants are notified that the event is canceled.. The event is automatically removed from their 
calendars when they click on the cancellation message and then click the Clear This Event button. 
(The Cancel icon remains in the New column as a reminder until the event is cleared.)



Adding More Participants to an Event
To add more participants to an event you have scheduled
1. Click the event and click the Reschedule button, or right-click the event and choose Reschedule 

from the shortcut menu. The Schedule Event dialog box opens.
2. Select the participants you want to add. Click OK.
Note The notification is sent to all participants, so that everyone receives the full attendee list.



Adding a New Resource

 Related topics

To add a new resource
1. In the Calendar or Activities view, choose Internet | Resources | Add.
2. Enter information about the new resource in the Add Resources dialog box.



Making a Resource Available To Others

 Related topics

Once you have created a new resource using the Add command, you must distribute the resource to 
others so they can reserve it. 

To distribute a resource
1. In the Calendar or Activities view, choose Internet | Resources | Distribute. The Distribute Resources

dialog box opens.
2. Click the resource to be distributed in the Available Resources list.    Click the > button to add it to 

the Selected Resources list.
3. Select all users who should be able to reserve the resources in the User List. Click the > button to 

add them to the Selected Users list.
You can distribute a resource to anyone using the same kind of e-mail as you.



Reserving a Resource For an Event

 Related topics

To reserve a resource before or after sending invitations, use the Resource Reservation Wizard

 In the Calendar or Activities view, choose Internet | Resource Wizard. 
The first Resource Reservation Wizard panel opens. You can request the resource and wait for 
confirmation before notifying attendees.

To reserve a resource while scheduling an event
1. In the Calendar, choose Internet | Scheduling Wizard. 
2. In the Select Resources panel of the Internet Scheduling Wizard, make your choice from the 

Available Resources list. The resource request is sent at the same time as your invitations.
Note If you use the Resource Reservation Wizard to book the resource, do not also include it when 

you create invitations to the same event. If you have already reserved the resource, sending a 
second request will result in a message saying the resource is already reserved for that time. 



Transferring a Resource To a New Manager

 Related topics

If you are the manager of a resource, you can transfer it to someone else. 

To transfer management of a resource
1. In the Calendar or Activities view, choose Internet | Resources | Transfer. The Transfer Resources 

dialog box opens.
2. Select the resource you want to transfer.
3. Enter the new manager’s name and information. 
Note The new manager (who must be using Internet Sidekick) can decline or accept the transfer. 

Until the new manager accepts the transfer, you are still the resource manager.
You can transfer a resource to anyone using the same kind of e-mail as you.



Changing a City Clock

   Related topics  

To change a city clock
1. Right click an existing city clock that you want to replace.
2. Choose Select a Different City from the menu.
3. Type the first few letters of the city. 
4. When you see the name you want in the list, click it to select it, and then click OK.



Centering a City 

   Related topics  

To move a city to the horizontal center of the EarthTime map
1. Right-click the clock for the city you want to center.
2. Choose Make (city) the Map Center from the menu.



Centering a Map Location

   Related topics  

To center any location horizontally in the EarthTime map
1. Right click on the map at the location you want centered.
2. Click Center Map Here.



Comparing Time In Two Cities

   Related topics  

To see a comparison of time in two cities
1. Click on the clock of the first city (you must click the time indication itself).
2. Drag to the clock for the second city. 
Or you can right-click the clock for any city and choose Time Difference from the menu. Then select 
the cities you want using the Browse Cities buttons in the Time Difference dialog box.



Converting Measurements
To convert from one unit of measure to another
1. Choose Tools | Conversions.
2. Fill in the units and quantity information in the Conversions dialog box. 
3. Read the result in the Value box.



Entering an Expense Receipt

   Related topics  

To enter information for a new receipt

1. Click the Add Receipt button.  
2. Choose the Expense Type from the drop-down list at the upper-right of the view. 
3. Type the receipt information in the blank receipt form below the list. 

Most fields include a drop-down list you can select from to speed up your data entry. These lists are 
updated when you type new information, such as a new city name. For a mileage expense receipt, you
enter the number of miles, and Sidekick automatically calculates the mileage amount by multiplying it 
times your mileage rate (in the Defaults page of Expense Preferences).

To edit an existing receipt
1. Click it in the Receipts list at the left of the view. The receipt appears at the right. 
2. Make any changes you want in the receipt fields.
Once you have entered one or more receipts, you can create an expense report.



Creating an Expense Report

   Related topics  

To create an expense report, you must first enter information in expense receipts. 

To create the expense report from one or more receipts

1. Select View | Report View, or click the Go To Report button.  
2. Type the Name, Department and Purpose of the expense report at the top of the screen.
3. In the By drop-down list, choose the contents: by Range, by Week, or by Folder.

The numbers in the expense report are not directly editable. To change this information, return to the 
Receipt view and make changes in the receipts.



Changing Expense Report Options

   Related topics  

To enter default values and currencies to apply to the Expense view

 Choose Tools | Preferences | Expense 

To set properties for the specific folder

 Choose Expense | Folder | Modify 

To set properties for the current Expense file

 Choose Expense | File Properties 
Note Changes in the Expense Preferences dialog are not retroactive. They apply to new data you 

enter.



Dialing a Voice Call Automatically
To dial a call using cardfile information (provided you have entered a default dialing field in the 
Cardfile SpeedDial field)
1. Select the card you want in the Cardfile. Or, if you are in another view, open the Viewport and select 

the card you want.
2. Drag the card to the telephone icon on the Deskpad.
3. Lift the receiver of your phone, and click the Talk button in the Call Status dialog box. Or you can 

click Hang Up to cancel the call.
Once the Phone Dialer is open, you can select a different card to dial just by clicking the card you want
in the Cardfile or Viewport—without closing the Phone Dialer.
Tip You can also dial a call using a phone number you have typed in an appointment or To Do item 

in the Calendar. Just drag the appontment or To Do item to the phone icon to dial the number.    
Or you can highlight a phone number and press F9.



Entering a Call Note

   Related topics  

To enter a text note about a call
1. Open the Phone Dialer by clicking the Call icon on the Deskpad.
2. Click the Call Note button at the bottom of the Phone Dialer
3. Type the text you want in the Call Note pad.
4. Select the card by clicking it in the Cardfile view or Viewport.
5. Click Save to Current Contact Log in the Phone Dialer.



Checking While-You-Were-Out Messages 

   Related topics  

To see who called while you were out

1. Open the Phone Dialer by clicking the Call icon  or pressing F9.
2. Open the History window by clicking the History button
3. Review the Call History panel, which displays Caller ID information on incoming calls that were 
not answered.

Note: This feature requires you to have the Windows 95 Unimodem V driver installed, a modem with 
Unimodem V capability, and Caller ID service. 



Importing, Exporting, and Synchronizing
Internet Sidekick includes advanced technology for importing and exporting files in other formats, and 
for synchronizing files so they have matching content.

Importing
You can import files in the Calendar, Cardfile, and Write views.    Choose File | Open, and select the 
format from the Files of Type drop-down list. 

Exporting
You can export files in the Cardfile view.    Choose File | Save As, and choose the file type from the File
Type drop-down list.    

Synchronizing
You can synchronize data between Calendars and Cardfiles in several formats. After synchronizing, 
the two files contain the same information.    See Synchronizing.
For more details, see About Conversions. If you have a question once the import/export or 
synchronize operation has begun, click the Help button in the dialog box. 



Internet Menu
The Internet menu in the Activities and Calendar views has options for scheduling meetings and 
resources, as well as publishing and mailing list management.

Scheduling Wizard
Resource Wizard
Mailing List
Resources
Publish to the Web
Eudora Pro Mail
Netscape Mail
Send/Receive Now



Internet Menu
The Internet menu in the Cardfile view has options for opening your e-mail address books and 
launching your browser and jumping to a Web site, and publishing cardfile information.

Scheduling Wizard
Mailing List
Eudora Pro Address Book
Netscape Address Book
Exchange Address Book
Eudora Pro Mail
Netscape Mail
Launch URL
Publish Cardfile to the Web



Mailing List
The Internet | Mailing List menu has options for editing and managing mailing lists. 
The menu choices are 

Edit Mailing List
Manage Mailing List



Resources
The Internet | Resources menu has options for reserving and managing resources. 
The Resources menu includes:

Add
Modify
Remove
Transfer
Distribute
View
Print



Publish to the Web
The Internet | Publish to the Web (Calendar or To Do Items) command allows publishing of Internet 
Sidekick Calendar data to the World Wide Web as an HTML document. This option is available as an 
Internet Sidekick add-on pack.
For more information, visit the Starfish Software Web site, at
http://www.starfishsoftware.com/products/sis/publisher/pub_to_web.html



Publish Cardfile to the Web
The Internet | Publish Cardfile to the Web command allows publishing of Internet Sidekick Cardfile 
data to the World Wide Web as an HTML document. This option is available with the Internet Sidekick 
Web Publisher add-on pack.
For more information, visit the Starfish Software Web site, at 
http://www.starfishsoftware.com/products/sis/publisher/pub_to_web.html



Netscape Mail
The Netscape Mail (Internet | Netscape Mail) command lets you create e-mail in Netscape Navigator.
This command opens Netscape Navigator and takes you to the Message Composition window where 
you can create a new message. (If you have not configured Navigator for e-mail, this option just opens
the Navigator browser.)



Eudora Pro Mail
The Eudora Pro Mail command (Internet | Eudora Mail) opens the Eudora Pro (32-bit) e-mail program 
so you can send and receive e-mail. 



Send/Receive Now
The Send/Receive Now command (Internet | Send/Receive Now) starts an immediate e-mail session 
to check for incoming messages and send any that are waiting to go. 

Shortcuts

Toolbar:
The Activities view shows you all incoming and outgoing group event invitations. Any that you have not
read yet are marked with an icon  in the New column. 

If there are unread messages in the Activities view, the Activities icon on the Deskpad changes to red and 
is animated every 15 minutes.

Note All invitations or replies are sent only when a Flash Session occurs, or when you use the 
Send/Receive Now command. 



Schedule an Event
The Schedule Event command (Calendar | Events | Daily) opens the Schedule an Event dialog box. 
Click each tab in the dialog box, and fill in information about the event. 
Note If you do not specify participants or resources, the event is entered locally, on your calendar 

only, as an individual event. 
For more information click the page in the list:

Date and Time page
Participants page
Message page
Resources page
Options page



Date and Time Page

 Related topics

In the Date and Time page of the Schedule an Event dialog box, enter the “when and where” details 
for your event.
Note: Be sure that Cardfiles you want to use for selecting participants are open before you begin 

scheduling the event.

Dialog Box Options

Subject 
Type the subject of your meeting or event. (You can’t select other page tabs without entering a 
subject.)

Date and Time
Click the day or month, day, year, and use the arrows to increase or decrease the value. Or click the 
large arrow to see a calendar you can use to find and select the date. You can also type a date.
Click the hour or minute in the From and To fields, and use the arrows to increase or decrease the 
time. Or you can type the time.

Location

City and Country:    Click the arrow and choose one from the list, such as San Francisco, CA, 
USA.

Time Zone: The time zone is filled in when you select a city. For an event that is time-zone 
specific, such as a conference call at 10 a.m. USA Central time, you can select the time zone instead of 
choosing a city and country.

Place:    Type a location, such as Smith Hotel, or click the arrow and choose one from the list of 
your previous entries. 



Participants Page

 Related topics

In the Participants page of the Schedule an Event dialog box, identify the people you want to invite to 
your event or meeting. Participants will be notified and their responses collected automatically by 
Internet Sidekick’s messaging software.
Note If you do not enter any participants, the event is considered a personal event, entered in your 

calendar only.

Dialog Box Options

Select Address Book or Mailing List
Select one of the currently open Sidekick Cardfiles containing names you want to notify of the event. 
Click the More button to open another cardfile. You can select particpants from more than one address
book or mailing list.

People
Lists the people in the currently selected address book or mailing list.    Click the + sign next to the 
name that you want to add, to see the person’s addresses. If several delivery options are available, 
such as Internet and CompuServe, click the one you want to use for delivering the invitation, and then 
click the Add ( > )button for the Participants or CC lists. If you select a telephone address, the person 
will be added to your Calls list in the Calendar to remind you to call them. If you select a fax number, a 
fax is automatically created and sent (assuming you have installed Microsoft Fax, and have a fax 
modem installed). 

Participants
Click > to add the selected name to the Participants list. Or select a name in the Participants list and 
click < to remove it. 

CC
Click > to add the selected name to the CC list. People on the CC list receive the same e-mail 
notification as participants. They have the option of accepting or declining the invitation. 



Message Page

 Related topics

In the Message page of the Schedule an Event dialog box, enter the meeting agenda, announcement, 
notes, or other information about the event.

Dialog Box Options

Message
Type the message in the text field (up to 2,000 characters). You also can click the Message button and
choose a text file (.TXT) to copy into the Message text field.

Attach URL button
Opens the Attach a Uniform Resource Locator dialog box, where you can enter a URL and description.

Message button
Opens the Browse dialog box, where you can look for a text file to load into the Message text field.

File Attachment
Click the Browse button and locate a file to include as an attachment to the message.



Resources Page

 Related topics

In the Resources page of the Schedule an Event dialog box, identify the facilities and equipment you 
want to reserve for your event. 

Dialog Box Options

Available Resources
Choose one or more resources from the list. These are resources that have been distributed to you, 
plus any that you manage. To create new resources, use Internet | Resources | Add.

Event Resources
Click > to add the selected name to the Event Resources list.

You can select a resource in the Event Resources list and click < to remove it. 
You will receive an automatic reply from the manager of the resource, which you can view in the 
Activities view. The reply will confirm your reservation, or decline it if the resource is already booked or 
no longer available.    



Options Page

 Related topics

The Options page of the Schedule an Event dialog box lets you add reminders and set a number of 
options for the event.

Dialog Box Options

Reminders

Remind Participants sends a reminder automatically to all participants in the event (including 
those on the CC list), except for those who have Declined.    In the time boxes, specify how far ahead of 
the meeting you want the reminder sent. 

Page Me At pages you to remind you of the event. Click in the time box and use the arrows to 
specify how far ahead you want to be paged. The value to enter is, for example, 999-9999@pagenet.net. 
Note: You must have an alphanumeric pager with an electronic mail account from your pager provider. 
Contact your pager provider for the addressing information. 

Alert me lets you set an alarm to remind you of the event. Click in the time box and use the 
arrows to specify how far in advance you want the alarm.

Click the arrow at the Tone box and choose a sound. (The Tone pick list includes sound files found 
in the Windows\Media directory.) Click the Test Play button to hear the sound. Note: A sound card is
required to play sounds.

Event Options

RSVP requests replies from your participants. Sidekick automatically collects Accept, Decline, or 
other reply messages from your recipients, and displays them in the Activities view. Click FYI if you want 
to broadcast a message announcing an event, like a company meeting, without collecting reply 
information. 

Tentative indicates that the event has not been confirmed. A tentative icon 
 appears on your calendar and on participants’ calendars. (Select the item in the Activities view and click

the Confirm button, or right-click the event and choose Confirm,    when you are ready to to send a 
message confirming a tentative event.)

Completed lets you check off the event in your calendar when it has been completed. 

Type lets you select the event type: Public, Confidential, and Personal.



Internet Scheduling Wizard Step 1

 Related topics

The Scheduling Wizard command (Internet | Scheduling Wizard) opens the Wizard for scheduling 
events.
Be sure that Cardfiles you want to use for selecting participants are open before you begin scheduling 
the event.

Shortcuts

Toolbar:
In the opening Wizard panel, click one of the categories on the left:

Meeting
Conference Call
Online Event
Other Event

Then click an event description from the list on the right.
When you have selected the event type, click Next to continue to the next Wizard panel, or Cancel to 
exit.
Note If the choices are not exactly what you need, you can edit the subject in Step 2.



Internet Scheduling Wizard Step 2

 Related topics

In Step 2 of the Internet Scheduling Wizard, review the subject and enter the details of time and 
location for your event.

Subject
Review the subject, which is the meeting or event you selected on the previous page of the Wizard. 
You can revise the subject here, if necessary.

Date and Time
Click the day or month, day, year, and use the arrows to increase or decrease the value. Or click the 
large arrow to see a calendar you can use to select a date. You can also type a date.
Click the hour or minute in the From and To fields, and click the arrows, or use the up-arrow and down-
arrow keys, to increase or decrease the time. Or you can type the time.

Location

City and Country:    Click the arrow and choose the city and country from the list, such as San 
Francisco, CA, USA.

Time Zone:    The time zone is filled in when you select a city. For an event that is time-zone 
specific, such as a conference call at 10 a.m. US Central time, you can select the time zone instead of 
choosing a city and country. 

Place: Type a location, such as Smith Hotel, or click the arrow and choose one from the list of 
your previous entries. 



Internet Scheduling Wizard Step 3

 Related topics

In Step 3 of the Internet Scheduling Wizard, identify the people you want to invite to your event or 
meeting.

Select Address Book or Mailing List
Select a Sidekick Cardfile containing names you want to notify of the event. 

More button
Click if you want to open another Address Book or mailing list.

People
Lists the people in the currently selected address book or mailing list.    Click the folder icon next to the 
name that you want to add, to see the person’s addresses. If several delivery options are available, 
such as Internet and CompuServe, click the one you want to use for delivering the invitation, and then 
click the appropriate Add ( > ) button. If you select a telephone address, the person will be added to 
your Calls list in the Calendar to remind you to call them. If you select a fax number, a fax is 
automatically created and sent (assuming you have Microsoft Fax installed, and have a fax modem). 

Participants
Click > to add the selected name to the Participants list.

CC
Click > to add the selected name to the CC list. People on the CC list receive the same e-mail 
notification as participants. They have the option of accepting or declining the invitation.

You can select a name in the Participants or CC list and click < to remove the name.



Internet Scheduling Wizard Step 4

 Related topics

In Step 4 of the Internet Scheduling Wizard, enter the meeting agenda, list of required items, notes, or 
other information about the event.

Message
Type the message in the text field (up to 2,000 characters). You also can click the Message button and
choose a text file (.TXT) to copy into the Message text field.

Attach URL button
Opens the Attach a Uniform Resource Locator dialog box, where you can enter a URL and description.

Message button
Opens the Browse dialog box, where you can look for a text file to load into the Message text field.

File Attachment
Click the Browse button to locate a file to include as an attachment to the message. 



Internet Scheduling Wizard Step 5

 Related topics

In Step 5 of the Internet Scheduling Wizard, identify the facilities and equipment you need for your 
event.

Available Resources
Choose one or more resources from the list.

Event Resources
Click > to add the selected name to the Event Resources list.

You can select a resource in the Event Resources list and click < to remove it. 
You will receive an automatic reply from the manager of the resource, which you can view in the 
Activities view. The reply will confirm your reservation, or decline it if the resource is already booked or 
no longer available.    



Internet Scheduling Wizard Step 6

 Related topics

Step 6 of the Internet Scheduling Wizard lets you add reminders and set a number of options for the 
event.

Reminders

Remind Participants sends a reminder automatically to all participants in the event (except 
those who have declined). In the time boxes, specify how far ahead of the meeting you want the reminder
sent.

Page Me At pages you to remind you of the event. Click in the time box and use the arrows to 
specify how far ahead you want to be paged. The value to enter is, for example, 999-9999@pagenet.net. 
Note: You must have an alphanumeric pager with an electronic mail account from your pager provider. 
Contact your pager provider for the addressing information. 

Alert Me lets you set an alarm to remind you of the event. Click in the time box and use the 
arrows to specify how far in advance you want the alarm. 

Click the arrow at the Tone box to choose a sound. Click Test Play to hear the sound. Note: A sound
card is required to play sounds.

Event Options

RSVP requests replies from your participants. Sidekick automatically collects Accept, Decline, or 
other reply messages from your recipients, and displays them in the Activities view. 

FYI broadcasts a message announcing the event, like a company meeting, without collecting 
reply information. 

Tentative marks the event as unconfirmed on your calendar and participants’ calendars.    (Select
the event in the Activities view and click the Confirm button, or right-click the event and choose Confirm,    
when you are ready to send a message confirming the tentative event.)

Type lets you select the event type: Public, Confidential, and Personal.



Internet Scheduling Wizard Step 7

 Related topics

Review the details you have specified for your event. Click Back if you need to go back to previous 
steps to change anything.

Event Summary
Review the date, time, location, and subject. Check the Participants and Resources lists. If you need to
change any information, click the Back button until you come to the page where it appears, and make 
the changes.

Finish button
Click to schedule the event.



Edit Mailing List
The Edit Mailing List command (Internet | Mailing List | Edit Mailing List) lets you add or delete mailing 
lists, or modify their names.

Dialog Box Options

Specify the Mailing List Name
Type the name of a new or existing mailing list.

Existing Mailing List
Click a mailing list to select it from the list.

Add button
Enter a new name, and click Add to add the new mailing list.

Modify button
Select an existing mailing list. Revise the name as desired, and click Modify to change the name. 

Delete button
Select an existing mailing list and click Delete to remove it permanently.
Warning: Deleting a Mailing List removes all the addresses it contains.



Manage Mailing List
The Manage Mailing List command (Internet | Mailing List | Manage Mailing List) lets you modify the 
membership of your mailing lists.

Dialog Box Options

Select a Mailing List
Start by specifying the mailing list. Click the arrow and select one of your defined mailing lists.

Select Address Book
Click the arrow and choose an address book from the currently open cardfiles. After adding names 
from one address book, you can select another and add names from it.

People in the Address Book
Click the + sign next to each name, and click a notification method if more than one appears. Then 
click the > button to add the person to the list.

The > and < buttons
Once you have clicked a person and notification method, click > to add the person to the list.

Click a person in the Contacts in the Mailing List box and click < to remove him/her from the list.

People in the Mailing List
Contains the list you have created.

Save
Click to save the list, including any changes you have made.

Reset
Restores the list to its last saved state. 



Compose the Minutes of the Meeting 
The Compose the Minutes of the Meeting dialog box lets you (or any meeting participant) write 
meeting minutes and send them to the attendees. 

Dialog Box Options

Minutes of Meeting
Type the minutes in the space provided. 

File Attachment
Specify a file to send as an attachment, or click Browse to locate the file.
Once you have entered the minutes, click OK to send them automatically to the meeting attendees. 



Delegate 
Use the Delegate To dialog box to delegate a meeting invitation to someone else. The person you 
delegate to becomes the recipient, and has the same options for responding as other recipients.    The 
event initiator receives notification that you have delegated the event, and to whom you delegated it.

Dialog Box Options

Select Address Book    
Click the arrow to select an address book from among your open Sidekick Cardfiles. 

Select the Person to Delegate this event to 
Click the person you want to delegate the invitation to. If a + appears next to the name, click it and 
choose the notification method you want to use in delegating the message.

Short Message
Type a message of up to 2,000 characters. 



Reschedule Request 
The Reschedule Request dialog box lets you reply to a meeting invitation with a request to reschedule 
it. Your reply includes up to three proposed alternate times, and can include your Free Time Report.

Dialog Box Options

1, 2, 3 Proposed Schedule
Enter one or more alternate dates and times if desired. Check the box for First Proposed Date/Time 
(then Second Proposed Date/Time, if desired, then Third). Click in the date or time field, and click the 
arrows to increase or decrease the value. The large arrow in the Date field opens a calendar you can 
use to select the date. 

4 Type a Short Message
Type a short message (up to 2,000 characters) you want to send with your reschedule request.

Attach my Calendar‘s Free Time Report for Next 30 Days
Check to attach a report showing your free time for the next 30 days. Note: This report is based on 
your currently open calendar.



Accept Invitation 
Type a short message (up to 2,000 characters) you want to send with your reply accepting the meeting
invitation. 



Decline Invitation 
Type a short message (up to 2,000 characters) you want to send with your reply declining the meeting 
invitation. 
Check Attach My Calendar’s Free Time Report for Next 30 Days to include a report showing available 
time on your calendar. This report is based on the currently open calendar.



Cancel Event 
Cancels the selected event (you can only cancel an event you initiated). Participants automatically are 
notified by Internet messaging. 
When participants click the cancellation message and click the Clear This Event button, the event is 
removed from their calendars. The notification icon remains in the New column to remind participants 
to clear the event.



Send Reminder
Automatically sends a reminder to participants in the selected event (it must be an event you initiated).
People who have declined the invitation do not receive the reminder. 

The reminder appears with an icon  in the New column in the Activities view.



Reschedule
The Reschedule command opens the Schedule an Event dialog box. You can enter new event 
information and re-send the invitations. 
Once you reschedule an event, all previous replies you received are cleared, since new replies are 
needed for the rescheduled event.

The recipients see an icon  in the New column, and the word Rescheduled appears as the Status in 
the Information pane.

Recipients must click the Accept, Decline, or other reply buttons to reply to the rescheduled event 
notification. The notification icon remains in the New column to remind participants to reply to the 
rescheduled event.



Reschedule Resource Reservation
The Reschedule command for a resource lets you change the date and/or time of a resource 
reservation. 
Click the resource message and click the Reschedule button. Or you can right click the resource 
message and choose Reschedule from the shortcut menu.    Enter the new date/time information in the
Resource Wizard.



Cancel Resource Reservation
Use the Cancel Resource command to cancel a resource reservation. 
Note A resource’s manager can cancel reservation for that resource manually. View the resource’s 

reservations (Internet | Resources | View). Right click on the reservation and select Cancel 
Reservation. No notification is sent to the person who made the reservation.



Confirm Event
The Confirm command sends confirmation notices to participants of an event previously marked 
tentative. 
Select the event and click the Confirm button, or right-click the event and select Confirm. Notification is
automatically sent to all participants removing the tentative status of the event.



Delete
Use Delete to remove the selected event from the Activities list. 
Deleting the activity is used to clean up the Activities view. No messages are sent to participants, and 
the event is not removed from your calendar.    Use the Cancel Event button if you want to cancel an 
event and notify participants, or delete the event from the Calendar view. 
NOTE: Here are some issues to consider when you delete an event:
1. If the item is for a group event that you initiated and that has not been completed, you will not be 

able to track and modify the deleted event.
2. If the item is a group event that is still in your calendar, deleting the item will delete all participant 

and resource information for the event. You can safely do so after the event has taken place. 
3. If you delete an item in Activities view and then delete it from the Calendar, you will not be prompted 

to send cancellation notices to participants, because the participant and resource information has 
been deleted. 

4. If you delete an event, incoming replies to that event are discarded.



New Activity
The New option in the shortcut menu opens the Schedule an Event dialog box, so you can create a 
new event. 
Clicking the New button in the Activities view creates a new event of the type currently selected. If you 
have an event selected, it opens the Schedule an Event dialog box. If you have a resource message 
selected, it opens the Resource Reservation Wizard.



Resource Reservation Wizard 1

 Related topics

The Resource Reservation Wizard command (Internet | Resource Wizard) opens the Wizard for 
scheduling resources. 

Shortcuts

Toolbar:

Wizard Options

Facilities
Click one or more resources in the Facilities list. Click a selected resource to de-select it.

Equipment
Click one or more resources in the Equipment list. Click a selected resource to de-select it.

Details
Select a resource and click Details to see information about that resource, such as the maximum 
occupancy of a facility and the manager’s name.



Resource Reservation Wizard 2

 Related topics

Enter the purpose and time of the reservation.

Wizard Options

Purpose
Type the purpose of the reservation.

From
Click in the date or time box and use the arrows to increase or decrease the value. Or type a date or 
time in the box. The large arrow next to the Date box opens a calendar you can use to select the date.

To
Click in the date or time box and use the arrows to increase or decrease the value. Or type a date or 
time in the box. The large arrow next to the Date box opens a calendar you can use to select the date.

Location
Select the city and country from the list.    The Time Zone is filled in automatically. Or select the time 
zone from the Time Zone drop-down list. This is the date and time that will be used for reserving the 
resource.



Add Resources
Use the Add command (Internet | Resources | Add) to add a new resource. You become the manager 
who “owns” the new resource (unless you transfer it to someone else). The manager’s computer is 
where the resource’s calendar is maintained, but all scheduling occurs in the background, without 
requiring any involvement by the manager.
Note A resource manager should keep the Flash Sessions setting enabled, and set to a fairly 

frequent interval, to allow Internet Sidekick to respond to resource requests promptly. Flash 
sessions are turned on or off in the Group Scheduling Preferences dialog box.

Dialog Box Options

Existing resources
A list of resources currently available on your system.

Resource Type

Facility: A conference room or other location. A maximum occupancy field is provided.

Equipment: A computer, vehicle or other resource that has no maximum occupancy.

Other: An undefined resource category you can use as you need. For example, this might be a 
phone company conference call operator or a catering company. No reservations are recorded for Other 
resources.

Name
Type the name of the new resource.

Maximum Occupancy
For a Facility, the maximum number of people that it accommodates (up to 32,000).

Resource Manager Information

Contact Name: Your name, as the manager of the resource.

E-mail Type: Your e-mail account type.

E-mail Account: Your e-mail account name.

Phone Number: Your telephone number.

Fax Number: Your fax number.

Comments
Comments or notes about the resource.



Modify Resources
The Modify command (Internet | Resources | Modify) lets you modify a resource’s information, as it 
appears on your system.
In the Modify Resources dialog box, click the resource you want to modify in the list on the left.    Make 
changes you want in the fields on the right (fields that are gray cannot be modified).
Note If you try to schedule a resource and receive notification that the resource has been transferred 

to a different manager, use the Modify Resources command to enter the new manager’s 
information.

Dialog Box Options

Select the resource to be modified 
A list of resources currently available on your system.

Resource Type

Facility: A conference room or other location. A maximum occupancy field is provided.

Equipment: A computer, vehicle or other resource that has no maximum occupancy.

Other: An undefined resource category you can use as you need.

Name
The name of the resource, which cannot be modified.

Maximum Occupancy
For a Facility, the maximum number of people that it accommodates.

Resource Manager Information

Contact Name: The name of the person who “owns” the resource.

E-mail Type: The contact’s e-mail account type. 

E-mail Account: The contact’s e-mail account name.

Phone Number: The contact’s telephone number.

Fax Number: The contact’s fax number.

Comments
Comments or notes about the resource.
Note The changes you make will appear on your computer only. 



Remove Resources
Use the Remove command (Internet | Resources | Remove) to delete a resource from your system. 
In the Remove Resources dialog box, click the resource in the list at the left, and then click Remove to 
delete the resource. 



Transfer Resources
The Transfer command (Internet | Resources | Transfer) lets you transfer management of a resource 
to another person. You can transfer a resource to anyone using the same kind of e-mail as you.
In the Transfer Resources dialog box, click the resource in the list at the left. You can view the current 
information about the selected resource.    
Click the Transfer button, and enter the new manager’s information in the spaces provided. The 
manager must be using Internet Sidekick, and you must provide the manager’s e-mail account 
information. 
When you have entered the information, click the Transfer button. The new manager has the option of 
accepting or declining the transfer. 
Note A resource manager should keep the Flash Sessions setting enabled, and set to a fairly 

frequent interval, to allow Internet Sidekick to respond to resource requests promptly. Flash 
sessions are turned on or off in the Group Scheduling Preferences dialog box.

Dialog Box Options

Contact Name: The name of the person who “owns” the resource.

E-mail Type: The contact’s e-mail account type. Click the arrow and choose the account type 
from the list. 

E-mail Account: The contact’s e-mail account name.

Phone Number: The contact’s telephone number.

Fax Number: The contact’s fax number.



Accept Resource Transfer 
When a resource is transferred to a new manager, the new manager must Accept the transfer before it
goes into effect. 
The new manager clicks the transfer message and clicks the Accept button to accept the transfer.
The scheduling of the resource happens in the background on the manager’s computer, without 
requiring any direct involvement of the manager. A resource manager should schedule flash sessions 
at frequent intervals so Internet Sidekick can handle incoming resource requests promptly.



Decline Transfer
When a resource is transferred to a new manager, the new manager has the option to decline the 
transfer. 
Click the transfer message and click the Decline button to decline the transfer.



Retransfer Resource
The retransfer command repeats a resource transfer message. Use this command if you find the 
message transferring a resource has failed to arrive at the destination. 
Select the resource transfer message and click the Restransfer button to send the transfer message 
again to the same person as before.



Undo Transfer
Use the Undo Transfer command if a problem with a transfer requires you to undo it.
For example, if you transfer a resource and then find out that the e-mail transfer message cannot be 
delivered, use the Undo command to resume managing the resource. You can then transfer to another
recipient or a new e-mail address if desired.



New Resource Manager
Use the New Resource Manager dialog box to specify a new manager for a resource you have 
managed.    

Dialog Box Options

Contact Name
Type the new manager’s name

E-mail Type
The new manager’s e-mail type (Internet or Exchange).

E-mail Account
Enter the new manager’s account name.

Phone Number
Enter the new manager’s telephone number.

Fax Number
Enter the new manager’s fax number.

Transfer button
When the information is correct, click the Transfer button.



Distribute Resources
The Distribute command (Internet | Resources | Distribute) lets you make a resource available to other
users for booking reservations. Only users to whom the resource has been distributed will be able to 
reserve it. You can distribute a resource to anyone using the same kind of e-mail as you.    You can 
distribute resources you manage and resources that were distributed to you by others.

Dialog Box Options

Select Resources for Distribution

Available Resources lists resources on your system. Click each resource you want to distribute, 
and click > to add to the Selected Resources list. You can distribute resources that are managed by 
others. 

Selected Resources lists the resources you are distributing.

Select Users for Distribution

Address Book or Mailing List:    Choose the address book or mailing list to use. You can select 
users from more than one address book or mailing list.

User List shows everyone in the selected Address Book or Mailing List. Click names and click > 
to add them to the Selected Users list.

Selected Users lists users you want to receive the distribution.

Distribute button
When the lists of resources to distribute, and users to distribute to, are correct, click Distribute to make 
the distribution.



View Resources
Use the View command (Internet | Resources | View) to see the schedule of a resource you manage.    
You can view the schedule for up to six months ahead.
In the Viewing Resources dialog box, booked time shows as blocks. Use the scroll bars to see more 
dates and times. 
If you need to cancel a resource reservation, right-click the reservation block and choose Cancel 
Reservation (no notice is sent to the person who made the reservation).
You can print the schedule in weekly or monthly format. Click the Print button. The Print Resource 
Reservation Report dialog box opens.



Print Resources
The Print Resources command (Internet | Resources | Print) opens the Print Reservations dialog box. 
You can print the schedule for up to six months ahead. 



Print Reservations
The Print Reservations dialog box lets you print a report showing booked time and free time for 
resources you manage. To open this dialog box, choose Internet | Resources | Print or click the Print 
button in the Viewing Resources dialog box.

Dialog Box Options:    Weekly View

Resource to Print
Click the arrow and choose the resource schedule you want to print.

Date Range
Click in the From or To box, and use the arrows to increase or decrease each value. The large arrow 
opens a calendar you can use to select a date. 

Time Range
Click in the From or To box, and use the arrows to increase or decrease each value. Or you can type a
value.

Dialog Box Options:    Monthly View

Resource to Print
Click the arrow and choose the resource schedule you want to print.

Month to Print
Click the arrow, and choose the month you want to print.



Netscape Address Book
In the Cardfile view, the command Internet | Netscape Address Book opens the Netscape address 
book and converts the multi-level mailing list into an Internet Sidekick mailing list.
Note Internet Sidekick looks for the file Address.htm, stored in the same folder as your Netscape 

bookmarks file. If the file is not found, the File Open dialog appears so you can select the 
address book. Once imported, the copy of the address book is saved as Netscape.SKCard in 
the Internet Sidekick DATA directory. 



Eudora Pro Address Book
In the Cardfile view, the command Internet | Eudora Pro Address Book opens the Eudora Pro (32-bit) 
address book, and converts its contents into an Internet Sidekick cardfile. The cardfile is called 
Eudora.SKCard, and is stored in the Internet Sidekick DATA directory.
If you are using Eudora Pro 3.0, you can have multiple e-mail addresses per person. These entries are
automatically converted into a mailing list. 



Exchange Address Book
The Internet | Exchange Address Book command opens your Microsoft Exchange address books in 
the Sidekick Cardfile View. If you have several, such as a Postoffice Address List and a Personal 
Address Book, a dialog box appears asking you to specify which one to use.
Once you open it as a Sidekick Cardfile, you can use Save As to store it in Sidekick format.    (You 
need to log on to Exchange to reopen the saved Exchange cardfiles.) The cardfile is “linked” to the 
Exchange Address book.
Note This is a read-only file. You can extract it into a new cardfile you create if you want to edit its 

contents.



Launch URL
The Internet | Launch URL command launches your default World Wide Web browser and jumps to the
Web site specified by a URL in the current card. 
If there is more than one URL in the current card, Internet Sidekick jumps to the first URL in the card. If
that is not what you want, you can click in a field containing a URL before giving the Launch URL 
command to specify which URL to use.
Internet Sidekick recognizes a variety of URL types such as http:// (the World Wide Web), ftp://, 
gopher://, wais://, and file://.
A 32-bit browser is required. 



Shortcut Menu (Activities view)
The shortcut menu opens when you right-click an event in the Activities view.

Menu Options (Incoming Events)
Accept sends an accept message to the meeting originator. You can type a message to go with the 
reply.
Decline sends a decline message to the meeting originator.    You can type a message to go with the 
reply.
Reschedule Request sends a message requesting that the event be rescheduled to another time. 
You can propose up to three alternate times, and you can attach a Free Time Report showing your 
available times for the next 30 days.
Delegate forwards the invitation to someone else you specify, and notifies the meeting originator that 
you have delegated the event. 
New opens the Schedule an Event dialog box so you can enter a new event.
Delete deletes the selected event.

Menu Options (Outgoing Events)
Reschedule opens the Schedule an Event dialog box, where you can change the event’s date, time, 
or other options, and re-send the invitation.
Cancel sends a message canceling the event, and removes it from your calendar.
Send Reminder sends a message to all participants reminding them of the event.    The event is 
marked with a reminder icon: 

New opens the Schedule an Event dialog box so you can enter a new event.
Delete deletes the selected event.




